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Change Table

The following table contains an overview of changes made to this document for the 3.3
release of Zenly.

Table 1: Change Table

Version Section Impacted Change(s)

33 Mortgage Call Report | A section was added for the Mortgage Call Report

(Reports) (Reports).

Mortgage Call Report | Sections from the Mortgage Call Report 2024
2024 (Reporting) (Reporting) synch with other Zenly screens.

Lead Tracking Status | Added information about the ability to change the date
and Track Loan Status | for statuses for Leads/Loan files.

Ch. 5: Reports Tab Updated the Reports chapter to match the updated Ul.
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Chapter 1: DOCUMENT OVERVIEW

Preface

Zenly is a full web-based loan origination solution. Zenly requires no installs and is securely
accessed from multiple platforms on any computer or mobile device.

See the following table for product assistance details.

Table 2: Product Assistance

Knowledge Base Access the online Knowledge Base Articles

Visit: Zenly Knowledge Base Articles

Product Information General product information and links to product support
pages and the user guide are available at Calyx Support.

Email: Zenly@calyxsoftware.com

Email: DCSZIP@calyxsoftware.com

Training Attend paid online cases delivered by a Certified Calyx
Consultant by contacting PSG@calyxsoftware.com or call 1-
800-362-2599 Option 1.

Online: Go to the Calyx Customer Portal
Email: training@calyxsoftware.com

Toll Free: 800-362-2590.

Documentation Accessibility

The goal is to make Calyx products, services, and supporting documentation accessible.
This document focuses on usability for the disabled community. The documentation
includes features that make information available to users of assistive technology and
conforms with Americans with Disabilities Act (ADA) compliance standards. Documentation
is available in HTML format and contains markup to facilitate access by the disabled
community. Accessibility standards continue to evolve over time, and Calyx Software is
actively engaged with other market-leading technology vendors to address technical
obstacles so documentation can be accessible to all customers.
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Access Zenly

Use https.//www.calyxzenly.com/ link to access Zenly.
1. Click the Calyx Zenly link.

2. Enter User Email Address.

¥ zenly

Email Address
@greatdemobank.com

Password

Forgot Your Password?

Powered by © Calyx Technology, Inc.
All rights reserved.

Figure 1: Zenly Log In
3. Enter the 14-digit Password.

Note: Zenly requires a combination of alpha-numeric characters along with at least one
special character. At least one alpha character must be capitalized.

Forgot Password (Request Password Reset)

Users needing to renew or to replace forgotten password can use the link to reset the
password.

To change the password:

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
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1. Click on the Forgot Your Password? link in the sign in screen.

@ zenly

Forgot Your Password?

Powered by © Calyx Technology, Inc.
All rights reserved.

Figure 2: Forgot Your Password?

2. Enter the Login Name.

@ zenly

REQUEST PASSWORD RESET

Enter your login name. All notifications and loan information are sent to this address by default.
An access code will be sent to your email address or mobile number based on your preferences.

Login Name

If you do not know this information or you have problems resetting your password, contact your company administrator or
Zenly Dedicated Customer Service at 800.342.2599 Option 4.

Figure 3: Request Password Request
3. Click the Send button to request the password change.
4. After receiving the code, type Access Code in the field.

REQUEST PASSWORD RESET

Password information:

- Passwords must contain a minimum of 12 characters.
- Pass\ must contain at least one uppercase letter, one lowercase letter, AND one number.
- Must not same as your four previously used passwords.

Access Code

Resend Code
Choose another method

Password

Confirm Password

Reset Password

Figure 4: Access Code

Note: The Choose another method allows the user to send the password request through a

different method. See User Information.
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5. Enter a new Password.

6. Enter the same password again to confirm.

Mobile Access

The mobile view of Zenly functions identically to the desktop view. The standard menu
items are available by expanding the Menu button : located at the top of the screen. For

information about the buttons, See Zenly Mobile Icons.

¥ Andy America

New - 07/10/2023
© Andy America
Lead - 01/13/2023

© Andy America
-1

© Andy America

ead - 11/01/2022

fanniemae com

Figure 5: Zenly Mobile View
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Home Screen (Mobile)

The user can return to the Home screen by tapping on the Zenly logo.

© Andy America
Lead - 02/12/2024

F Andy America

New - 07/10/2023

© Andy America
Lead- 01/13/2023

© Andy Am
ezd- 1

1234 Ocean Pines

@ Andy America
Lesd - 11/01/2022

andu a@fanni

.

Figure 6: Home Screen (Mobile)

User Profile for Mobile Users

Selecting the Menu icon display's all Zenly features including the User Profile, Interview
Portal, Support, Help, and the Sign Out functions.

¥ zenly ,

€& REPORTS

USERS

22 TEMPLATE

as

B Interview Configuration
@ Help

& Sign Out

11/14/2023
ool

The Home screen allows the user to search for both Leads or Loan files.

Figure: User Profile (Mobile)
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Zenly Mobile Icons

Table 3: Zenly Home Screen Icons

Icons

Function

@ zenly

Tapping the icon allows the user to return to the Zenly Home screen.

Tapping on the Select button allows the user to choose files to delete or
archive.

The Alerts icon displays unread notifications. Select the icon to view
notifications.

Tap on the menu button to access the main menu. The User Profile,
Interview Portal, Reports, Users, and Template screens are accessed in the
main menu.

Tapping on the Filter icon allows the user to filter between Lead, Loan, and
Archived files.

+ i<

The New File icon allows the user to create new loans or lead files.
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Chapter 2: ZENLY HOME SCREEN

Zenly opens to the Home Screen after successful login. This screen provides access to
existing leads and loan options. Click on the Zenly logo to return to the Home screen.

a
‘ Zenly LEADS / LOANS REPORTS USERS TEMPLATES -ﬁ e
Name Status Status Date Telephone Email Property Address Owner/LO
e Andy America Lead 07/13/2023 andy.a@fanniema 1234 Rodman St John Done
T AndyAmerica New 07/10/2023
©  AndyAmerica Lead 01/13/2023
e Andy America Lead 11/30/2022 (508)333-2211 andy.a@fanniema... 1234 Ocean Pines
e Andy America Lead 11/01/2022 (508)777-7777 andy.a@fanniema 1234 Rodman St
e Andy America Lead 11/01/2022 (508)777-7777 andy.a@fanniema... 1234 Rodman St
e Andy America Lead 11/01/2022 (508)333-2211 andy.a@fanniema... 1234 Ocean Pines
©  AndyAmerica Lead 11/01/2022 andy.a@fanniema. 1234 Rodman St
(5] Andy America Prospect 09/26/2022 (508)333-2211 andy.a@fanniema.. 1234 Ocean Pines
e Andy America Lead 07/18/2022 (508)888-8888 andy.a@fanniema... 1234 Ocean Pin... John Done
©  AndyAmerica Lead 06/02/2022
©  AndyAmerica Lead 06/01/2022
v

Figure 7: Zenly Main Page

Note: The User List displays only the registered user when logging into Zenly the first time.
Use the New button to add users or select a Main tab to add loans or set up the
administration options (See Add User for details).

Icons help distinguish a Lead from a Loan. See Figure 8.

Lead

_—
\ 4
v

Figure 8: Home Table Icons
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Filtering

The filtering @ icon allows the user to display the desired file type. The options include

Archived, Leads, and Loans

@ zenly

LEADS / LOANS

Search Leads & Loans

Name
B Archived

Q

B Leads

REPORTS

USERS

X

. Loans

TEMPLATES

Email

Property Address

® 0

Owner/LO

(5] Andy America andy.a@fanniema... 1234 Rodman St

John Done

Figure 9: Filtering

Archiving Files

Files located on the Home screen or in the Leads/Loans table are archivable.
To archive a file:
1. Click on the Select button.

‘ Zen |y LEADS / LOANS ~ REPORTS  USERS  TEMPLATES _ﬁ ®

- Search Leads & Loans oy V¥V + NewFile ¥
Name Status Status Date Telephone Email Property Address Owner/LO

e Andy America Lead 07/13/2023 andy.a@fanniema.. 1234 Rodman St John Done

T Andy America New 07/10/2023

©  AndyAmerica Lead 01/13/2023

e Andy America Lead 11/30/2022 (508)333-2211 andy.a@fanniema.. 1234 Ocean Pines

e Andy America Lead 11/01/2022 (508)777-7777 andy.a@fanniema.. 1234 Rodman St

e Andy America Lead 11/01/2022 (508)777-7777 andy.a@fanniema... 1234 Rodman St

e Andy America Lead 11/01/2022 (508)333-2211 andy.a@fanniema.. 1234 Ocean Pines

e Andy America Lead 11/01/2022 andy.a@fanniema.. 1234 Rodman St

e Andy America Prospect 09/26/2022 (508)333-2211 andy.a@fanniema... 1234 Ocean Pines

e Andy America Lead 07/18/2022 (508)888-8888 andy.a@fanniema.. 1234 Ocean Pin... John Done

©  AndyAmerica Lead 06/02/2022

©  Andy America Lead 06/01/2022

Figure 10: Selecting Files (Archives)

2. Select the desired files.
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3. Select the Archive button.

“ zenly LEADS / LOANS ~ REPORTS ~ USERS  TEMPLATES 'ﬁ ©

l Search Leads & Loans s} V¥ + NewFile ~
Name Status Status Date Telephone Email Property Address Owner/LO

Andy America Lead 07/13/2023 andy.a@fanniema... 1234 Rodman St John Done

Andy America New 07/10/2023

Andy America Lead 01/13/2023

D Andy America Lead 11/30/2022 (508)333-2211 andy.a@fanniema... 1234 Ocean Pines

[j Andy America Lead 11/01/2022 (508)777-7777 andy.a@fanniema... 1234 Rodman St

[j Andy America Lead 11/01/2022 (508)777-7777 andy.a@fanniema... 1234 Rodman St

[j Andy America Lead 11/01/2022 (508)333-2211 andy.a@fanniema. 1234 Ocean Pines

[0 AndyAmerica Lead 11/01/2022 andy.a@fanniema 1234 Rodman St

D Andy America Prospect 09/26/2022 (508)333-2211 andy.a@fanniema. 1234 Ocean Pines

D Andy America Lead 07/18/2022 (508)888-8888 andy.a@fanniema.. 1234 Ocean Pin... John Done

[J  AndyAmerica Lead 06/02/2022

[J  AndyAmerica Lead 06/01/2022

Figure 11: Archiving Files

7. Click Ok on the Confirm Archive dialog.

Viewing Archived Files

Use the Filter function to view archived files.

Note: Viewing archived files while archived are read-only. Ensure that the file is reactivated
before opening.

To view archived files:

1. Click on the Filter & icon.

‘ Zen |y LEADS/LOANS REPORTS USERS

- R
x

ISearch Leads & Loans

Name Status

+ Archived B Leads B Loans

Figure 12: Viewing Archived Files

2. Select Archived.

Reactivating Archived Files

Archived files required reactivation before adding additional information. Opening an
archived file will function in read-only mode.

To reactivate an archived file:
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1. Click on the Filter & icon.

2. Select Archived.
3. Click on the Select button.

“ zenly LEADS /LOANS ~ REPORTS  USERS  TEMPLATES o 0
- Search Leads & Loans ey Vv + NewFile ~
Name Status Status Date Telephone Email Property Address Owner/LO
©  AndyAmerica Lead 07/13/2023 andy.a@fanniema 1234 Rodman St John Done
¥ Andy America New 07/10/2023
©  AndyAmerica Lead 01/13/2023
\m :
Figure 13: Select Button
4. Choose the desired files.
.
5. Select Activate.
‘ zenl W% LEADS / LOANS ~ REPORTS ~ USERS  TEMPLATES 0 (2]
. Search Leads & Loans e} V + NewFile ~
Name Status Status Date Telephone Email Property Address Owner/LO
Andy America Lead 07/13/2023 andy.a@fanniema 1234 Rodman St John Done
Andy America New 07/10/2023
Lead 01/13/2023

Andy America

J

Deleting Files

Figure 14: Activate Button

Delete files through the Home and Leads/Loan tables.

To delete files:
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1. Click the Select button.

‘ Zen|y LEADS / LOANS ~ REPORTS ~ USERS  TEMPLATES 'ﬁ e 2
- Search Leads & Loans s} V¥ + NewFile v
Name Status Status Date Telephone Email Property Address Owner/LO
©  AndyAmerica Lead 07/13/2023 andy.a@fanniema. 1234 Rodman St John Done
¥ Andy America New 07/10/2023
©  AndyAmerica Lead 01/13/2023
©  AndyAmerica Lead 11/30/2022 (508)333-2211 andy.a@fanniema 1234 Ocean Pines
©  AndyAmerica Lead 11/01/2022 (508)777-7777 andy.a@fanniema. 1234 Rodman St
©  AndyAmerica Lead 11/01/2022 (508)777-7777 andy.a@fanniema. 1234 Rodman St
©  AndyAmerica Lead 11/01/2022 (508)333-2211 andy.a@fanniema. 1234 Ocean Pines
©  AndyAmerica Lead 11/01/2022 andy.a@fanniema. 1234 Rodman St
©  AndyAmerica Prospect  09/26/2022 (508)333-2211 andy.a@fanniema. 1234 Ocean Pines
©  AndyAmerica Lead 07/18/2022 (508)888-8888 andy.a@fanniema 1234 Ocean Pin. John Done
©  AndyAmerica Lead 06/02/2022
©  AndyAmerica Lead 06/01/2022
Next
v

Figure 15: Selecting Files (Deleting)
2. Choose the desired files.

3. Select the Delete button.

‘ Zer‘]|y LEADS / LOANS ~ REPORTS ~ USERS ~ TEMPLATES _ﬂ e

. Search Leads & Loans Q =+ New File ~
Name Status Status Date Telephone Email Property Address Owner/LO

Andy America Lead 07/13/2023 andy.a@fanniema.. 1234 Rodman St John Done

Andy America New 07/10/2023

Andy America Lead 01/13/2023

(J  AndyAmerica Lead 1173012022 (508)333-2211 andy.a@fanniema.. 1234 Ocean Pines

(J  AndyAmerica Lead 11/01/2022 (508)777-7777 andy.a@fanniema.. 1234 Rodman St

(J  AndyAmerica Lead 11/01/2022 (508)777-7777 andy.a@fanniema... 1234 Rodman St

(J  AndyAmerica Lead 11/01/2022 (508)333-2211 andy.a@fanniema 1234 Ocean Pines

(J  AndyAmerica Lead 11/01/2022 andy.a@fanniema.. 1234 Rodman St

(J  AndyAmerica Prospect  00/26/2022 (508)333-2211 andy.a@fanniema.. 1234 Ocean Pines

(J  AndyAmerica Lead 07/18/2022 (508)888-8888 andy.a@fanniema... 1234 Ocean Pin... John Done

(J  AndyAmerica Lead 06/02/2022

[J  AndyAmerica Lead 06/01/2022

IR Next

Figure 16: Deleting Files
4. Click OK in the Confirm Delete dialog.
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User Profile

The User Profile's location is at the top-right corner of the screen. Selecting the button
allows the user to access the Interview Portal (Interview Configuration), Help, and Sign Out
links.

® 0
i - l

i Interview Configuration
rty |
¥ @ Help

[+ Sign Out

Figure 17: User Profile

Accessing the Interview Portal

Use the User Profile to access the Interview Portal and the User Profile settings. See Chapter
8: Zip for more information.

Alerts

The Alerts feature displays notifications set by the user. Alerts appear in the bell icon at the
top of the screen. Select the icon to view the queue. See Alerts Configuration for
information about managing alerts.

Ken N Customer

Initiate Loan

Ken N Customer

Print loan comparison documents.

Ken N Customer

Figure 18: Alerts

Note: All notifications will appear in the Alerts window. The Alerts window inside of a file will
also display all other file's notifications.

To clear an alert;
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1. Click on the Select button.

2. Select the desired alert(s).

3. Select Clear.

4. Select Delete in the Delete Confirmation dialog.

Note: The Mark as Unread button allows read alerts to become re-highlighted and cause
the alerts counter to increase.

Creating an Alert

The user can create alerts by selecting the bell icon in an open lead/loan file.
To create an alert:

1. Select the desired Lead/Loan file.

2. Select the Alerts 2 icon.

3. Select the Add Hicon.

Alerts Tt QO X

Ken N Customer

Initiate Loan

Ken N Customer

Print loan comparison documents.

Ken N Customer

Figure 19: Add Alerts
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4. Add the notification information in the Add Alerts dialog.
Add Alert x 3
af Borrower A
Ken N Customer
Description
B n
pt
4§
Due Date/Time
ao
Assigned to
kTl y
Clear Alert Automatically
| | Created Date/Time 11
08/07/2023 8:24 AM
By
IN
' 3
Figure 20: Add Alert Dialog
Leads/Loan Search
Use the Search field to locate existing leads or loans.
Note: Zenly allows partial text searches.
1. Enter the Search criteria.
’ zenly LEADS / LOANS ~ REPORTS ~ USERS  TEMPLATES ‘ﬂ (2]
l Search Leads & Loans Q
Name Status Telephone Email Property Address Owner/LO
Figure 21: Loan Search
2. Press Enter to obtain search results.
‘ zenly LEADS / LOANS ~ REPORTS  USERS  TEMPLATES 'ﬁ (2]
@\m\ix Q v <+ NewFile ~
Name Status Status Date Telephone Email Property Address Owner/LO
n Andy Amorics lood 07412022 anch 2@V 1224 Dodmoan Gt lobn None

Figure 22: Search Results

3. Clear the Search field and press Enter to return to the full list.
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New File

The New File button allows the user to create a New Lead or a New Loan file. For more
information on creating a Lead see Creating a New Lead. For more information on creating a
loan file see Creating a New Loan File.

* New Lead

© New Loan

Figure 23: New File
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Chapter 3: LEADS

A Lead is a person interested in the products or services of a company in any way. The
Tracking screen allows the user to insert information about the lead. Once the lead chooses
to continue, the user can initiate the loan process through the Status screen.

Creating a New Lead

Use the New Lead button to create a new lead. Selecting the button opens the Lead Status
screen, where the user can insert information about the lead. For information on archiving
and deleting lead files, see Archiving Files or Deleting Files.

r ~ New Lead

© New Loan

Figure 24: Creating a New Lead

Creating a Lead Invite

Use the Lead Invite option to send an existing or potential customer a link. The link provides
customers with access to a personal Point of Sale (POS) website.

1. Open or create a new Lead. See Creating a New Lead.
2. Click the Lead Invite button.

Run Pricing H Invite Lead H Initiate Loan H Save ]
By

Figure 25: Leads Invite
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3. Select the invitation Type from the dropdown.

Lead Invite X

Type Text Message (SMS) v

o
Contact First Name Last Name

Memo to
Borrower

Vi
Disclaimer: By sending this information, you acknowlecge
that you will be sharing your personal ZIP website and
comments with the Contact. Once this action has been
initiated, it cannot be rescinded.

Figure 26: Lead Invite Dialog

4. Enter contact type details. (phone number or email address).
5. Enter the Contact First and Last Names.

6. Enter a memo to introduce the borrower to the link for the Interview portal.

Lead Status

The Status tab contains sections for the user to record information about the lead. Use the
Contact screen to add desired contacts for the lead.

‘ Zen|y LEADS / LOANS ~ REPORTS ~ USERS ~ TEMPLATES 0 e
Status Qualification Documents
Lead ID : 20230303000011 -Ken N Customer [ wnpricng ][ miteteod ][ mitotetoon [ sae |
Tracking

Q@ SsTATUS [+]
Contacts

ALERTS

@ summary Info © (+]
Housing Expense : 4.750% @ CONVERSATION LOG )
Debt-to-Income : 5.038%
e v @ CONTACT INFORMATION

@ TELEPHONE [+]

@ ADDRESS [+)

@ LOAN INFORMATION

@ NOTE DETAILS

@ PROPOSED HOUSING EXPENSES [+)

M poinanpy LOIISING CVDENCES o

Figure 27: Lead Status
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Lead Tracking

Lead information added to the Tracking screen is transferable to a loan file (See Initiate
Loan).

The user can also select the Lead Invite button to send an interview request to the lead (See
Creating a Lead Invite).

Summary Info

The Summary Info allows the user to see Housing Expense, Debt-to-Income, and the Total
LTV ratios on the Tracking screen. For mobile users, select the Information icon Bl to open
the Summary Info.

‘ Ze n |Y l ADDITIONAL INFORMATION
Status | Qualification Do \
Lead ID : 202303030000 ﬂ

Lead Invite Initlate Loan

Contacts

o CONTACT INFORMATION

© summary Info
: HE on L X
Housing Expense : 4.750%

Debt-to-Income : 5.038% 4750% 5.038% 95.000%

Figure 28: Summary Info (Desktop/Mobile)

Lead Tracking Status

Use the Status options to track and update the status of the lead. The following statuses are
provided by default:

e New e Future Opportunity
e Prospect e \Won Opportunity

¢ Qualified e Lost Opportunity

¢ Unqualified e |oan Created

e Not Interested e Other

The user can create additional statuses by using the Template > Dropdown Lists screen.
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Adding a Lead Status

Add a new status to show the progress of the lead. A new status will populate the table
without overwriting an existing status.

To add a status to a lead:

1. Expand © the Status table.
2. Click on the Add © button.

@ sTATUS g (+)
Status Description By Date/Time

Qualified 03/13/2023 10:21 AM
Unqualified Doesn't make enough 03/06/2023 9:15 AM

New 03/03/2023 10:22 AM

Figure 29: Add Status
3. Choose an option from the Status dropdown menu.

Add Tracking

Date/Time 04/23/2024 09:19 AM |o
By
Status

Description

Figure 30: Add Tracking

4. If needed, add a Description.
5. Click Save & Close or Save & New.
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Editing Lead Status

The user cannot edit the status set in the Status dropdown menu. Date/Time is editable. To
change the condition of the lead, add a new status.

Edit Status

Date/Time ~ 11/01/2022 11:33 AM N0

By

Status Lead
De%

Save & Close

Figure 31: Edit Status

Alerts (Leads)

The Alerts section allows the user to view active and cleared alerts for the Lead. Users can
view the alert by selecting an item from the table. Use the © button to add an alert for the
lead.

@ ALERTS (+]
Description Created v Due Cleared Assigned To

Active

Add new Contacts 11/16/2023 03:05 PM

Print loan comparison documents. 11/16/2023 03:05 PM

Initiate Loan 11/16/2023 03:04 PM

Cleared

Print loan comparison documents. 08/03/2023 03:01 PM 08/03/2023 03:01 PM 09/05/2023 08:48 AM

Add new Contacts. 08/03/2023 02:59 PM

Initiate Loan 08/03/2023 02:59 PM 08/03/2023 03:00 PM

Figure 32: Alerts (Leads)
Note: Alerts CANNOT be deleted.

Add Alerts
To add an alert for the lead:
1. Click on the @ icon.
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2. Enter a Description

el

T

Add Alert

Borrower

Ken N Customer

Description

Due Date/Time

Assigned to

Clear Alert Automatically
Created Date/Time

08/07/2023 8:24 AM

By

Figure 33: Add Alerts

3. Select a Due Date/Time for the alert to notify.

4. Select Save & Close to exit the window.

Edit Alerts

Only Active alerts are editable. Select an alert from the Active side of the table to open the

Edit Alerts screen.

@ ALERTS

©

Description

Active
Add new Contacts.
Print loan comparison documents

Initiate Loan

Created » Due Cleared Assigned To

11/16/2023 03:05 PM
11/16/2023 03:05 PM

11/16/2023 03:04 PM

Cleared
Print loan comparison documents
Add new Contacts.

Initiate Loan

08/03/2023 03:01 PM 08/03/2023 03:01 PM 09/05/2023 08:48 AM

08/03/2023 02:59 PM

08/03/2023 02:59 PM 08/03/2023 03:00 PM

Clearing Alerts

Figure 34: Edit Active Alerts

Even if Alerts can't be deleted, alerts can be cleared.

To clear an alert;
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1. Select the checkbox for the undesired alert.

@ ALERTS (+]
Description Created ~ Due Cleared Assigned To
Active
E Initiate Loan 02/26/2024 09:32 AM 02/24/202412:00 AM
Email 02/26/2024 09:29 AM
C
Facebook Message 02/26/2024 09:29 AM 02/26/2024 09:30 AM
Call 02/26/2024 09:29 AM 02/29/2024 12:00 AM 02/26/2024 10:03 AM

Figure 35: Clear Alerts
2. Select the Clear button.

The undesired alerts will move to the Cleared section of the table.

Conversation Log (Leads)

Use the Conversation Log to track communications with the lead.

Note: Conversation Log entries cannot be altered or deleted after saving, adding, or
removing documents are the only modifications a user can make.

To add an entry:
1. Expand @ the Conversation Log table.
2. Select the Add © button.

° CONVERSATION LOG

o ©

Type Description By Date/Time
Phone Call 03/13/2023 10:17 AM
E-mail Bruce called in and was looking for a... 03/06/2023 9:16 AM &

Figure 36: Add Conversation Log
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3. If needed, link a stored document by selecting the Link icon.

Add Conversation Log X

DOCUMENT @B

Date/Time 03/13/2023 8:17 AM

By

Type ¥

Description

Figure 37: Add Conversation Log Dialog

4. If needed, select the Upload PDF icon to upload a pdf document into the
Conversation Log entry.

5. Select an option from the Type dropdown menu.
6. If needed, add a Description.
7. Click Save & Close or Save & New.

Contact Information

Contact Information is a section to record personal, as well as a spouse'’s, information.

1. Expand @ the Contact Information section.
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2.

Enter the lead's First name and Last name.

° CONTACT INFORMATION

First

Middle

Last

Suffix

Nickname
Contact Method
Email

SSN/Tax ID

Date of Birth

Age

Marital Status
Number of Dependents
Language

Other Description
Citizenship
Credit Score

First-Time Homebuyer

PRIMARY CONTACT
Ken
N

Customer

Email

111-22-3333

11/16/1984

Married
0 Ages

English

(] self-employed

First

Middle

Last

Suffix
Nickname
Contact Method
Email

SSN/Tax ID
Date of Birth

Ag:

e

Marital Status

Number of Dependents

Language

Other Description

Citizenship

Credit Score

First-Time Homebuyer

SPOUSE

English

[ self-Employed

© ® N OO0 MW

Figure 38: Contact Information

If needed, add the Middle name.
If needed, add a Suffix.

Add a Nickname if applicable.
If needed, add the lead's Email Address.
Select the lead's preferred Contact Method.
Add SSN/Tax ID of the lead.

Enter Date of Birth.
Age will populate automatically.

10. Enter Martial Status.

11. Enter the Number of Dependents and the Ages if applicable (Ex. 2,5).
12. Enter the Lead's desired Language.
Note: If Other was selected, enter the desired language in the Other Description field.

13. Select the lead's Citizenship status.

14. Enter the lead's Credit Score.

15. Select whether the lead is a First-Time Homebuyer.

16. Enter the Spouse’s information if applicable.

17. Select the Save button at the top of the screen.
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Telephone (Leads)
Use this section to add any telephone numbers associated with the lead.

Adding a Telephone Number

To add a Telephone number:
1. Expand © the Telephone table.
2. Click on the Add © button.

@ TELEPHONE = (+]

_—

Type Number Preferred

Mobile v

Home

Figure 39: Add Telephone
3. Click on the Type dropdown menu and select an option.

Add Telephone 24

Type hd
Other Description
Number G

Extension

Preferred Contact

Figure 40: Add Telephone Dialog

Add a description if Other was selected in the Type dropdown menu.
Enter the phone Number.
Enter the Extension if applicable.

N o o A

If the number entered is preferred by the lead, select the Preferred Contact
checkbox.

8. Click on Save & Close or Save & New.

Editing a Telephone Number
To edit a Telephone number:

1. Expand @ the Telephone section.
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2. Select the desired number from the table.

@ TELEPHONE (+]
Type Number Preferred
I Mobile v

Home

Figure 41: Edit Telephone
3. Update the desired fields.
4. Click Save & Close.

Delete a Telephone Number
To delete a phone number:

1. Expand © the Telephone section.

2. Click on the Delete icon associated with the undesired number.

@ TELEPHONE (4]

Type Number Preferred

Home

Mobile v \ m]
W

Figure 42: Delete Telephone Number

3. Select Delete on the Delete Confirmation dialog.
Address (Leads)

The Address table displays addresses associated with the lead. The user can add, edit, or
delete an address.

Adding an Address

To add an Address:

1. Expand © the Address table.
2. Select the Add © button.

@ ADDRESS » (+)

Type Length of Residency Occupancy Street Address City State Zip

Current 10 years 6 months Own 10655 Birch St Burbank CA 91502 |

Figure 43: Add Address
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3. Select an option from the Type dropdown menu.

Add Address X

v

Type
Qccupancy &
Length of Residency Years Months
Address

Unit Designator M Number
City
State/Province
Postal Code

County

Country United States v

Figure 44: Add Address Dialog

4. Select an Occupancy option.

5. Enter the Length of Residency.

6. Enter the Address.

7. Select a Unit Designator if applicable.

8. Enter the Number of the unit if applicable.
9. Enter the City name.

10. Select the State the address resides in.

11. Enter the address’ Postal Code.

12. Enter the County

13. Select the Country.

14. Click on Save & Close or Save & New.

Editing an Address
To edit an Address:
1. Expand © the Address section.
Click on the desired address in the table.
Update the desired fields.
Click Save & Close.

~ WD
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Delete an Address
To delete an Address:
1. Expand © the Address section.
2. Select the Delete icon associated with the undesired address.

3. Select Delete on the Delete Confirmation dialog.
Loan Information (Leads)

The user can enter loan information of the lead in this section.

° LOAN INFORMATION
Loan Type FHA N Construction Type h
Other Description Cash-Out Type v
Loan Purpose Purchase v Occupancy Primary Residence v
Other Description Lien Position First e

Figure 45: Loan Information
1. Expand © the Loan Information section.
2. Select the Loan Type.
Note: If Other is selected, enter a description in the Other Description field.
3. Choose a Loan Purpose.
Note: If Other is selected, enter a description in the Other Description field.
Select the Construction Type if applicable.

If Refinance was selected in the Loan Purpose dropdown menu, select a Cash-Out
Type.
6. Select the type of Occupancy.

7. Select the Lien Position.
Note Details (Leads)

The user can enter Note Details in this section.
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1. Expand @ the Note Details section.

@ NOTE DETAILS
Estimated Appraised Value 2 850,000.00 Amortization Term 360 Months
Sales Price 3 785,000.00 PMI/MIP/VA/USDA
Base Loan Amount 2 745,750.00 @ PMI/MIP/VA/USDA Amount
Down Payment Amount 3 39,250.00 Total Loan Amount w/MIP.FF 3 745,750.00
Note Rate 3.900 % Monthly Payment & 3,517.47

Figure 46: Note Details
Enter the Estimated Appraised Value.
Enter the Sales Price.

Enter the Base Loan Amount.

o~ WD

Enter the Down Payment Amount.

Note: Selecting the Calculator icon opens the Down Payment dialog that allows the user to
enter the down payment percentage.

6. Enter the Note Rate.
7. Enter the Amortization Term in Months.
8. Enter the PMI/MIP/VA/USDA percentage if applicable.

Note: The PMI/MIP/VA/USDA Amount, Total Loan Amount w/MIP.FF, and Monthly Payment
fields are auto populated.

Proposed Housing (Leads)

This section allows the user to enter proposed housing expenses. If the Loan Information
and Note Details section were completed, the mortgage would populate in this section. If
needed the user can add additional proposed housing expenses.

Adding Proposed Housing

To add an expense:

1. Expand @ the Proposed Housing section.
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2. Click on the Add © button.

° PROPOSED HOUSING o
Expense Type unt
First Mortgage 3,517.47
City Property Tax 1,80223 W@
Total 5,319.69

Figure 47: Proposed Housing
3. Select a Housing Expense Type.

Note: If Other was selected, enter the Other Description.

Add Proposed Housing Expenses X

Housing Expense Type
Other Description

Based On Total Loan Amount v
Fee Percentage
Monthly Dollar Amount %

Monthly Amount ki

Figure 48: Add Proposed Housing Expenses

4. Select an option from Based On dropdown menui.
The option determines how the expense is calculated.

5. Enter a Fee Percentage if applicable.
6. Enter a Monthly Dollar Amount if applicable.

The Monthly Amount fields will auto populate based on options entered and
selected in this dialog.

7. Select Save & New or Save & Close.

Editing Proposed Housing Expenses
To edit an expense:
1. Expand @ the Proposed Housing section.
2. Select the desired expense.
3. Update the desired fields.
4. Select Save & Close.
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Deleting Proposed Housing Expenses
To delete an expense:
1. Expand © the Proposed Housing section.
2. Select the Delete icon associated with the undesired expense.

3. Select Delete in the Delete Confirmation dialog.
Primary Housing (Leads)

The Primary Housing expense section allows the user to enter the lead's current housing
expenses.

Adding Primary Housing Expenses

To add a Primary Housing expense:

1. Expand © the Primary Housing section.
2. Select the Add © button.

° PRIMARY HOUSING o
Type Amount
Earthquake Insurance 12.00
County Bond Tax 5400 @
Total 66.00

Figure 49: Primary Housing
3. Select a Type.

Note: If the Other option was selected, enter Other Description.

Add Primary Housing >

Type h
Other Description

Amount k3

Figure 50: Add Primary Housing Dialog

4. Enter the Amount.
5. Click Save & New or Save & Close.
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Editing Primary Housing Expenses
To edit an expense:
1. Expand © the Primary Housing section.
2. Select the desired expense.
3. Update the desired fields.
4. Click Save & Close.

Deleting a Primary Housing Expense
To delete an expense:

1. Expand © the Primary Housing section.
2. Select the Delete icon on the undesired expense.

3. Click Delete on the Delete Confirmation dialog.
Income (Leads)
The Income section allows the user to enter the lead's sources of income.

Adding a Source of Income
To add a source of income:

1. Expand © the Income section.
2. Select the Add © button.

© INCOME

@ LIABILITIES (4]

Figure 51: Income
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3. Select the Source.

Note: If Other was selected, enter an Other Description.

Add Income X

Source
Other Description

Amount 2

Figure 52: Add Income Dialog

4. Enter the Amount.
5. Click Save & New or Save & Close.

Editing a Source of Income

To edit a source of income:

Expand © the Income section.
Select the source of income.
Update the desired fields.

4. Select Save & Close.

w N

Deleting a Source of Income
To delete a source of income:
1. Expand @ the Income section.
2. Select the Delete icon associated with the undesired income source.

3. Select Delete in the Delete Confirmation dialog.
Liabilities (Leads)

This section allows the user to pre-emptively add liabilities that the lead holds.

Adding a Liability
To enter liabilities:

1. Expand © the Liabilities section.
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2. Select the Add © button.

&g TeomT

@ LIABILITIES

@ OTHER EXPENSES

A4
- ©
(4]

Total Balance & Total Payment %

ADDITIONAL INFORMATION

Figure 53: Liabilities

3. Add the Company Name.

Add Liability X

Current
Company Name
Balance & $
Credit Account Type v

Monthly & 3

Liability Type b Payment

Other Description Payments

Remaining

Account Number

Paid Off | &
Mortgage Loans

D Paid off at closing

- %
Credit Limit [] omitted

[:J Subject Property

Remaining

Figure 54: Add Liability Dialog

4. Select an option from the Credit Account Type dropdown.

5.

Select a Liability Type.

Note: If Other was selected, enter an Other Description.

6.
7.
8.

0.

10.

11.

12.
13.
14.

Enter the Account Number.

For Mortgage Loans, enter the Credit Limit if applicable.
Select the Subject Property checkbox if applicable.
Enter the Current Balance.

Enter the Remaining Balance if applicable.

Enter the Payments Remaining.

Select the Paid off at closing checkbox if applicable.
Select the Omitted checkbox if applicable.

Select Save & New or Save & Close.
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Editing a Liability
To edit a liability:

1. Expand © the Liabilities section.
Select the desired liability.
Update the desired fields.

Select Save & Close.

> W N

Deleting Liabilities
To delete a liability:
1. Expand @ the Liabilities section.
2. Select the Delete icon associated with the undesired liability.

3. Select Delete in the Delete Confirmation dialog.
Other Expenses
All additional expenses that the lead wants to disclose are added to this section.

Adding Other Expenses
To add an expense:

1. Expand © the Other Expenses section.
2. Select the Add © button.

@ LIABILITIES ©

@ OTHER EXPENSES = ©

Total Balance & Total Payment | &

ADDITIONAL INFORMATION

Figure 55: Other Expenses
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3. Select an option from the Type dropdown menu.

Add Expense X

Borrower Ken Customer
Type e
Other Description
Owed To
Description
Payments Remaining
Monthly Payment %
[: Omit

Figure 56: Other Expenses Dialog
Note: If Other was selected, enter an Other Description.
Enter who the expense is Owed To if applicable.
Enter a Description if applicable.
Enter the remaining payments (Payments Remaining).
Enter the Monthly Payment.
Select the Omit checkbox if applicable.

Select the Save & New or Save & Close.

© © N o o A

Editing Other Expenses

To edit an expense:

Expand © the Other Expenses section.
Select the desired expense.

Update the desired fields.

Click Save & Close.

A~ w nhoR

Deleting Other Expenses
To delete an expense:
1. Expand © the Other Expenses section.
2. Select the Delete icon associated with the undesired expense.

3. Select Delete in the Delete Confirmation dialog.
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Additional Information (Leads)

Use the Additional Information field to add any notes about the lead. The expansion icon at
the bottom-right corner can increase or decrease the size of the text box.

Total Balance & Total Payment &

ADDITIONAL INFORMATION

Figure 57: Additional Information

Contacts (Leads)

The Contacts screen provides a location for entering information about people of interest
(Ex.: Appraiser, Broker, Doc Preparer).

To add a contact;
1. Select the Add © icon.

“ zenly LEADS / LOANS ~ REPORTS  USERS ~ TEMPLATES _ﬂ (2]
Status Qualification Documents
Lead ID : 0230303000011 - Ken N Customer [ munprigng || mvietad ][ imitistetoan [ sme |
Tracking CONTACTS Eg °

@ summary Info
Housing Expense : 4.750%
Debt-to-Income : 5.038%

Base LTV: %

Figure 58: Contacts (Leads)
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2. Select a Contact Type.

ADDITIONAL DETAILS

Contact Type v First Company Name
Other Type Middle Address
Reference Last Unit Designator v | Number
Entity v Suffix City
Position State/Province v
Telephone | () Postal Code
Extension County
Email Country v
Telephone | ()

Extension

Fax ()

Contact Detail

State Company Detail

State

NMLS License Number

License

Federal Tax ID

NMLS License Number

License

Federal Tax ID

Figure 59: Add Contacts Dialog (Leads)
Note: If the Other was selected, enter a label for the Other Type.

3. If needed, enter a Reference.

4. If Seller #1, 2, 3, 4 are selected, ensure that an option was selected from the Entity

dropdown menu.

5. Enter contact information of the individual or the entity.

Additional Details

Add additional information about the contact's licenses or identification.

ADDITIONAL DETAILS

Contact Detail State Company Detail

State

NMLS License Number NMLS License Number

License License

Federal Tax ID

Federal Tax ID

Figure 60: Additional Details
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Select a license/identification in the list to add details.

Contact Detail Type NMLS License Number Company Detail Type MNMLS License Number

Detail Detail

Save & Close

Figure 61: Edit Detail Dialog

Adding Contacts Using the Directory

Use the Directory B icon to added contacts from the Directory. For more information about
the Directory see Directory.

To add contacts:
1. On the Status screen.
2. Select the Directory Biicon.
3. Choose the desired contact(s) or use the Search bar to enter a contact parameter.

Note: Only one of each Contact Type is allowed per Lead if multiple contacts are selected
from the Directory.

Note: If a contact of the same type was selected, Zenly will prompt the user to overwrite
the prior contact.

‘ Add from Directory X
Search Q
Type Contact » Company Telephone Email
D Applicable Point of Contact  First Contact Entered, Ma... Great Demo Bank @cal
D Appraiser Freddie Mac Integration S... integrationsupport@
D Broker Calyx Test Calyx Software
D Lender/Mortgagee Great Demo Bank @cal
D Loan Originator Calyx Software @gmail.co
D Loan Originator @freddie
4 >
o

Figure 62: Add from Directory
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4. Click OK.
CONTACTS Bi o
Type Contact Company Telephone Email
Appraiser Freddie Mac Integration S... integrationsupport@fredd... w
Broker Tim L Tester Broker Inc. B w

Figure 63: Contact Through Directory

Note: Contacts that are added from the Contacts screens can be added to the Zenly
Directory by selecting the icon displayed next to the Delete 1 icon.

Qualification

The Qualification screen allows the user to provide Loan Comparisons for the lead.

Loan Comparisons

The Loan Comparisons screen allows the user to swiftly create loan scenarios and compare
loan possibilities. Use the Loan Comparisons screen to create loan scenarios for more
information.

Note: The user can select a maximum of three (3) loan scenarios to compare.

b Zenly LEADS/LOANS REPORTS USERS TEMPLATE ‘ e

Status  Qualification Documents

Lead ID : 20230303000011 - Ken N Customer

Figure 64: Loan Comparison

To compare loan scenarios:

1. Select the desired 2 or 3 scenarios in the table.
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2. Enter how many months to compare.

Status  Qualification Documents

Lead ID : 0230303000011 - Ken N Customer ES
LOAN SCENARIO Months to Compare 48 o
Sales Price/ Down o ]
Products Est. Appraised Val Payment Amount Loan Amount Note Rate Proposed Payment
30 yr Mortgage 420,000.00 84,000.00 336,000.00 4.000 2,422.12 ]
15 Yr Mortgage 420,000.00 84,000.00 336,000.00 4.000 3,303.35 o
D 15 Yr ARM 420,000.00 84,000.00 336,000.00 2.000 2,162.19 ]
:] 30 Yr ARM 420,000.00 84,000.00 336,000.00 2.000 1,24192 ]

Figure 65: Months to Compare
3. Click on the Compare button.

Lead ID : 2023030300001 1 - Ken N Customer
COMPARE SCENARIOS
30 yr Mortgage 15 Yr Mortgage
Loan Type Conventional Conventional
Loan Purpose Purchase Purchase
Estimated Appraised Value 420,000.00 420,000.00
Sales Price 420,000.00 420,000.00
Down Payment Amount 84,000.00 84,000.00
Down Payment Percentage 20.00 20.00
Base Loan Amount 336,000.00 336,000.00
Up-Front M Financed
Total Loan Amount w/MIP,FF 336,000.00 336,000.00
Note Rate 4.000 4.000
Amortization Term (Months) 360 180
Total Monthly Payment 1,604.12 2,485.35
Proposed Payment 242212 3,303.35
Estimated Closing Costs 29,830.00 29,830.00

Figure 66: Compare Scenarios

Note: The scenarios are available in print form through the Documents tab.
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Drag & Dropping Scenarios

Users can arrange loan scenarios by dragging & dropping them in the desired order.

Status  Qualification | Documents

Lead ID : 20230303000011 -Ken N Customer Save

wensstocomere o [ ©

Sales Price/ Down Total
Products Est. Appraised Val Payment Amount Loan Amount Note Rate Proposed Payment
[J 15YrARM 420.000&0 84,000.00 336,000.00 2.000 2,162.19 o
:] 30yr Mortgage 420,000.00 84,000.00 336,000.00 4.000 2,422.12
:] 15Yr Mortgage 420,000.00 84,000.00 336,000.00 4.000 3,303.35
:] 30 Yr ARM 420,000.00 84,000.00 336,000.00 2.000 1.241.92 W

Figure 67: Drag & Drop Scenario
Generated Loan Scenario Documents

When generating a printable Loan Comparison document, ensure that the desired scenarios
are selected. Drag and drop the scenarios into the desired order that they will appear in the

Loan Comparison. If no scenarios are selected, the top three scenarios in the Loan Scenario

table will appear in the printable loan comparison document.

Status  Qualification  Documents

Lead ID : 20230303000011 - Ken N Customer Save }
Sales Price/ Down Total
Products Est. Appraised Val Payment Amount Loan Amount Mote Rate Froposed Payment
o 30 yr Mortgage 420,000.00 84,000.00 336,000.00 4000 242212 o)
o 15 ¥r Mortgage 420,000.00 24,000.00 336,000.00 4000 3,303.35 T}
o 30 Yr ARM 420,00 —— &
Loan Comparison
] 15¥r ARM 420,00 :|
Providad For: [Te—
Providad By
Laan Program 10 ye Wamgage 18 ¥r Mertgagn 309 ARM
Furchass Frice ey e rep
Down Paymest 1000 (884 100 06 B00008 (44 W0H0D 20.000% /8B 000 00
. Loan maunt smam ssa0m0m w00
Generate Print e amcn 2
Document — e oo e iz
Friceal 8 bins Preh sass sz
Eubordinale Lisr
Hemeoumer's Inauance: wmm s
Supphernntal Progery nsirsncs

Figure 68: Scenarios

Creating Loan Scenarios

Before loans can be compared, create, and add loan scenarios to the table.

To create a Loan Scenario:
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1. Select the Add © icon.

‘ zenly LEADS/LOANS ~ REPORTS ~ USERS  TEMPLATE A O

Status  Qualification Documents

Lead ID : 20230303000011 - Ken N Customer

Figure 69: Loan Scenario
2. Enter a Product name.

Note: A Product name is required before saving and exiting.

“ Zen |y LEADS / LOANS REPORTS USERS TEMPLATES ‘ e

Status Qualification Documents

Lead ID : 20230303000011 - Ken N Customer

0 2 3

Proposed Housing Expenses Estimated Closing Costs

I Product 30yr Mortgage I

Loan Program Scenario Fees Template

LOAN INFORMATION

Loan Type Conventional v Note Rate %

Other Description Estimated Appraised Value 3

Loan Purpose Purchase v Sales Price &
Other Description Base Loan Amount % @
Construction Type v Down Payment Amount &
Cash-Out Type v

Amortization Term Months

Save & Exit Next

Figure 70: Create Scenario

3. If needed, click the Select button to choose a Loan Program Scenario.

Note: The tables will auto-populate based on the scenario selected.

4. If needed, click the Select button to choose a Fees Template.

Note: The tables will auto-populate based on the template selected.

5. Adjust the desired values in the Loan Information section.
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Loan Information

Use the Loan Information section to add or adjust the fields to the desired values. Save after
adding or adjusting values before continuing to the next step.

LOAN INFORMATION

Loan Type v Note Rate

Other Description Estimated Appraised Value $

Loan Purpose v Sales Price $
Other Description Base Loan Amount $ @
Construction Type v Down Payment Amount  $
Cash-Out Type v Amortization Term Months
OC(UPBW(\/ v Loan Term Months
Lien Position h Interest-Only Months
Amortization Type M Total Loan Amount w/MIP.FF  $

Monthly Payment %

Figure 71: Loan Information
PMI/MIP/VA/USDA

If needed, add information for mortgage insurance. Save after adding or adjusting values
before continuing to the next step.

PMI/MIP/VA/USDA

Up-Front Monthly
PMI/MIP/VA/USDA  PMI Renewal 1 PMI Renewal 2

PMI/MIP/VA/USDA Y Rate Percentage
PMI/MIP/VA/USDA Amount % Monthly Dollar Amount & $ $
Additional Amount Paid in Cash & Monthly Amount % % %

Up-Front MIP/PMI/VA Funding 2 Manths

Fee Financed
Calculation Based on Base Loan Amount v

Figure 72: PMI/MIP/VA/USDA

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

58


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

™

calyx Zenly User Guide

Rate Adjustment

If needed add any rate adjustment to the scenario. Save after adding or adjusting values
before continuing to the next step.

RATE ADJUSTMENT
Adj Cap Months Index Type -
1st Change
Other Description
Adj Period
Rate Rounding Options
Life Ca
P Rate
Margin
Rate Round To v
Index
Alt. Index
Floor

Figure 73: Rate Adjustment Scenario
Proposed Housing Expenses

Use this section to include any housing expenses to the loan scenario. Once satisfied with
the added expenses, click Next.

Lead ID : 20230303000011 - Ken N Customer [ sae |
e 3
Loan Estimated Closing Costs

First Mortgage 3

Subordinate Lien(s) $
Homeowner's Insurance $
Supplemental Property Insurance |
Property Tax | &

Monthly Mortgage Insurance &
Association/ Project Dues  $

Other %

Total Proposed Payment

T New

Figure 74: Housing Expenses Scenario
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Estimated Closing Cost

Use this section to include any closing costs to the scenario. Use the Fee Template

dropdown menu to auto-populate the table. Adjust any desired value and select the Save &

Exit button.

Lead ID : 20230303000011 - Ken N Customer

CREATE SCENARIO

Loan Comparison

Loan

Prepaid Finance Charge i

Amount Financed g

Proposed Housing Expenses

Fees Template
Finance Charge 3

APR

Save

%

PFC = Prepaid Finance Change (APR items) FHA = FHA Allowable POC = Paid Outside of Closing FIN = FIN - QM
A. ORIGINATION CHARGES [+
Fee Pay To Borrower-Paid Seller-Paid Other Paid
Company Name AtClosing  Before Closing At Closing ~ Before Closing

Loan Amount (Points)

Previous

Save & Exit

Figure 75: Estimated Closing Costs

Deleting a Loan Scenario

To delete a loan scenario, select the Trash icon.

Lead ID : 20230303000011 - Ken N Customer

LOAN SCENARIO

Months to Compare

Save
B o

Sales Price/ Down Total
Products Est. Appraised Val Payment Amount Loan Amount Note Rate Proposed Payment
j 30 yr Mortgage 420,000.00 84,000.00 336,000.00 4.000 2,422.12
D 15 Yr Mortgage 420,000.00 84,000.00 336,000.00 4.000 3,303.35 W
D 15Yr ARM 420,000.00 84,000.00 336,000.00 2.000 2,162.19 i}
j 30Yr ARM 420,000.00 84,000.00 336,000.00 2.000 1,.241.92 o]

Figure 76:

Deleting Loan Scenario
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Documents Stored (Leads)

The Stored screen allows the user to upload PDFs and store them. Use this screen to view
any stored documents or delete unnecessary ones.

Status | Qualification  Documents

Lead ID : 20230303000011 - Ken N Customer Save
a &

Generate

Request
ALL OTHER DOCUMENTS

Document Stored By

Copy of Driver's License 03/06/2023 11:40 AM PED

PACKAGE NAME

Document Stored By

Passport Copy 03/07/2023 02:55 PM =] . k)

Figure 77: Lead Documents

Uploading a PDF

To upload a PDF:

File Types allowed:

o TXT e DOCX
e MSG e BMP
e PDF e RTF

e PNG e HTML
e JPEG e TIFF

e JPG e XML
e GIF

1. Select the Upload B icon.

2. Enter a Document Name.

Upload b o

Document Name Prepared
Date
Category v
Package
Name
Stored Date C]

Choose File | No file chosen

EIEZ

Figure 78: Upload Dialog
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© N O o AW

Choose a Category for the document.

Select a Prepared Date.

Enter a Package Name.

Click the Choose File button to browse for the desired PDF.
After the PDF is chosen, select Open.

Click on the Store button to complete the upload.

Searching for Lead Documents

Use the Search Bar to locate a specific PDF.

To search for a PDF:

1. Click inside the text field.

2.

Enter the name of the document.

3. Press Enter or click on the magnifying glass icon.

Previewing, Downloading, and Deleting

The entries contain functions for each uploaded. The user can preview, download, or delete
the desired PDF.

Status | Qualification Documents

Lead ID : 20230303000011 - Ken N Customer Save
.
Search Q +]
Generate
Request
ALL OTHER DOCUMENTS
Document Stored By
Copy of Driver's License 03/06/2023 11:40 AM PEm
PACKAGE NAME
Document Stored By
Passport Copy 03/07/2023 02:55 PM BEm

Figure 79: Table Functions
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Documents Generate (Leads)

Generate printed loan comparisons. Preview the generated document by selecting the
associated icon when selecting Loan Comparison.

Status | Qualification = Documents

Lead ID : 20230303000011 - Ken N Customer

Save
Stored
DOCUMENT SELECTION LIST SELECTED DOCUMENTS
Request QUALIFICATION

Document

Loan Comparison

Figure 80: Documents Generate

To generate a printable loan comparison document:

1. Ensure that the desired loan scenarios are arranged at the top of the Loan
Comparison table. See Generated Loan Scenario Documents,

2. Select Documents > Generate.
Select Loan Comparison.
Select Store.

Note: Stored loan comparisons are available in Documents > Stored for leads.

Lead ID : 20230303000011 - Ken N Customer

Save
Stored
DOCUMENT SELECTION LIST SELECTED DOCUMENTS
Request QUALIFICATION

Document Document Prepared Preview

Loan Comparison 08/03/2023 \B @’

Loan Comparison

Figure 81: Store Document
5. Enter Package Name or the Skip button.
6. Click Set.

Document Request (Leads)

The Document Request screen allows the user to request documents from the lead.

Note: Document request recipients must have a valid email address on file.

1. Select Documents.
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2. Select Request.

Status | Qualification  Documents

Lead ID : 20230303000011 - Ken N Customer
Stored
PENDING
Generate o
Document Due Requested Sent To
Government ID 2023-04-19T05:00:00Z ]

REVIEW

COMPLETED

Figure 82: Documents Request (Leads)

Pending

Use the Pending options to request missing documents from appropriate parties.
1. Click the Add © button.

2. Select or enter the Document Name.

Add Document Request X

Document v Memo to Borrower
Name
Borrower Ken N Customer
7
Category W
Due Ec

Figure 83: Add Document Request Dialog (Leads)

3. Select the document Category from the dropdown.
Note: Leave Category blank when the document category is not listed.
Use the Calendar to select the Due date and Time.

Enter a memo to the request recipient if Memo to Borrower does not auto
populate.

6. Click Save & Close or Save & New.
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7. Click Send when requested documents are listed.

Status | Qualification  Documents
Lead ID : 20230303000011 - Ken N Customer

Stored

Generate PENDING o

Document Due Requested Sent To

Government ID 2023-04-19T705:00:00Z w

REVIEW

COMPLETED

Figure 84: Send Document Request (Leads)

8. Click Send To.

Send Document Request X

Send Ken N Customer L Email
To
Barrower Document Due
Ken N Customer Government ID 04/20/2023

Figure 85: Send Document Request

Review

Document requested appear in the Review List after return from requestor.

1. Click the Preview icon.

REVIEW

Borrower Document Name Requested Received

preV

o m

Ken N Customer Government ID 04/20/2023 04/20/2023

Figure 86: Review Received Documents

2. Click Accept to approve the received document.

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

65


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

calyx Zenly User Guide

3. Click Reject to reject the document.

Note: The rejected document moves back to the Pending List to return to the requestor.
Completed

Accepted documents move to the Completed List.

[ REVIEW
COMPLETED
Borrower Document Name Requested Received Preview Accepted
Ken N Customer Government ID 04/20/2023 04/20/2023 B 04/20/2023

Figure 87: Completed Document Requests

Run Pricing

The Run Pricing function for leads works to find a suitable loan product for the lead. Use this
screen to filter through the available loan products and select eligible products for the lead.

To use the Run Pricing function:
1. Open the desired Lead file.

2. Enter applicable information for the Status screen.
3. Select Run Pricing.

Status Qualification Documents

Lead ID : 20230303000011 -Ken N Customer

Run Pricing J\ nvite Lead ‘ Initiate Loan || Save |
— Pl °
Contacts
Status Description Date/Time By
1
B Surmary inf Qualified 03/13/2023 1021 AM
Housing Expense: 4.750% i
Unqualified Doesn't make enough
Debt-te-Income : 5.038%
BasaLTV: % Hew
@ ALERTS [+]
@ CONVERSATION LOG [+]
Type Description By Date/Time
Phone Call

03/13/2023 10:17 AM

Figure 88: Run Pricing

Availability Screen

1. Ensure that the Availability Search table contains the correct information.

Note: Values in the Availability Search table are auto-populated from the Status screen.
OR
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2. Click on the Select button to choose a Loan Program Scenario. See Loan Program.

Lead ID : 20230303000011 - Ken N Customer

@ summary Info an Program Scenario

@ AVAILABLE PRODUCTS SEARCH @ AVAILABLE PRODUCTS

\Furpuse  Purchase v 10/6 ARM 10 ¥r 10 5/1/5
Central Pacific Bank

Pontfolio SOFR 1041/6mo Interest Only AR

10/6 ARM 5/1/5

Central Pacific Bank

] Porifolio P8 Asset Based SOFR 10yr/Emo ARM
85000000 30y Fixed
745,750.00 Central Pacific Bank

95.000%

Figure 89: Choose a Loan Program
3. If needed, use the Advanced Search fields to enter more values.

Note: If no lead information is added to the Availability Search table, all loan products will
appear in the Available Products table.

4. Select the desired product(s) from the investor.
5. Click Save.
6. Click Next.

Eligibility Screen

Review the information in the Eligibility screen.
1. Edit or enter Loan Information if applicable.

Note: Select a single product from the Showing Eligibility for dropdown menu to show
eligibility parameters for that one product.

Lead ID : 20230303000011 - Ken N Customer | s |
Tracking Gis
Contac =
@ LOAN INFORMATION Showing Eligibility for: Al Selected Products v
© summary Info
b LoanPurpose  Purchase Ld Base Loan Amount  § 745,750.00

Primary Residence v Other Financing Amaunt
First ~ Amortization Term 360 il Months
2 LTV 95.000 %
Loar b LT

° BORROWER INFORMATION

Citizenship ~ Debt-to-Income 5.038 %
Bankruptcy Typ ¥ T

For Months

Rankrinteu Dicsharaad Maonths

Figure go: Select Products
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2. Edit or enter Borrower Information if applicable.
3. If needed, select Product Features.
4. Edit or select Property Information.
5. Click Save.
6. Click Next.

Pricing Screen

The Pricing screen will populate products that are eligible and ineligible for the lead.
Expand the table to see all loan products that fit or don't fit the lead's criteria.

Eligible Product

Expand the Eligible Products table to view all loan products to view all loan products that fit
the lead's criteria.

Select the Calendar & icon to view the Interest Rate table for the selected loan product. Rate
Adjustments and Price Adjustments appear below the table.

° ELIGIBLE PRODUCTS

7.000% 2500 0.250 0125 0500 0125 -0.250 1.000 0.875 1375

7.250% 0750 0500 0375 0.250 0.250 0.125 -0.500 0.500 1.000

Figure 91: Eligible Products
To choose the Eligible Products:
1. Expand © the Eligible Products table.
2. Select the desired loan products.

3. Select Save Scenario.
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4. Select either or both to save as a New Loan Comparison Scenario(s) and/or to the
Lead's Loan Information table.

Save Pricing Scenario

Where would you like to save the selected pricing scenario(s)?

D New Loan Comparison Scenario(s)

D Lead's Loan Information

Figure 92: Save Pricing Scenario

5. Use the dropdown menu to select the desired product.
6. Click OK.

To view this Pricing Scenario(s), see Loan Comparisons.

Ineligible Product
Expand the Ineligible Products table to view all loan products that don't fit the lead's criteria.

The table lists the ineligible products as well as the cause for the ineligibility.

@ INELIGIBLE PRODUCTS Results as of 02/27/2024 8:28 AM
Investor 30 Yr Fixed Reasons
Central Pacific Bank FHLMC LP 30 Yr Fixed No... Occupancy Statuses = Investment
FHLMC LP 30 Yr Fixed Re... Loan Purpose Types = Refinance
FNMA DU 30 Yr Fixed No.. Occupancy Statuses = Investment
FNMA DU 30 Yr Fixed Re... Loan Purpose Types = Refinance
Portfolio 30 ¥r Fixed Max LTV = 80.000%
Portfolio Condotel 30 Yr ... Min Loan Amount = $1,149,826

Max LTV = 70.000%

Portfolio Foreign Nationa... Max LTV = 70.000%

Portfolio Jumbo 30yr Min Loan Amount = $1,149,826
Max LTV = 80.000%

Portfolio LLC/Trust 30 ¥r ... Max LTV = 70.000%

Portfolio PB Asset Based ... Max LTV = 70.000%

Figure 93: Ineligible Products
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Initiate Loan

The Initiate Loan button allows the user to start the loan process by creating a loan file from
the lead. Zenly will use the available information in the lead.

Status Qualification Documents

Lead ID : 20230303000011 - Ken N Customer [ Run Pricing H Invite Lead Initiate Loan H Save ]

® s °

Contacts

Status Description Date/Time By

F® Summarv Info

Figure 94: Initiate Loan Button

To initiate a loan:
1. Select the Initiate Loan button.

2. Select Import Data from ZIP Interview if applicable.

Lead ID : 20230303000011 - Ken N Customer
Contacts
@ Summary Info 2 3
Housing Expense : 4.750% Select Documents Summary
Debt-to-Income : 5.038%
BaseLTV: %
@ File Contact Import Data from Interview

Figure 95: Initiate Loan Screen

Note: If there are no documents uploaded for the lead, the Select Document step will not
appeatr.

4. If documents are stored, select the desired PDFs to copy over to the loan file.
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5. Use the icons associated with the documents to preview or delete the selected

PDF.

Lead ID : 20230303000011 - Ken N Customer

INITIATE LOAN

Contacts
Borrower Source

@ summary Info
Housing Expense : 4.750%
Debt-to-Income : 5.038%

BaseLTV: %

Search

N

3

Summary

Save

Copy of Driver's License

Previous

03/06/2023

Q
STORED DOCUMENTS SELECTED DOCUMENTS
Document Name Stored Date Document Name Preview
Loan Comparison 08/03/2023 B Loan Comparison 5] w
Passport Copy 03/07/2023 [ Passport Copy [&] jm)

Figure 96: Selected Documents

6. Click Next.

7. Review the Summary.

Lead ID : 20230303000011 - Ken N Customer

@ summary Info

INITIATE LOAN

Contacts
Housing Expense : 4.750% Borrower Source
Debt-to-income : 5.038%

BaseLTV: % SELECTED SOURCE

Select Documents

Ken Customer

SELECTED DOCUMENTS

. Loan Comparison

[, Passport Copy

Exit

Figure 97: Summary

8. Click on the Create Loan button to complete the initialization.
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Chapter 4: LOANS

The Home and the Leads/Loans contains the loan files the user has available. The user can

identify a Loan file by the icon ©. Use either screen to create a new loan file or open an

existing loan.

” Zenly LEADS / LOANS REPORTS USERS TEMPLATES 'ﬁ e
Name Status Status Date Telephone Email Property Address Owner/LO

©  AndyAmerica Lead 07/13/2023 andy.a@fanniema 1234 Rodman St John Done

¥ Andy America New 07/10/2023

©  AndyAmerica Lead 01/13/2023

©  AndyAmerica Lead 11/30/2022 (508)333-2211 andy.a@fanniema 1234 Ocean Pines

©  AndyAmerica Lead 11/0172022 (508)777-7777 andy.a@fanniema.. 1234 Rodman St

©  AndyAmerica Lead 11/01/2022 (508)777-7777 andy.a@fanniema. 1234 Rodman St

©  AndyAmerica Lead 11/01/2022 (508)333-2211 andy.a@fanniema. 1234 Ocean Pines

©  AndyAmerica Lead 11/01/2022 andy.a@fanniema 1234 Rodman St

©  AndyAmerica Prospect  09/26/2022 (508)333-2211 andy.a@fanniema.. 1234 Ocean Pines

©  AndyAmerica Lead 07/18/2022 (508)888-8888 andy.a@fanniema.. 1234 Ocean Pin.. John Done

©  AndyAmerica Lead 06/02/2022

©  AndyAmerica Lead 06/01/2022

New Loans

Figure 98: Leads/Loans

Create new loans by completing the Zenly screens during a borrower interview or using the
import function. Users can import single or batch loan files.

Creating a New Loan File

Use the New File button to create a new loan file during a borrower interview.
1. Click New File.

2. Select the New Loan option.

e

0 O

% New Lead

‘f O New Loan

Figure 99: Create New Loan
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3. Select the Blank Loan option.
4. Click Create.

© Blank Loan

O Import

Import one or more Fannie Mae 3.2 (.fam) or Fannie Mae m
3.4 MISMO (.xml) files

Figure 100: Create Loan Dialog

5. Proceed to Application Borrower.

Importing Loan Files

Use the import function to import Fannie Mae 3.2 (FNM) and Fannie Mae MISMO 3.4 (XML)
files.

To import loan files:
1. Select New File.
2. Select New Loan.

0 6

e ¥ New Lead

‘f © New Loan

Figure 101: Create New Loan

3. Select the Import option.
4. Click Select Files.

O Blank Loan
@ Import

Import one or more Fannie Mae 3.2 (.fanm) or Fannie Mae Select Files
3.4 MISMO (.xml) files
=

Figure 102: Import Loans
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5. Browse to the stored FNM/XML files.
6. Highlight the file.
7. Click Open.

Drag & Drop Import

Use the drag and drop import feature to drag FNM/XML files to Zenly instead of browsing
to the file(s).

Access the Zenly Loan List. (See Figure 7))

Browse to the stored FNM and/or XML files.

Select the files.

Drag the files to the loan list.
Click Import.

o0 A W N e

Click Close when import is complete.

Loan Status

The Status tab enables loan progress tracking from prequalification to close. The Loans
Status screens provide status information for the selected loan. The following options are
available for loan status.

Loan Export

Use the loan Export option to select and export files from Zenly to a designated location.
Zenly exports the loan application as an XML file.

1. Select afile.

‘ Zenly LEADS / LOANS REPORTS USERS TEMPLATES 'ﬂ e
Status Application Processing Underwriting Reporting Documents Services Settings
Loan ID :20221101000011 - Amy America Export Save
© sns °

Contacts Date Status Description By

Conversation Log

,,,,,,,,,,,,,,,,

Figure 103: Export File
2. Click Export.
3. Click Open File to view the exported file.

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

74


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

v

calyx Zenly User Guide

4. Click the Ellipse to view export options.

Open
Always open files of this type
Show in folder

Copy download link

Report this file as unsafe

Delete file

Cancel
0201026000004.fam 'K
O Open file i

Figure 104: Export Options

Note: The exported file is an XML file when exporting the Loan Application.
5. Select the appropriate Export option.
6. Browse to the appropriate folder and save the export.

Note: See Mortgage Market Exchange for sending exported files to third-party vendors.

Status Tracking

The Status Tracking screen opens by default after selecting a loan. Use the Tracking
options to track and update loan application/processing status.

Track Loan Status

Review and update loan status information. Only the Status Description can be updated from
the Status List. The Status as well as the Date/Time synch with the Closed Date and the
Application Date for the Mortgage Call Report. See Mortgage Call Report 2024.

Note: See Add Status to enter a new loan status.
1. Select the Status.
2. Select Tracking. (See Figure 101)
3. Click current Status to edit.
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4. Update the Description.

Add Status

]

Date/Time  04/23/2024 11:26 AM Bo
Status ~

Description

Figure 105: Update Status

irnTe

5. Click Save & Close.

Add Status

Add new loan statuses as the application progresses. The new status populates in the
Status list without overwriting existing statuses.

Note: Use Add Status to change a loan Lead to a loan application.
1. Click Add.

Loan ID : 20211104000001 - Andy America Export Save
o

Contacts Date Status Description By

Conversation Log 11/04/2021 4:46 PM Lead

Figure 106: Add Loan Status
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2. Select the appropriate status from the dropdown.
Add Status

Date/Time 04/23/2024 11:26 AM [=:XC)
By
Status

Description

Figure 107: Add Status Dialog

3. Enter status Description.
4. Click Save & Close to add the status to the Status List.

Loan ID : 20211104000001 - Andy America

e ©
Contacts Date Status Description By
Conversation Log I 03/14/2023 3:34 PM Application Application in progress. I
11/04/2021 4:46 PM Lead

Figure 108: New Application Status

Note: Use Save & New to add another status.

Edit Statuses

Review and update loan status information. Only the Date/Time and Description can be
updated from the Status List.

Edit Status

/|

Date/Time ™ 11/01/2022 11:33 AM = {C]

By

Status Lead
De%

Save & Close

Figure 109: Edit Status
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Alerts

The Alerts section allows the user to view active and cleared alerts for the loan. Users can
view the alert by selecting an item from the table. Use the © button to add an alert for the
loan.

@ ALERTS ©
Description Created » Due Cleared Assigned To

Active

Add new Contacts. 11/16/2023 03:05 PM

Print loan comparison documents. 11/16/2023 03:05 PM

Initiate Loan 11/16/2023 03:04 PM

Cleared

Print loan comparison documents. 08/03/2023 03:01 PM 08/03/2023 03:01 PM 09/05/2023 08:48 AM

Add new Contacts. 08/03/2023 02:59 PM

Initiate Loan 08/03/2023 02:59 PM 08/03/2023 03:00 PM

Figure 110: Alerts (Loans)
Note: Alerts CANNOT be deleted.

Add Alerts
To add an alert for the loan file:

1. Click onthe @ icon.
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2. Enter a Description.

el

hTI

=

Add Alert x4

Borrower

Ken N Customer

Description

Due Date/Time

Assigned to

Clear

[ | Created Date/Time

08/07/2023 8:24 AM

By

Alert Automatically

Figure 111: Add Alerts

3. Select a Due Date/Time for the alert to notify.

4. Select Save & Close to exit the window.

Edit Alerts

Only Active alerts are editable. Select an alert from the Active side of the table to open the

Edit Alerts screen.

@ ALERTS

(+]

Description

Created » Due Cleared Assigned To

Active
Add new Contacts
Print loan comparison documents,

Initiate Loan

11/16/2023 03:05 PM

11/16/2023 03:05 PM

11/16/2023 03:04 PM

Cleared

Add new Contacts

Initiate Loan

Print loan comparison documents.

08/03/2023 03:01 PM 08/03/2023 03:01 PM 09/05/2023 08:48 AM

08/03/2023 02:59 PM

08/03/2023 02:59 PM 08/03/2023 03:00 PM

Clearing Alerts

Figure 112: Edit Active Alerts

Even if Alerts can't be deleted, alerts can be cleared.

To clear an alert;

1. Select the checkbox for the undesired alert.
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@ ALERTS (+]
Description Created - Due Cleared Assigned To
Active
E Initiate Loan 02/26/2024 09:32 AM 02/24/2024 12:00 AM
Email 02/26/2024 09:29 AM
C
Facebook Message 02/26/2024 09:29 AM 02/26/2024 09:30 AM
Call 02/26/2024 09:29 AM 02/29/2024 12:00 AM 02/26/2024 10:03 AM

Figure 113: Clearing Alerts
2. Select the Clear button.

The undesired alerts will move to the Cleared section of the table.

Status Contacts

The Status Contacts List provides a location to save contact information for relevant loan
contacts.

Add Contact

Add additional loan Contacts to the Contact List.
1. Select the Add © button.

Status ~ Application  Processing  Underwriting Reporting Documents  Services  Settings

Loan ID : 20221101000011 - Amy America

Tracking CONTACTS Ei o

Conversation Log

Loan Originator 2] w

Processor B | m]

Figure 114: Add Contact
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2. Enter Contact details.

-

Contact v First Company
Type Name
Middle
Other Type Address
Last
Reference Unit v Number
Suffix Designator
Entity v
Position City
Telephone (- State/Province v
Extension Postal Code
Email County
Country v
Telephone D D
Extension
Fax [ P,
ADDITIONAL DETAILS
Contact Detail State Company Detail State

Figure 115: Add Contacts Dialog
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3. Select Additional Details fields to add information if required.

Add Contacts X
i - o "
Email County
Country v
Telephone (S PG,

Extension

Fax S B S

ADDITIONAL DETAILS

Contact Detail State Company Detail State
NMLS License Number NMLS License Number

License License

Federal Tax ID Federal Tax ID

Web Site Address Web Site Address

Affiliate of Lender Affiliate of Lender

Figure 116: Additional Contacts Details
4. Click Save & Close.
Note: Click Save & New to add another contact.

Edit Contacts List

Use the following steps to edit the loan Contacts List.
1. Select the Status.
2. Select the Contacts tab.

3. Click a Contact entry to edit.

Status ~ Application  Processing  Underwriting Reporting Documents  Services  Settings

Loan ID :20221101000011 - Amy America Export Save
Tracking CONTACTS Es 0
Contacts q

_ Type Contact Company Telephone Email

Conversation Log . ’/ .
Loan Originator B W
Processor 2] w

Figure 117: Loan Contacts List
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4. Make appropriate contact information changes.

Edit Contacts b4

-

Contact Appraiser 4 First Sam Company Appraisers Inc
Type Name
Middle
Other Type Address
Last Appraiser
Reference Unit v Number
Suffix Designator
Entity £
Position City
Telephone ) - State/Province v
Extension Postal Code
Email County
Country v
Telephone -
Extension
Fax S P
ADDITIONAL DETAILS
Contact Detail State Company Detail State
Save & Close

Figure 118: Edit Contacts Dialog

5. Select Additional Details fields to edit information if required. (See Figure 112)

6. Click Save & Close.
Delete Contact

Delete contacts that are no longer required.

1. Click the Delete icon for the contact to delete.

Status Documents  Services

Application

Processing  Underwriting  Reporting Settings

Loan ID :20221101000011 - Amy America

Export Save

Tracking CONTACTS Bi 0

Contacts q

_ Type Contact Company Telephone Email -~

Conversation Log ‘
Loan Originator 2] i}
Processor =] ]

Figure 119: Delete Contact

2. Click Delete on the Delete Confirmation dialog.
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Adding Contact Using the Directory

Use the Directory B icon to added contacts from the Directory. For more information about
the Directory see Directory.

To add contacts:
1. On the Status screen.
2. Select the Directory Biicon.
3. Choose the desired contact(s) or use the Search bar to enter a contact parameter.

Note: Only one of each Contact Type is allowed per Loan if multiple contacts are selected
from the Directory.

Note: If a contact of the same type was selected, Zenly will prompt the user to overwrite
the prior contact.

|
‘ Add from Directory »

Search Q
Type = Contact » Company Telephone Email

I:] Applicable Point of Contact ~ First Contact Entered, Ma... Great Demo Bank @cal

E] Appraiser Freddie Mac Integration S... integrationsupport@

D Broker Calyx Test Calyx Software

m Lender/Mortgagee Great Demo Bank @cal

E] Loan Originator Calyx Software @gmail.co

D Loan Originator @freddie
4 >

Lor

Figure 120: Add from Directory

4. Click OK.
CONTACTS E 0
Type Contact Company Telephone Email
Appraiser Freddie Mac Integration S... integrationsupport@fredd... w
Broker Tim L Tester Broker Inc. 53 w

Figure 121: Contact Through Directory

Note: Contacts that are added from the Contacts screens can be added to the Zenly
Directory by selecting the icon displayed next to the Delete @ icon.
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Status Conversations

Use Status Conversations to track communications with borrowers and loan contacts.

Note: Conversation Log entries cannot be altered or deleted after saving.

1. Select the Status tab.
2. Select Conversation Log.

Loan ID :20221130000002 - Amy America

Tracking CONVERSATION LOG

Contacts

Date/Time

By

Notes

Figure 122: Loan Conversations

3. Click Add.
4. Enter conversation details.

Date/Time

By

12/27/2022 3:32 PM

Save & Close

Figure 123: Add Item Dialog
5. Click Save & Close to add the item to the Conversation Log.

Loan Application

Use the Loan Application screens to enter/update borrower and loan information details.

Application Borrower

The Application Borrower screen contains options for capturing borrower details. Enter initial
borrower information and return to update as additional information is provided.
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1. Select the Application tab.

Status  Application = Processing  Underwriting  Reporting Documents  Services  Settings ll

Loan ID : 20221101000011 - Amy America Export
Lomn L O  AmyAmerica- Primary
(7]
Subject Property
Initial Fees Worksheet Loan Originator v Loan Originator Signature 8
Estimated Cash-to-Close
CONTACT INFORMATION
Loan Estimate
Fannie Mae Addendum BORROWER CO-BORROWER
Freddie Mac Addendum
First Amy First

Anti-Steering

Middle Middle
Escrow Account
Initial ARM Disclosure Last  America Last
HOEPA Counseling List Ui Ui

Figure 124: Application Borrowers
2. Select Borrower.

Note: The Borrower radio button title populates with the primary borrower's name after
completing the Borrower Information. (See Borrowers for details.)

3. Select the radio button for a listed borrower to view an overview of the selected
borrower.

4. Drag and drop the desired borrower to the top of the table to make them the
Primary borrower.

5. Use the Loan Originator dropdown menu to select the desired contact.

Note: The selected loan originator will auto-populate in the Status Contacts screen.
Selecting a new loan originator from the dropdown menu will replace the existing one.

6. Select the Loan Originator Signature Date.
Borrowers
Borrowers may be added to the loan throughout the loan process.

Add Borrower
Use the following steps to add a borrower other than co-borrower to the loan.

1. Click the Add Borrower icon.

® -Primary

i Re B

Figure 125: Add Borrower

2. Proceed to Borrower/Co-Borrower Information to complete the borrower details.
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Import From Leads
The user can import a borrower by using leads.
To Import from Leads:

1. Select the Add Borrower icon.

Loan ID : 20221101000011 - Amy America
o Andy America - Primary
Loan i° O . America- Primary
m

Subject Property

Initial Fees Worksheet Loan Criginator v Loan Originator Signature =]

Figure 126: Adding a Borrower

2. Choose Import from Leads.

Add Borrower Set

C) Blank Borrower Set

@ Import from Leads

Figure 127: Import from Leads

3. Click Next.
4. Search for the desired Lead Contact using the search bar.

Note: If the Lead contains no stored documents, the screen will skip to the Summary step.

Loan ID:20221101000011 - Amy America Export Save ‘
Loan D
Subject Property [ 2 3

Initial Fees Worksheet

Select Documents Summary

Loan Estimate

LEAD CONTACT

Fannie Mae Addendum
tm Q @ File Contact Import Data from Interview
Freddie Mac Addendum

Anti-Steering SELECTED SOURCE

Escrow Account Tim Tester
Initial ARM Disclosure

HOEPA Counseling List

Figure 128: Searching Leads

Click on the magnifying glass icon or press Enter.

Select a lead from the results table.

Select either File Contact or Import Data from Interview.
Click Next.

© N o o
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9. Select the desired stored documents to move the items to the Selected
Documents table.

Loan ID:20221101000011 - Amy America

Loan

Subject Property e 3

Initial Fees Worksheet

Borrower Source Summary
Estimated Cash-to-Close
Loan Estimate
Fannie Mae Addendum Search Q
Freddie Mac Addendum
Anti-Steering STORED DOCUMENTS SELECTED DOCUMENTS
Escrow Account Document Name Stored Date Document Name Preview
Initial ARM Disclosure Drivers License 10/23/2023 [ Drivers License B m]

HOEPA Counseling List

Figure 129: Select Documents

10. Click Next.

11. Review the Summary.

Loan ID: 20221101000011 - Amy America

Loan

Subject Property o o

Initial Fees Worksheet

Borrower Source Select Documents

Estimated Cash-to-Close
Loan Estimate SELECTED SOURCE
Fannie Mae Addendum .

Tim Tester
Freddie Mac Addendum
Anti-Steering SELECTED DOCUMENTS
Escrow Account B, Drivers License

Initial ARM Disclosure

HOEPA Counseling List

Figure 130: Summary

12. Click Import.

Delete Borrower
Use the following steps to delete a borrower from the loan.

Note: The primary borrower cannot be deleted if other borrowers are not listed on the loan.
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1. Select the borrower to delete.

&+ @ -Primary

Figure 131: Delete Borrower

2. Click Delete Borrower.
3. Click Delete on the Delete Confirmation dialog.

Swap Primary Borrower

Use the following steps to swap the primary borrower and co-borrower. Information
automatically updates to match the new primary borrower when the swap is complete.

1. Click the Primary Borrower set.

o+ @ -Primary

Figure 132: Edit Borrower

2. Click the Edit Borrower icon.
3. Select the Swap radio button.

Edit Selected Borrowerset X

® Swap Amy America / Andy America
Separate Borrowers

Save & Close

Figure 133: Swap Primary Borrower

4. Click Save & Close.
5. Proceed to Borrower/Co-Borrower Information to complete the borrower details.

Separate Borrowers
Use the following steps to separate borrowers in the same borrower set. The separated
borrowers become single borrowers in the Borrower List.

Note: Separate a borrower set to enable deleting a borrower from the loan.
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1. Select the Borrower Set. (See Figure 128))
2. Click the Edit Borrower icon.

3. Select the Separate Borrower radio button.

Edit Selected Borrowerset X

Swap Amy America / Andy America
® Separate Borrowers

Save & Close

Figure 134: Separate Borrowers

4. Click Save & Close.

Merge Borrowers

Use the following steps to merge borrowers.
1. Select one of the borrowers to Merge. (See Figure 128))
2. Click Edit Borrower.
3. Select the appropriate Merge As option.

Edit Selected Borrowerset xX

ser: Amy America

Merge As Borrower v

With b

Save & Close

Figure 135: Merge Borrowers

4. Select the borrower to merge With.
5. Click Save & Close.
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Borrower/Co-Borrower Information

Complete the screen details with as much information as possible. Return to the Borrower
and Co-Borrower fields to update as additional information becomes available.

1. Select Borrower from the Application tab.

BORROWER CO-BORROWER
First | Amy First
Middle Middle
Last America Last
Suffix Suffix
Nickname Nickname
SSN/Tax ID 500-60-2222 SSN/Tax ID [
Date of Birth | 01/31/1967 E Date of Birth E
Age Age

Marital Status Married v Marital Status v
Years of Education Years of Education

Number of Dependents 0 Ages Number of Dependents Ages

Email

eDisclosure Consent

First-time Homebuyer

amy.a@fanniemae.com

Email

eDisclosure Consent

First-time Homebuyer

Figure 136: Borrower/Co-Borrower Information

Note: Select Unmarried from the Marital Status dropdown to enable the Unmarried
Addendum fields.

2. Complete the Borrower and Co-Borrower fields with available information.
Unmarried Addendum

Use the Unmarried Addendum when the borrower resides in a state that recognizes civil
unions, domestic partnerships, or registered reciprocal beneficiary relationships.

1. Select the appropriate Shared Property Rights option.

UNMARRIED ADDENDUM
Shared Property Rights v
Domestic Relationship v

Other Description

State 4

Figure 137: Unmarried Addendum

Note: Proceed to Telephone if answering No in Step 1.
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2. Select appropriate Domestic Relationship option.
3. Enter Other Description when selecting Other for Domestic Relationship.

4. Select the appropriate State.
Telephone
Contact telephone numbers are required for all borrowers.

Add Telephone
Use the following steps to complete the borrower/co-borrower Telephone fields.

1. Click the Borrower Telephone Add button.

TELEPHONE (4]
Type Number Preferred
Home (508)888-8888 ]

Figure 138: Add/Edit Telephone Number
2. Select Telephone Type.

Add Telephone X

Type v
Other Description
Number ()

Extension

Preferred Contact

Figure 139: Add Telephone Dialog

Enter the Other Description when Other is selected from the Type dropdown.
Enter the Telephone Number.

Enter an Extension when appropriate.

o o0 A~ W

Select the Preferred Contact checkbox if the entered number is the preferred
contact type.

7. Click Save & Close.
Note: Click Save & New to add another telephone number.

8. Repeat Steps 1 - 7 for the Co-Borrower.
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Edit Telephone
Use the following steps to edit a listed telephone number.
1. Click the phone Number to edit. (See Figure 134.)

2. Update the Telephone Information on the Edit Telephone dialog. (See Add
Telephone for details.)

3. Click Save & Close.

Delete Telephone
Use the following steps to delete a listed telephone number.

1. Click the Delete icon. (See Figure 134.)

Delete Confirmation X

Are you sure you wish to delete this?

Figure 140: Delete Confirmation

2. Click Delete on the Delete Confirmation dialog.
Addresses

Enter borrower/co-borrower current address information. Important selections for the Add
Address dialog entries include:

e Select Previous from the Type dropdown list and add addresses to cover the
required timeframe.

e Select Current from the Type dropdown list where the address listed is also the
mailing address.

e Enter the Postal Code to auto-populate the City and State/Providence fields.
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Add Address
Use the following steps to add borrower addresses.
1. Click the Borrower Address Add button.

TELEPHONE ! o

Type Number Preferred

Home (508)888-8888 )

Figure 141: Add/Edit Current Address
2. Select the appropriate Type from the dropdown.

Add Address X

Type 2
Occupancy M.
Monthly Rent  $

Positive Rental History

Length of Residency Years Months

Address
Unit Designator v Number

City

State/Province v
Postal Code
County

Country United States v

Country Code | 01

Figure 142: Add Address Dialog

3. Select the Occupancy from the dropdown.

Note: Monthly rent amount is added from the Monthly Housing Expenses section. If the
borrower has a Positive Rental History, select the checkbox.

4. Enter Length of Residency.
5. Enter the borrower Address Information.

Note: The Country Code auto-populates based on the Country selected.
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6. Click Save & Close.
Note: Click Save & New to add another address.

7. Repeat Steps 1 - 6 for the co-borrower when appropriate.

Edit Address
Use the following steps to edit a listed address.

1. Click the Borrower Address to edit. (See Figure 137.)

2. Update the Address Information on the Edit Address dialog. (See Add Address for
details.)

3. Click Save & Close.
Delete Address

Use the following steps to delete a listed address.

1. Click the Delete icon. (See Figure 137.)
2. Click Delete on the Delete Confirmation dialog.

Employment

A minimum of two years' employment history is required.

Add Employment
Enter employment information for the borrower/co-borrower.
1. Click the Borrower Add button.

EMPLOYMENT o
Employer Start End /
Army m

Figure 143: Add/Edit Employment History
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2.

3.

Enter Employer name.

Add Employer X

Employer Employment Status Current

Address Employment Primary
Classification
Unit Designator v Number
Position
City
Start Date
State/Province v
Length of Employment years
Postal Code
Years in Occupation years
Country United States v

Telephone Number ) =

Extension employed
¢ wnership Interes

Employed by a family Owngrship Intérest
member, property seller, re.

o

estate agent or other party to Monthly Income | #

the transaction

v

v

]
months

months

Figure 144: Add Employer Dialog
Complete the Employer Address fields.

Note: Enter the Postal Code to auto-populate the City and State fields.

18

Select the Country.

Enter employer contact Telephone Number.

Enter an Extension if appropriate.

Select the Employed by family checkbox when appropriate.
Select the appropriate Employment Status.

Select the Employment Classification.

. Enter the Employer Position.

Use the Calendar to select the Start Date.

. Complete the Length of Employment fields.

. Complete the Years in Occupation fields.

Select the Foreign Income checkbox if applicable.

Select the Seasonal Income checkbox if applicable.

. Select the Business Owner/Self-employed checkbox if appropriate.

Complete the Ownership Interest and Monthly Income fields when selecting the

checkbox.
Click Save & Close.

Note: Click Save & New to add another employer.

10.

Repeat Steps 1 - 13 for co-borrower Employment History.
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Edit Employment
Use the following steps to edit a listed employer.
1. Click the Employer name. (See Figure 139.)

2. Update the Employer Information on the Edit Employer dialog. (See Add
Employment for details.)

3. Click Save & Close.

Delete Employment
Use the following steps to delete a listed employer.
1. Click the Delete icon. (See Figure 139.)

2. Click Delete on the Delete Confirmation dialog.

Income

Individual gross income details are required for the borrower/co-borrower.

Add Income
Use the following steps to add income.

1. Click the Borrower Add button.

INCOME 0
Source Amount
Army
Base 4,000.00
Military Clothes Allowance 150.00
Military Flight Pay 175.00
Total 4,325.00

Figure 145: Gross Monthly Income

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

97


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

™

calyx Zenly User Guide

2. Select the appropriate Section.

Section hd
Source e
Other Description

Amount

Figure 146: Add Income Dialog

Select the appropriate Source.

Enter Other Description when Other is selected from the Source dropdown.
Enter the Amount.

Click Save & Close.

Note: Click Save & New to add another income source.

o o~ W

7. Repeat Steps 1 - 6 for co-borrower.

Edit Income
Use the following steps to edit a listed income.
1. Click the income to edit. (See Figure 141.)

2. Update the Income Information on the Edit Income dialog. (See Add Income for
details.)

3. Click Save & Close.

Delete Income
Use the following steps to delete a listed income.

1. Click the income to delete. (See Figure 141)

2. Click Delete on the Delete Confirmation.
Assets

Borrower/co-borrower assets are combined.
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Add Assets
Use the following steps to add assets.
1. Click the Assets Add button.

ASSETS - BANK ACCOUNTS AND OTHER ACCOUNTS o

Company Type Account Number Liquid Asset Cash/Market Value

Checking and Other Accounts
Checking Account 7,500.00

Money Market Fund

Savings Account 25,000.00

L L8 K

0]
100,00000 @
0]
0]

ABC123 Corp Stock 123457 57,000.00

Figure 147: Combined Borrower/Co-Borrower Assets

2. Enter Company Name for the asset.

Add Assets - Bank Accounts and Other Accounts )4

Name ACCOUNTS o
Address
Unit Designator ~ Number
City
State/Province ~
Postal Code

Figure 148: Add Asset Dialog
Complete the remaining Add Asset dialog fields.
Click the Add button to add a new account on the Add Account dialog.
Select the Account Type from the dropdown.

Add Account G

Type ¥ Life Insurance Face Value &
Other Description Shares
Owner ~ Vehicle Make
Account Number Vehicle Year
Cash/Market Value $ Liquid Assets

Figure 149: Add New Account Dialog
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6. Enter Other Description if applicable.

7. Select Owner from the dropdown.

8. Enter Account Number.

9. Enter Cash/Market Value.

10. Complete the remaining Add Account dialog fields as applicable.

11. Click Save & Close on the Add New Account dialog to list the account on the Add

Asset dialog.
Name Bay State Bank ACCOUNTS o
Address Assets Type Account Number Amount
Unit Designator - Number Savings Account 88223344 25,000.00 W
City
State/Province hd

Postal Code

Save & Close

Figure 150: Added Asset Account

Note: Click Save & New to add another new account.
12. Click Save & Close on the Add Asset dialog.

Note: Click Save & New to add another new account.

Edit Assets
Use the following steps to edit a listed asset.

1. Select the Asset to edit. (See Figure 143.)

2. Update the Assets Information on the Edit Assets dialog. (See Add Assets for
details.)

3. Click Save & Close.

Edit Asset Account

Use the following steps to edit a listed asset account.
1. Select the Asset with the account to edit. (See Figure 143)
2. Select the Account to edit. (See Figure 146.)

3. Update the account information. (See Figure 144.)

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

100


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

v

calyx Zenly User Guide

4. Click Save & Close on the Add New Account dialog.
5. Click Save & Close on the Add Asset dialog.

Delete Assets
Use the following steps to delete a listed asset.

1. Select the Delete icon next to the desired Asset. (See Figure 143.)

2. Click Delete on the Delete Confirmation dialog.

Delete Asset Account
Use the following steps to delete a listed asset account.
1. Select the asset with the account to delete. (See Figure 143.)
Select the account to delete. (See Figure 146.)
Click Delete on the Delete Confirmation dialog.
Click Save & Close on the Edit Asset dialog.

B~ w DN

Gifts or Grants
Enter all gifts or grants being applied to the loan.

Add Gifts or Grants
Use the following steps to complete the Gifts or Grants Received fields.

1. Click the Gifts or Grants Received Add button.

GIFTS OR GRANTS RECEIVED o

Subtotal Liquid Assets 3 0.00

Total Assets (a) £ 82,000.00

Figure 151: Gifts or Grants Received

2. Select the Type.

Type v Source of Funds v
Deposited v Other Description
Account Number v Cash/Market Value k2

Figure 152: Add Account
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3. Click Yes from the Deposited dropdown if the gift/grant is deposited.
Note: Click No if the gift/grant is not deposited.
Enter Account Number if deposited.
Select Source of Funds.
Enter Other Description when selecting Other from Source of Funds dropdown.
Enter Cash/Market Value.
Click Save & Close.

Note: Click Save & New to add another account.

© N o o

Edit Gifts or Grants
Use the following steps to edit a listed gift/grant.
1. Select the gift/grant to edit.

GIFTS OR GRANTS RECEIVED o
Type Source Account Number Deposited Cash/Market Value
Cash Gift Parent v 25,000.00 0]

Figure 153: Gifts or Grants Received

2. Update the Income Information on the Edit Account dialog. (See Add Gifts or
Grants details.)

3. Click Save & Close.

Delete Gifts or Grants
Use the following steps to delete a listed gift/grant.

1. Click the Delete icon. (See Figure 149.)
2. Click Delete on the Delete Confirmation dialog.

Liabilities

Enter the borrower/co-borrower combined liabilities. Entered mortgage liabilities populate
the Unmatched Mortgage Liabilities table.

Add Liabilities
Use the following steps to add liabilities.
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1. Click the Liabilities Add button.
LIABILITIES o
Company Liability Type Balance Payment At Closing Before Closing Resub Omit
RELENTLESS BANK Installments 1,554.00 46.22 @
ALLEN BANK CARD Revolving 4,665.00 133.00 0]
BURSTING CREDIT Revolving 1,357.00 27.00 o
CAPITAL BANK Revolving 29.00 10.00 o
PRIME VISA Revolving 450.00 40.00 w

Figure 154: Liabilities List

Note: Click an existing liability and use the Edit Liability dialog to update.

2. Enter the Company Name and the company’s Address information for the liability.

Add Liability %

Company Name
Address

Unit Designator
City

State/Province
Postal Code

Credit Account Type
Liability Type

Other Description

Account Number

Amount

(FHA) Automobile

(FHA) Original Debt $

v

Number

Make

Balance

Monthly Payment

Payments
Remaining
¥ Paid Off
v
N
Mortgage Type
Credit Limit
Year

Current Remaining

Paid off at closing
Paid off before closing
Resubordinated
Omitted

Mortgage Loans

Payment Includes Ins/Tax

Property Assessed Clean Energy

© ©® N OO N~ W

Figure 155: Add Liability Dialog

Select the Liability Type from the dropdown.

Enter the liability Account Number.
Enter (FHA) Original Debt Amount if appropriate.
Enter (FHA) Automobile information if appropriate.

Enter Current Balance and Payment details.

10. Enter Remaining amount if applicable.

Select the Credit Account Type from the dropdown menu.

Enter Other Description when selecting Other from the Liability Type dropdown.
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11. Complete the Paid Off amount if applicable.
12. Check the appropriate checkbox.
13. Enter the Mortgage Type from the dropdown if applicable.
14. Enter the Credit Limit amount if applicable.
15. Check the appropriate checkbox if applicable.
16. Click Save & Close.
Note: Click Save & New to add another liability.
Edit Liabilities
Use the following steps to edit liabilities in one of the liability tables.
1. Click the liability to edit. (See Figure 150.)

2. Update the information for the liability as applicable. (See Add Liabilities for details.)
3. Click Save & Close.

Note: The Real Estate table updates automatically when changes are made to a real estate
owned liability.

Delete Liabilities
Use the following steps to delete liabilities in one of the liability tables.

1. Click on the Delete icon to remove the liability. (See Figure 150.)

2. Click Delete on the Delete Confirmation dialog.
Alimony, Child Support, Other Expenses

Enter alimony, child support, and other expenses for borrower/co-borrower.

Add Expenses
Use the following steps to Add Alimony, Child Support, and Other Expenses.
1. Click the Add button.

ALIMONY, CHILD SUPPORT, AND OTHER EXPENSES ﬁ o

Figure 156: Alimony, Child Support, Other Expenses
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2. Select the expense Type.

Add Expense X

Borrower Andy America A

Type ~
Other Description
Owed To
Description
Payments Remaining

Monthly Payment

Omit

Figure 157: Add Expense Type

Enter Other Description when Other is selected from the Type dropdown.
Enter number of Payments Remaining.

Enter Monthly Payment amount.

Select the Omit checkbox if applicable.

Click Save & Close.

Note: Click Save & New to add another expense.

N O o~ W

Edit Alimony, Child Support, and Other Expenses

Use the following steps to Edit Alimony, Child Support, and Other Expenses.
1. Select the desired expense to Edit. (See Figure 152)
2. Inthe Edit Expense dialog, update the desired information.
3. Click Save & Close.

Delete Alimony, Child Support, and Other Expenses

Use the following steps to delete a listed expense.

1. Click the Delete icon on the desired expense. (See Figure 152.)

2. Click Delete on the Delete Confirmation dialog.
Real Estate

Use the following sections to complete the Real Estate section.
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Add Real Estate
Use the following steps to add real estate.
1. Click the Real Estate Add button.

REAL ESTATE o
Address Qccupancy Status Market Value Payment Ins/Tax/Misc Gross Rent Net Rent

» 4321 Cul de Sac Str... Pending Sale 600,000.00 3,362.00 700.00 w
Total 600,000.00 3,362.00 700.00 0.00 0.00

Figure 158: Existing Real Estate
2. Select the Subject Property checkbox if applicable.

Add Real Estate X

[] Subject Property Shatus < ‘
Address
Intended Occupancy M
Unit Designator i Number
Current Occupancy g
City
Market Value $
State/Province 24
Mortgage Balance %
Postal Code R
GrossRent | $
Country United States v

Monthly Payment | &

Number of Units
Ins/Tax/Misc k2

Acc. Dwelling Units [] omitted Ins/Tax/Misc

Property Type b4 Occupancy Rate 75.000
Net Rent $ a
Acc. Dwelling Net Rent |
MATCHED MORTGAGES

Figure 159: Add Real Estate Dialog
Complete the Address fields.
Enter the Number of Units.

Enter the Acc. (Accessory) Dwelling Units if applicable.

3

4

5

6. Select the Property Type.

7. Select the appropriate Status from the dropdown.
8. Select Intended Occupancy from the dropdown.

9. Select the Current Occupancy from the dropdown.
10. Enter the Market Value.

11. Enter the Mortgage Balance if applicable.

12. Enter the Gross Rent.

13. Enter Monthly Payment if applicable.
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14. Enter Insurance/Tax/Miscellaneous expenses.
15. Select the Omitted Ins/Tax/Misc to omit the expense from the loan application.
16. Enter the Occupancy Rate percentage.
17. Click Calculate icon to calculate the Net Rent.
18. If needed, enter the Acc. (Accessory) Dwelling Net Rent.
19. Click Save & Close.
Note: Click Save & New to add another real estate property.

Edit Real Estate
Use the following steps to edit Real Estate section.

1. Click the Real Estate to edit. (See Figure 154.)

2. Update the desired information on the Edit Real Estate dialog. (See Add Real Estate
for details.)

3. Click Save & Close.

Delete Real Estate
Use the following steps to delete a listed real estate item.
1. Click the Delete icon. (See Figure 154.)

2. Click Delete on the Delete Confirmation dialog.
Unmatched Mortgage Liabilities

Use the following steps to match the table items to the Real Estate table items. This table
populates when a Liability is an unmatched mortgage. See Liabilities.

1. Select the Unmatched Mortgage Liability.

REAL ESTATE O

Address Occupancy Status Market Value Payment Ins/Tax/Misc Gross Rent Net Rent

» 4321 Culde Sac Str... Pending Sale 600,000.00 3,362.00 700.00 o)

Total 600,000.00 3,362.00 700.00 0.00 0.00

UNMATCHED MORTGAGE LIABILITIES

Company Liability Type Account Number Balance Payment At Closing Before Closing  Ins/Tax Omit

AAA Mortgage Loan 500,000.00 3,250.00 o

Figure 160: Unmatched Mortgage Liabilities
2. Drag and drop the liability to the matching item on the Real Estate table item.

Note: The selected item is removed from the Unmatched Mortgage Liabilities table.
Matched liabilities can be updated on either the Real Estate table or the Liabilities table.
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Primary Housing
Complete the Primary Housing section with current housing expenses.

Add Primary Housing
Use the following steps to add primary housing expenses.

1. Click the Primary Housing Add button.

PRIMARY HOUSING

Type A

First Mortgage 3,362.00

Hazard Insurance 125.00

Mortgage Insurance 75.00

a}

@

County Property Tax 338.00 o]
@

Homeowners' Assoc. Dues 300.00 @
@

23.00

Total 4,223.00

Figure 161: Primary Housing

Note: Click an existing expense and use the Edit Primary Housing dialog to update.

2. Select the expense Type.

Add Primary Housing X

Type v
Other Description

Amount %

Figure 162: Add Primary Housing Dialog

3. Enter Other Description when Other is selected from the Type dropdown.
4. Enter expense Amount.
5. Click Save & Close.

Note: Click Save & New to add another expense.

6. Repeat Steps 8 - 12 for co-borrower.

Edit Primary Housing Expenses
Use the following steps to edit a listed primary housing expense.
1. Click the Expense to edit. (See Figure 157.)

2. Update the Address Information on the Edit Address dialog. (See Add Primary
Housing for details.)
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3. Click Save & Close.

Delete Primary Housing Expenses
1. Click the Delete icon. (See Figure 157.)

2. Click Delete on the Delete Confirmation dialog.
Declarations

Complete the Declarations for the borrower/co-borrower as appropriate.

1. Select Yes or No appropriately for each borrower question.

DECLARATIONS

Borrower Co-borrower
What is your citizenship/residency status?
Us Citizen v Us Citizen v

Do you live in a community property state?

v v

Do you intend to occupy the property as your primary residence?

No v No v

Have you had an ownership interest in a property in the last three years?
Yes Vv Yes v
What type of property did you own (PR/SR/SH/IP)?
Primary Residence v Primary Residence v

How did you hold title to home (S/SP/0)?

Joint with Spouse ~ Joint with Spouse ~

Purchase Transaction: Do you have a family relationship or business affiliation with the seller of the property?

v v

Figure 163: Borrower/Co-Borrower Declarations
2. Enter a Description when selecting Yes.

3. Click the Bankruptcy Select button when Yes is selected for the Bankruptcy
question.

Have you declared bankruptcy within the last seven years?

No v No v

BANKRUPTCY m BANKRUPTCY m

Figure 164: Bankruptcy Details
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4. Select the appropriate Bankruptcy type.

Bankruptcy X

Chapter 7
Chapter 11
Chapter 12

Chapter 13

Save & Close

Figure 165: Bankruptcy Dialog

5. Click Save & Close.
6. Select Yes or No appropriately for Military Service.

Have you served, or are you the surviving spouse of someone who served, in the United States Armed Forces?

v v

MILITARY SERVICE STATUS m MILITARY SERVICE STATUS @

Figure 166: Military Service
7. Click Select when Yes is selected.
8. Select the appropriate Military Service checkbox.

Military Service X

Currently serving on active duty [E]
with service end date

Currently retired, discharged, or separated from service

Only period of service was as a non-activated member of the
Reserve or National Guard

Surviving spouse

Save & Close

Figure 167: Military Service Dialog

9. Use the Calendar to select the Active Duty Service End Date when the checkbox
is selected.

10. Repeat Steps 1 - 9 for the co-borrower.

Ethnicity and Gender

Ethnicity and gender information is optional. Use the checkboxes when borrower/co-
borrower decline to provide the information.
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1. Select the Ethnicity Borrower does not wish to furnish this information checkbox
when the borrower declines to provide information.

2. Select the Borrower Ethnicity Add button.

ETHNICITY o ETHNICITY 0
Ethnicity Designation Ethnicity Designation
Not Hispanic or Latino | 0] Not Hispanic or Latino o
Borrower does not wish to furnish this information Co-borrower does not wish to furnish this information
Visual Observation v Visual Observation e
GENDER GENDER
Borrower does not wish to furnish this information Co-Borrower does not wish to furnish this information
Sex Male v Sex Female e
Visual Observation ~ Visual Observation v

Figure 168: Add/Edit Ethnicity
Note: Click the displayed ethnicity and use the Edit Ethnicity dialog to update.

3. Select the borrower's Ethnicity from the dropdown.

Add Ethnicity X

Ethnicity v
Designation v

Other Description

Figure 169: Add Ethnicity Dialog

4. Select the Designation when appropriate.
5. Enter Other Description when Other is selected from the Designation dropdown.
6. Click Save & Close.
Note: Click Save & New to add another ethnicity.
7. Select the appropriate Gender Visual Observation option.

8. Select the Gender Borrower does not wish to furnish this information checkbox
when the borrower declines to provide information.

9. Select the appropriate Sex option.
10. Select the appropriate Visual Observation option.
11. Select the appropriate Race Visual Observation option.

12. Repeat Steps 1 - 11 for the co-borrower.
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Identifying Documentation

Enter details for identifying documentation provided by the borrower/co-borrower.
1. Click the Borrower Identifying Documentation Add button.

2. Select the documentation Type from the dropdown.

Add Identifying Documentation

Type ~ Governing Entity v
Other Description Other Description
Agency State/Province h
Document Number Country United States v
Issued 3| By
Expires |

Discrepancy and Resolution

Figure 170: Add Identifying Documentation Dialog

Enter Other Description when Other is selected from the Type dropdown.
Select the Governing Entity for the documentation from the dropdown.

Enter Other Description when Other is selected from the Governing Entity
dropdown.

6. Enter the identification issuing Agency.

7. Select the State/Province.

8. Enter the identifying Document Number.

9. Select the Country from which the document originated.
10. Use the Calendar to select the Issued date.

11. Enter the verifying party name in the By field.

12. Use the Calendar to select the Expires date.

13. Enter Discrepancy and Resolution details when the identification documentation
contains discrepancies.

14. Click Save & Close.
Note: Click Save & New to add another identifying document.

15. Repeat Steps 1 - 14 for the co-borrower.
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Nearest Relative
Nearest relative details are required for Federal Housing Administration (FHA) or Veteran
Affairs (VA) loans.
Note: (FHA/VA) Nearest Relative fields are required when FHA or VA is selected for Loan
Type on the Loan screen.
Add Nearest Relative

1. Click the Add button.

(FHA/VA) NEAREST RELATIVE o (FHA/VA) NEAREST RELATIVE o

(FHA) | certify that | was a resident of the following states in the past 10 years.

STATES o STATES o

Figure 171: FHA/VA Nearest Relative
2. Enter the Relationship status.

Add (FHA) Nearest Relative X

Relationship

First

Middle

Last

Suffix

Address

Unit Designator G Number
City

State/Province &
Postal Code

Phone Number C0 oo

Figure 172: Add (FHA) Nearest Relative
3. Complete the Name and Address fields.
Note: Enter the Postal Code to auto-populate the City and State fields.
4. Enter the contact Phone Number.
5. Click Save & Close.
Note: Click Save & New to add another relative.
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6. Click the States Add button.
7. Select the appropriate State.
8. Click Save & Close.
Note: Click Save & New to add another state.

9. Repeat Steps 1 - 8 for co-borrower.

Edit Nearest Relative
Use the following steps to edit a listed nearest relative.

1. Click the Expense to edit. (See Figure 167.)

2. Update the Address Information on the Edit Address dialog. (See Add Nearest
Relative for details.)

3. Click Save & Close.

Delete Nearest Relative

1. Click the Delete icon. (See Figure 167.)

2. Click Delete on the Delete Confirmation dialog.
Additional Information

Complete the remaining information fields if applicable.
1. Enter additional relevant Borrower Information.

2. Enter additional relevant Co-Borrower Information.

Application Loan

The Application Loan screen contains options for capturing the loan details.
Loan Overview

Enter initial loan details or use Select to import a pre-defined template.

Note: Use Loan Program in the Templates tab to create loan templates. See Loan Program
for details.

Options on the Application Loan screen vary depending on the initial loan details selected.
1. Select Application tab.

2. Select Loan.
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3. Use the Calendar to select Application Date.

Status  Application ~ Processing  Underwriting  Reporting Documents  Services  Settings

Loan ID : 20221101000011 - Amy America ‘ oot ‘ e
Borrowe: 7 o b e
- Total Borrowers 2
Subject Property Legal Entity ID v
Initial Fees Worksheet Lender Case Number  DI-C03_v3.4 Agency Case Number
Estimated Cash-to-Close
[meted tesotlose Check Number | 00

Loan Estimate
Universal Loan ID
Fannie Mae Addendum

Figure 173: Loan Overview
Enter the Legal Entity ID.
Click the Loan Program Scenario Select button.

Enter the number of Total Borrowers.

N o o s

Enter Agency Case Number.

Note: The Universal Loan Information field is ungrayed for users that are operating as a
Broker. This field functions the same for HMDA reporting.

Loan Information

Complete the Loan Information options as they pertain to the loan.

1. Select the Loan Type.

LOAN INFORMATION

Loan Type FHA v Lien Position First v

Other Description Simultaneous Financing

Loan Purpose Refinance ~ Amortization Type Fixed v

Other Description
Other Description P
Conversion of Contract for Deed or
Construction Type v Land
Cash-Out Type Cash-Out v Renovation
Prepayment Penalty

Occupancy Second Home v HeLoc

FHA Secondary Residence

Figure 174: Loan Information
Enter Other Description when selecting Other Loan Type.
Select the Loan Purpose.
Enter Other Description when selecting Other Loan Purpose.
Select the Construction Type option if applicable.

Select the Cash-Out Type when Refinance is selected for Loan Purpose.

N o ok~ w DN

Select the Occupancy.
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8. Select the FHA Secondary Residents checkbox if applicable.
9. Select the Lien Position.
10. Select the Simultaneous Financing checkbox if applicable.
Note: Checkbox is not available for First Lien Position.
11. Select the Amortization Type.
Note: Enter the Other Amortization Description if applicable.

12. Select the appropriate Loan Information checkboxes.
Note Details

Use the following steps to complete the Note Details section.

1. Enter Estimated Appraised Value amount.

NOTE DETAILS
A i \,
Estimated Appraised Value | & 420,000.00 Appraised Value
Initial Requested Loan Amount Sales Price $ 0.00
Note Rate 5.250 % Base Loan Amount & g
Qual Rate Down Payment Amount
Amortization Term 360 Months Total Loan Amount w/MIP.FF
Loan Term Months Monthly Payment

Figure 175: Note Details
Enter Initial Requested Loan amount.
Enter the Note Rate percentage.
Enter the Qual Rate percentage if different than Note Rate.
Enter the Amortization Term.
Enter Loan Term if different than Amortization Term.
Enter Appraised Value amount.

Enter Sales Price amount.

© ® N O 0 A W N

Enter Base Loan Amount.
10. Enter Down Payment Amount.

Note: Click %Cal to calculate a percentage down payment.

Rental Income on Subject Property

Complete the Rental Income on Subject Property if the property is a rental.
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1. Enter Gross Rent amount.

RENTAL INCOME ON SUBJECT PROPERTY

GrossRent & NetRent % @

Occupancy Rate Acc. Dwelling Net Rent %

Figure 176: Rental Income
2. Enter Occupancy Rate percentage.
3. Click Calculate to calculate Net Rent amount.
Note: The Ratios fields auto populate.
4. If needed, enter the Acc. (Accessory) Dwelling Net Rent.

5. Click on the Save button at the top of the screen.
If Construction Loan

The If Construction Loan fields are required if a Construction option is selected from the
Construction Type dropdown.

1. Enter the property Original Cost.

IF CONSTRUCTION LOAN

bl
Original Cost Period: Months OR Days =

Interest Rate
Lot Value (a)

Improvements (b) Required Reserve

Total (a + b) Closing Type b

Include MI During Construction Period

Include Escrow During Construction
Period

Figure 177: If Construction Loan

2. Enter the Lot Value.

3. Enter the Improvements estimate.
Note: Lot Value + Improvements = Total.
Select the Include MI During Construction Period checkbox if applicable.
Select the Include Escrow During Construction Period checkbox if applicable.
Enter the construction loan Period.
Enter the loan Interest Rate percentage.

Enter Required Reserve if applicable.

© ®© N o o A

Select the Closing Type from the dropdown.
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PMI/MIP/VA/USDA

Complete the PMI/MIP/VA/USDA details for the loan when the following details are
required:

e Private Mortgage Insurance (PMI)

e Mortgage Insurance Premium (MIP)

e Veterans Affairs (VA)

e United States Department of Agriculture (USDA)

1. Enter the PMI/MIP/VA/USDA Up-Front percentage requirements.

PMI/MIP/VA/USDA

Up-Front Monthly
PMI/MIP/VA/USDA  PMI Renewal 1 PMI Renewal 2
PMI/MIP/VA/USDA o Rate Percentage o %
PMI/MIP/VA/USDA Amount Monthly Dollar Amount
Additional Amount Paid in Cash 0.00 Monthly Amount
Up-Front MIP/PMI/VA Funding Months

Fee Financed

Calculation Based on v

Cancel at

Calculate based on remaining balance

Midpoint Payment cancellation

Figure 178: PMI/MIP/VA/USDA Section
Enter Additional Amount Paid in Cash.
Enter the Monthly Percentage rates.
Enter the Monthly Dollar Amount.
Enter the Months for the loan term.
Select the appropriate Calculation Based on option.
Enter the Cancel at percentage.

Select the Calculate based on remaining balance checkbox if applicable.

© ® N O U AW N

Select the Midpoint Payment cancellation checkbox if applicable.
Rate Adjustment

Complete the Rate Adjustment fields when the Amortization Type is ARM.
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1. Enter the 15t Change Adjustable Cap percentage.
RATE ADJUSTMENT
Adj Cap Months
1st Change %o Index Type v
Adj Period %o Other
Description
Life Cap o
Rate Rounding Options
Margin o
Rate
Index %o
Rate Round To v
Alt. Index o
Floor %

© ® N OO A WD

Figure 179: Rate Adjustment

Enter the Adjustment Period months.

Complete the remaining percentages.

Payment Adjustment

Enter payment adjustment information for loans.

1

Enter Interest-Only Months.

Enter the Adjustment Period percentage.

Enter the 15t Change Months at which the percentage changes.

Select the appropriate Index Type from the dropdown.

Complete the Other Description when selecting Other for the Index Type.
Enter the Rate Percentage Rounding Options if appropriate.

Select the appropriate Rate Round To option.

PAYMENT ADJUSTMENT

Interest-Only

months Extra payment of

iJ Calculate Qual Ratios at the Interest-Only Payment

Initial Payment Rate

~ % months
Adj Cap Adj Period
of months
Recast Pd/Stop

/ months Years

Max Balance

% Payment

iJ Calculate Qual Ratios at the Max Adjusted Loan Balance

every payment
:I Bi-Weekly Payment Schedule
:I Simple Interest
i] Down Payment Assistance Program
Principal Forgiven
% every months

Graduated Payment Mortgage

at Rate Yo

Payment Rounding Options Payment Rounding

%Yo v

Figure 180: Payment Adjustments
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10.

11

12.
13.
14.
15.
16.
17.
18.

Select the Calculate Qual Ratios at the Interest-Only Payment checkbox if
applicable.

Select the appropriate Initial Payment Rate option.
Enter the Initial Payment Rate percentage.

Enter the Adj Cap percentage.

Enter the Adj Period months.

Enter the Recast Pd/Stop values.

Enter the Max Balance percentage.

Select the Calculate Qual Ratios at the Max Adjustment Loan Balance checkbox
if applicable.

Enter extra payment amount.

Enter payment frequency.

Select the Bi-Weekly Payment Schedule checkbox if applicable.
Select the Simple Interest checkbox if applicable.

Select the Down Payment Assistance Program checkbox if applicable.
Enter the Principal Forgive amount and complete the months field.
Enter the Graduated Payment Mortgage details.

Enter the appropriate Payment Rounding %.

Select the appropriate Payment Rounding option.

Buydown Mortgage

Complete the Buydown Mortgage dialog when the buydown mortgage option is available.

1

Use the Paid By dropdown menu to select the responsible party for the Buydown.

2. Select the desired option from the Disclose LE/CD Product.

3. Click on the Type dropdown menu and select the desired option.

4. If needed, select the Temporary Subsidy checkbox.

5. Click Add.

BUYDOWN MORTGAGE o

Disclose LE/CD Product Step Rate ~ Type o

Paid By Borrower M Temporary Buydown Fee %

[_] Temporary Subsidy

Figure 181: Buydown Mortgage
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6. Enter the buydown mortgage Rate percentage.

Add Buydown Mortgage X

Rate %o Term (months)

Figure 182: Add Buydown Mortgage Dialog

7. Enter the Term in months.
8. Click Save & Close.
Note: Click Save & New to add another buydown mortgage option.

Loan Features

A balloon payment is required when the Loan Term is lower than Amortization Term.
1. Click Add.

LOAN FEATURES . o

Figure 183: Loan Features
2. Select the appropriate Loan Feature.

3. Complete Other Description field when selecting Other from the Loan Feature
dropdown.

Add Loan Features X

Loan Features Other v

Other Description

Figure 184: Add Loan Features Dialog

4. Click Save & Close.
Note: Click Save & New to add another loan feature.

Payment Schedule

The Payment Schedule is automatically calculated.
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1. Click Payment Schedule.

PAYMENT SCHEDULE Payment Schedule

Prepaid Finance & Amount Financed & 250,400.00 Finance Charge | & 247,377.39
Charge

Total Payments B 497,777.39 APR 5.250 % TIP 98.793 %

#

Pmt Pmt Date Int Rate Mth Pmt Balance

359 5250 1,382.72 1,374.89

1 5250 1,380.91 0.00

Figure 185: View Payment Schedule

2. Review Payment Schedule.

Payment Schedule X

Pmt # Pmt Date Int Rate Payment Principal Interest MI Balance

1 5.250 1,382.72 287.22 1,095.50 0.00 250,112.78
2 5.250 1,382.72 288.48 1,094.24 0.00 249,824.30
3 5.250 1,382.72 289.74 1,092.98 0.00 249,534.56
4 5.250 1,382.72 291.01 1,091.71 0.00 249,243.55
5 5.250 1,382.72 292.28 1,090.44 0.00 248,951.27
6 5.250 1,382.72 293.56 1,089.16 0.00 248,657.71
7 5.250 1,382.72 294.84 1,087.88 0.00 248,362.87
8 5.250 1,382.72 296.13 1,086.59 0.00 248,066.74
9 5.250 1,382.72 297.43 1,085.29 0.00 247,769.31

Figure 186: Payment Schedule

Subject Property
Use the following sections to complete subject property details. Complete the Subject
Property screen fields not auto populated from previous screens.

1. Select Application tab.
2. Select Subject Property.
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Subject Property Address

1. Verify the auto populated fields.

Status  Application = Processing  Underwriting Reporting Documents Services  Settings

Loan ID :20221101000011 - Amy America

Escrow Account
Legal Description

Initial ARM Disclosure

HOEPA Counseling List

Borrower SUBJECT PROPERTY ADDRESS
Loan
Address 1234 Ocean Pines State Code

Subject Property
Initial Fees Worksheet Unit Designator v Number 823 County Code
Estimated Cash-to-Close City Rehobeth MSA/MD Code
Loan Estimate

State/Province MD v Census Tract
Fannie Mae Addendum

21857 - United Stat; v

Freddie Mac Addendum Postal Code Country nited States
Anti-Steering County

Figure 187: Subject Property Details
2. Enter the County if applicable.
3. If needed, enter a Legal Description.
4. Enter the following codes:

e State Code
e County Code
e MSA/MD Code

5. If applicable, enter the Census Tact.
Property Information

1. Enter the Number of Units and the Year Built.

PROPERTY INFORMATION
Number of Units 1 Year Built 1972 Attachment Type Attached
Acc. Dwelling Units Year Acquired Structure Type Condominium

Lot Acquired Date 8 Construction Method Site Built
Mixed-Use Property No v Other Description
Property in Project Yes v Manufactured Home Width
Community Property State v Design Type
D Planned Unit Development (PUD) Other Description

Figure 188: Property Information

2. If needed, enter the Acc. (Accessory) Dwelling Units.
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3. Enter Year Acquired if refinancing.
4. Enter Lot Acquired Date if applicable.
5. Click on the Mixed-Use Property dropdown and select the appropriate option.
6. Click on the Property in Project dropdown and select the appropriate option.
7. Click on the Community Property State dropdown and select the appropriate

®

10.

11.
12.

13.

14.
15.

option.

Select the Planned Unit Development checkbox if needed.
Select the Attachment Type from the dropdown.

Select Structure Type from the dropdown menu.

Select Construction Method if applicable.

Complete Other Description field when selecting Other from Construction
Method option.

Select the Manufactured Home Width option.
Select Design Type option.

Complete Other Description field when selecting Other from the Design Type
option.

Proposed Housing Expenses

Enter the borrower/co-borrower disclosed housing expenses.

1. Click Add in Proposed Housing Expenses section.
PROPOSED HOUSING EXPENSES . o
Expense Type Amount
First Mortgage 1,763.42
Hazard Insurance 65.00
County Property Tax 205.00
Homeowners' Assoc. Dues 400.00 oW
Total 2,433.42

Figure 189:Proposed Housing Expenses
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2. Select Housing Expense Type option.

Add Proposed Housing Expenses X

Housing Expense Type ™
Other Description

Based On Total Loan Amount v

Fee Percentage

©®

Monthly Dollar Amount

Monthly Amount %

Figure 190: Add Proposed Housing Expenses Dialog

Note: Enter Other Description when selecting Other for Housing Expense Type.
Select appropriate Based On option.

Enter Fee Percentage.

Enter Monthly Dollar Amount.

Enter Monthly Amount if applicable.

Click Save & Close.

Note: Click Save & New to add other expenses.

N O o~ W

Subordinate Financing

Enter subordinate financing when the borrower/co-borrower is receiving subordinate
financing.

1. Click Subordinate Financing Add button.

SUBORDINATE FINANCING — O

Figure 191: Subordinate Financing
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2. Enter the desired information in the Add Subordinate Financing dialog.

Add Subordinate Financing x

Loan Position
Creditor Name
Source/EIN

Source Type

QOther Description
First Loan Mortgagee

Qriginal Loan Amount

v Loan Amount
Note Rate

Qual Rate

v Amortization Term
Loan Term

™~ Interest Only

Monthly Payment

Affordable Loan Credit Limit

Deferred First 5
Years

%
Months
Months

Months

Qualify Ratios
at the Interest
Only Payment

Figure 192: Add Subordinate Financing

Title

Enter the information to include in the new title.

1. Select the appropriate Title will be held as option.

TITLE

Title will be held as
Other Description
Estate will be held in Fee Simple

Exp. Date

v Trust Information

Indian Country Land

=

Tenure

N oo A WD

Figure 193: Property Title Details
Select the Other Description if applicable.

Select the appropriate Trust Information option.

Select the appropriate Estate will be held in option.

Use the Calendar to select the title Expiration Date.

Select the appropriate Indian Country Land Tenure option.

Select the appropriate (VA) Type of Ownership option.
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If Refinancing Loan

Select the appropriate option if the loan is being refinanced. Some fields may auto populate.

IF REFINANCE LOAN

Refinance Program h Describe Improvements

Other Description Made/To Be Made
Cash-Out Type Cash-Out v Improvement Cost %
Refinance Purpose Type Debt Consolidation v Lot Original Cost | %

Other Description

Figure 194: If Refinancing Loan

Names on Title
Use the following sections to add the names on the title.

Copy Borrower
Use the following to add borrower name to the title.
Note: Copy borrower overwrites existing names.

1. Click Copy Borrower.

©

NAMES ON TITLE .

Name

Figure 195: Names on Title

2. Click Delete on the Delete Confirmation dialog.

Add Name
1. Click the Add button. (See Figure 191)

Add Names on Title X

First
Middle
Last

Suffix

Figure 196: Add Names on Title Dialog
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2. Complete the Add Names on Title dialog.
3. Click Save & Close.

Note: Click Save & New to add another name to the title.

Edit Name
Use the following steps to edit a name.
1. Click the name to edit. (See Figure 191)

2. Update the Edit Names on Title dialog as applicable. (See Add Name for details.)
3. Click Save & Close.

Delete Name
Use the following steps to delete a name.

1. Click the name to Delete icon. (See Figure 191.)

2. Click Delete on the Delete Confirmation dialog.
Energy Improvements

Select the appropriate energy improvements.
1. Click Select.

ENERGY IMPROVEMENTS

Figure 197: Energy Improvements

2. Select the appropriate checkbox.

Energy Improvements

Mortgage Loan will finance energy- 3
related improvements

Property is currently subject to a lien that could take priority
over the first mortgage lien

Save & Close

Figure 198: Energy Improvements Dialog
3. Click Save & Close.

Note: Checking Mortgage Loan will finance energy-related improvements requires an
amount.
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4. Select the Loan Position option.

Add Subordinate Financing X

5. Enter Creditor Name.

6.

Loan Position
Creditor Name
Source/EIN

Source Type

Other Description
First Loan Mortgagee

Original Loan Amount

. Loan Amount
Note Rate

Qual Rate

v Amortization Term
Loan Term

= Interest Only

Monthly Payment

Affordable Loan Credit Limit

Deferred First 5
Years

Maonths
Months

Months

Qualify Ratios
at the Interest
Only Payment

Figure 199: Add Subordinate Financing Dialog

Enter Source/EIN.

7. Select Source Type option.

Note: Enter Other Description when selecting Other for Source Type.

8.
0.

10.

11.

12.
13.
14.
15.
16.
17.

Enter Loan Amount.

Enter Note Rate percentage.

Enter Qual Rate percentage.

Enter Amortization Term Months.

Enter Loan Term Months.

Enter Interest Only Months.

Enter Monthly Payment.

Enter Credit Limit.

Select the Quality Ratios checkbox if appropriate.

Click Save & Close.

Note: Use Save & New to add other subordinate financing.
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Initial Fees Worksheet

Complete the Initial Fees Worksheet fields not auto populated from previous screens.
1. Select Application tab.
2. Select Initial Fees Worksheet.
3. Use the Calendar to select the Estimated Close Date.

4. Use the Calendar to select the First Payment Date.

Status  Application = Processing  Underwriting  Reporting  Documents  Services  Settings

Loan ID : 20221101000011 - Amy America
Borrower Estimated Close Date = Fees Template

Loan
First Payment Date =
Subject Property

el e kaheen Prepaid Finance Charge | % 0.00 TIP 98.793 %

Estimated Cash-to-Close Finance Charge % 247,377.39 APR 5.250 %
Loan Estimate
Amount Financed 3 250,400.00

Fannie Mae Addendum
Freddie Mac Addendum PFC = Prepaid Finance Change (APR Items) FHA = FHA Allowable POC = Paid Outside of Closing FIN = FIN - QM
Anti-Steering A. ORIGINATION CHARGES o
Escrow Account ; .

Fee Pay To Borrower-Paid Seller-Paid Other Paid

Initial ARM Disclosure
Company Name At Closing Before Closing At Closing Before Closing

HOEPA Counseling List
Loan Amount (Points)

Figure 200: Initial Fees Worksheet
Fees Template

. Use the Fees Template to populate the Initial Fees Worksheet screen or enter the values
when not provided on the Fees Template. To import a Fees Template:

1. Click the Select button near the Fees Template field to browse templates.

Select Template X

|Sear’ch ‘ Q

Template Name

non spec

Standard Fee

E Cancel

Figure 201: Select Template Dialog
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2. Select the Template Name.
Note: Use Search to browse stored templates.

3. Click OK to import the Template Fees.
Origination Charges

Use the fees template created on the TEMPLATE tab to populate the Fee fields in the
worksheet when a template was created.
Add Origination Charges

Use the following steps to add additional Origination Charges to the imported template or
to manually build fees.

Note: See Dropdown Lists to build the Fees Template.
1. Click Origination Charges Add button.

A. ORIGINATION CHARGES ﬁ o

Fee Pay To Borrower-Paid Seller-Paid Other Paid

Company Name At Closing Before Closing At Closing Before Closing

Loan Amount (Points)

Subtotal

Figure 202: Origination Charges

2. Select the Fee Name to add a new fee type option.

Add Origination Charges X

Fee Name v Company Name
Other Description Responsible Party Borrower o
- e
Based On Total Loan Amount N
Paid By: Fee Percentage Fee Dollar Amount Total Fee Amount Paid Before Closing PFC FHA FIN
Borrower % $ $ %
Seller o $ & &
Lender o & & $
Broker %o $ $
Third Party % $ &
Correspondent % $ $
Total Amount | &

Figure 203: Edit Origination Charges Dialog
3. Enter Other Description if selecting Other Fee Name.
4. Select the Paid To option.
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5. Select the Based On option.
6. Enter Company Name.
7. Select Responsible Party option.
Note: Select Blank and enter the fee distribution on the Fees Distribution table.
8. Select the Qualified Mortgage checkbox if applicable.
9. Select the Exclude from Tolerance checkbox if applicable.

10. Complete the Fees Distribution table to distribute fees as applicable if Blank is
selected for Responsible Party.

11. Click Save & Close.

Note: Use Save & New to add other origination fees.

12. Select the Print additional fees on addendum checkbox if applicable.

Edit Origination Charges
Use the following steps to complete the Edit Origination charges.
1. Select the charge to edit. (See Figure 198))

2. Update the Address Information on the Edit Address dialog. (See Add Origination
Charges for details.)

3. Click Save & Close.
Delete Origination Charges
Use the following steps to delete a listed real estate item.

1. Click the Delete icon. (See Figure 198.)

2. Click Delete on the Delete Confirmation dialog.
Services Borrower Can't Shop For

The Origination Charges Services Borrower Can't Shop For list contains the loan
origination agents and services that are pre-selected and cannot be changed.

Add Services
Use the following steps to create the list.

1. Click the Service Providers Borrower Can’t Shop for Add button.

B. SERVICES BORROWER CAN'T SHOP FOR ' o

Figure 204: Non Shopped Services

2. Complete the Add Services Borrower Can't Shop for dialog fields. (See Add
Origination Charges for details.)
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3. Click Save & Close.
Note: Use Save & New to add other origination fees.

4. Select the Print additional fees on addendum checkbox if applicable.
See Edit Origination Charges for editing services.

See Delete Origination Charges for deleting services.

Services Borrower Can Shop For

The Origination Charges Services Borrower Can Shop For list contains the loan origination
services that have multiple providers from which the borrower can select. Use the following
steps to create the list.

1. Use the steps in Services Borrower Can't Shop For to build the Services Borrower
Can Shop For list.

2. Select the Print Confirm Receipt checkbox to request a Confirmation Receipt
when the Borrower receives the list.

See Edit Origination Charges for editing services.

See Delete Origination Charges for deleting services.

Total Loan Costs

Total Loan Costs fields populate from:

e Origination Charges
e Services Borrower Can't Shop For
e Services Borrower Can Shop For

Additional Fee Tables

Use the steps provided in Add Origination Charges for assistance with completing
appropriate the sections under Total Loan Costs. Sections include:

e Taxes and Other Government Fees

e Prepaids
¢ Initial Escrow payment at Closing
e Other

Total Other Costs

Total Other Costs fields populate from the Additional Fee Tables.
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Total Closing Costs

The Total Closing Costs table populates based upon the Fees selected while completing the

above Fees tables. Use the following steps to add Lender Credits.
1. Click Lender Credit.

J. TOTAL CLOSING COSTS(D +1)

Fee Borrower-Paid Seller-Paid

Other Paid

At Closing Before Closing At Closing Before Closing

Subtotal 0.00 0.00 0.00 0.00

Lender Credit

Total 0.00

0.00

Figure 205: Total Closing Costs

2. Update the fields as required.

Lender Credits x

Fee Lender Credit
Name

Non-Specific Fee Specific Total Fee Amount
Amount Amount
ki 0.00

Save & Close

Figure 206: Update Closing Cost Total Dialog
3. Click Save & Close.

Closing Costs Service Providers Borrower Can't Shop For

The Closing Costs Service Providers Borrower Can't Shop For list contains the closing

costs agents and services that are pre-selected and cannot be changed. Use the following
steps to create the list. See Services Borrower Can't Shop For details about building the list.

SERVICE PROVIDERS BORROWER CAN'T SHOP FOR o

SERVICE PROVIDERS BORROWER CAN SHOP FOR o
Print Confirm Receipt

CHANGE OF CIRCUMSTANCE o

Figure 207: Closing Cost Services

Note: See Edit Origination Charges for details on editing a listed fee.
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Closing Costs Service Providers Borrower Can Shop For

The Closing Costs Services Providers Borrower Can Shop For list contains the closing
costs services that have multiple providers from which the Borrower can select. Use the
following steps to create the list. See Services Borrower Can Shop For details about building
the list. (See Figure 203.)

Note: See Edit Origination Charges for details on editing a listed fee.

Select the Print Confirmation Receipt checkbox to request confirmation when Borrower
receives the information.

Change of Circumstance
Complete the Change of Circumstance fields when the Borrower experiences a change of
circumstance the impacts the loan process.

1. Click the Change of Circumstance Add button. See Figure 203.

2. Select the Changed Date.

Add Change of Circumstance X

ASSOCIATED FEES c

2]

Changed Date

Disclose By Date

Re-Disclosed Date

B E

Received Date

<

Delivery Method

£

Reason
Other Description
Change Details

|

Figure 208: Add Changed Date Dialog

Enter the Disclose By Date.

Enter the Re-Disclosed Date if applicable.
Enter the Received Date.

Select the Delivery Method.

Select the Reason.

Enter the Other Description when selecting Other Reason.

© ©® N OO0 A~ W

Enter Change Details.
10. Click Add.

11. Select the associated loan section from the Select Section dropdown.
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12. Select the Fee Name.
13. Enter the Previous Fee Amount.
14. Enter the New Fee Amount.
15. Click Save & Close.
Note: Click Save & New to add another associated fee.
16. Click Save & Close on the Add Change of Circumstance dialog.

Note: Click Save & New to add another change of circumstance.

Estimated Cash-to-Close

The Loan Estimate/Closing Disclosure Form dropdown allows the user to select the
Standard or an Alternate form to allow selecting the printed form. The fields depend on the
selected form.

Standard Form

Use the following steps to select the Standard print form output and the loan application
type.
1. Select Application tab.

Status  Application = Processing  Underwriting Reporting Documents  Services  Settings

Loan ID : 20221101000011 - Amy America Export ‘ Save
Borrower Loan Estimate/Closing Disclosure Form  Standard v
Loan
Subject Property BORROWER'S TRANSACTION SELLER'S TRANSACTION
Initial Fees Worksheet
K. DUE FROM BORROWER o M. DUE TO SELLER o
Estimated Cash-to-Close
Loan Estimate L. PAID FOR/BY BORROWER o N. DUE FROM SELLER
Fannie Mae Addendum
Fee Amount
Freddie Mac Addendum CASH FROM/TO SELLER
Loan Amount 250,400.00
Anti-Steering Total Due To Seller
crom Total 250,400.00
Escrow Account Total Due From Seller
Initial ARM Disclosure
Total
HOEPA Counseling List CASH FROM/TO BORROWER
Total Due From Borrower
Total Paid For/By Borrower - 250,400.00
Jotal =25040000

Figure 209: Standard Estimate/Closing Disclosure
2. Select Estimated Cash-to-Close.
3. Select the Standard Loan Estimate/Closing Disclosure Form from the dropdown.

Add Due from Borrower
Use the following steps to add due from borrower fees.

1. Click the Due from Borrower Add button to add additional fees. (See Figure 205.)
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2. Select the appropriate Section from the dropdown.

Add Due from Borrower b4

Section Due From Borrower v Liability Type v
Fee Name e Closing Adjustment 82
Other Description Proration Type 82
Based On Total Loan Amount v To
Percentage %% Paid Outside of 82
Closing
Dollar Amount
From Date E
Total Amount k3
To Date E

Figure 210: Add Due from Borrower Dialog

3. Select the appropriate Fee Name dropdown.

Note: Enter a description when selecting Other from Fee Name. The selected Fee Name
populates the liability fields as required.

4. Select the appropriate Based On option.
5. Enter the Percentage or Dollar Amount as appropriate.
6. Complete the To field.

Note: The To field is not required when the Adjustments for Items Paid by seller in Advance is
selected.

7. Select Yes from the Paid Outside Closing dropdown if applicable.
8. Enter the From and To Dates if applicable.
9. Click Save & Close.

Note: Select Save & New to add another fee.

Edit Due from Borrower
Use the following steps to edit a listed due from borrower fee.
1. Click the fee to update. (See Figure 205.)

2. Complete the changes in the Edit Due from Borrower dialog. (See Add Due from
Borrower for details.)

3. Click Save & Close.

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

137


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

calyx Zenly User Guide

Add Due To Seller
Use the following steps to complete the Due To Seller section.
1. Click the Due To Seller Add button.

SELLER'S TRANSACTION

N

M. DUE TO SELLER 0

Figure 211: Due To Seller

2. Select the Fee Name.

Add Due To Seller b 4

Section Due To Seller ~ Liability Type ~
Fee Name v Closing Adjustment &7
Other Description Proration Type 2
Based On Total Loan Amount v To
Percentage % Paid Outside of v
Closing
Dollar Amount
From Date ’E
Total Amount | &
To Date E

Figure 212: Add Due To Seller

3. Select Other Description when selecting Other for the Fee Name. See Add Due To
Seller for details.

Enter the Percentage.

Enter the Dollar Amount.

Complete the remaining fields if available.

Click Save & Close.

Note: Click Save & New to add another fee due to seller.

N o g s

Edit Due To Seller
Use the following steps to edit a listed due to seller fee.

1. Select the Fee to edit. (See Figure 207.)

2. Update the fee to edit on the Edit Due To Seller dialog. (See Add Due To Seller for
details.)
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Delete Due to Seller
Use the following steps to delete due to seller fee.

1. Click the Delete icon. (See Figure 214.)

2. Click Delete on the Delete Confirmation screen.

Add Paid For/By Borrower

Use the following steps to complete the Paid For/By Borrower section.

1. Click the Paid For/By Borrower Add button.

L. PAID FOR/BY BORROWER o
Fee Amount

Loan Amount 250,400.00

Total 250,400.00

Figure 213: Paid For/By Borrower

2. Select the appropriate Section from the dropdown.

Add Paid For/By Borrower x

Section Paid For/By Borrower v Liability Type v
Fee Name ™ Closing Adjustment 4
Other Description Proration Type 2
Based On Total Loan Amount v To
Percentage % Paid Outside of 2
Closing
Dollar Amount
From Date E
Total Amount | $
To Date E

Figure 214: Add Paid For/By Borrower
3. Select the appropriate Fee Name from the dropdown.

Note: Enter a description when selecting Other from Fee Name. The selected Fee Name
populates the liability fields as required.

4. Select the appropriate Based On option.
5. Enter the Percentage or Dollar Amount as appropriate.
6. Complete the To field.

Note: The To field is not required when the Adjustments for Items Paid by seller in Advance is
selected.
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7. Select Yes from the Paid Outside Closing dropdown if applicable.
8. Enter the From and To Dates if applicable.
9. Click Save & Close.

Note: Select Save & New to add another fee.

Edit Paid For/By Borrower
Use the following steps to edit a listed Paid For/By Borrower fee.
1. Click the fee to update. (See Figure 209.)

2. Complete the changes in the Edit Paid For/By Borrower dialog. (See Add Paid
For/By Borrower for details.)

3. Click Save & Close.
Add Due From Seller

Use the following steps to complete the Due To Seller section.

1. Click the Due To Seller Add button. (See Figure 205)

2. Select the appropriate Section from the dropdown.

Add Due From Seller b4

Section Due From Seller v Liability Type ~
Fee Name N Closing Adjustment e
Other Description Praration Type 7
Based On Total Loan Amount v To
Percentage o Paid Qutside of 2
Closing
Dollar Amount 3
From Date E
Total Amount | %
To Date E

Figure 215: Add Due From Seller Dialog

3. Select the appropriate Fee Name from the dropdown.

Note: Enter a description when selecting Other from Fee Name. The selected Fee Name
populates the liability fields as required.

4. Select the appropriate Based On option.

5. Enter the Percentage or Dollar Amount as appropriate.
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6. Complete the To field.

Note: The To field is not required when the Adjustments for Items Paid by seller in Advance is
selected.

7. Select Yes from the Paid Outside Closing dropdown if applicable.
8. Enter the From and To Dates if applicable.
9. Click Save & Close.

Note: Select Save & New to add another fee.

Edit Due From Seller
Use the following steps to edit a listed Due from Seller fee.
1. Click the fee to update. (See Figure 205.)

2. Complete the changes in the Edit Due from Seller dialog. (See Add Due From Seller
for details.)

3. Click Save & Close.

Delete Due From Seller
Use the following steps to delete a listed due from seller fee.

1. Click the Delete icon. (See Figure 214.)

2. Click Delete on the Delete Confirmation screen.

Add Source of Down Payment
Use the following steps to update the Source of Down Payment section when required.

1. Click the Source of Down Payment Add button.

SOURCE OF DOWN PAYMENT # 0

Down Payment

Figure 216: Source of Down Payment
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2. Select Funds Type.

Add Down Payment Source X

Funds Type e
Other Description
Funds Source Type e
Other Description

Amount

Figure 217: Add Down Payment Source

Enter Other Description when selecting Other Funds Type.
Select Funds Source Type.

Enter Other Description when selecting Funds Source Type.
Enter Amount.

Click Save & Close.

Note: Select Save & New to add another down payment source.

N o o M W

Edit Source of Down Payment
Use the following steps to Edit Source of Down Payment.

1. Click the Funds Type to edit. (See Figure 212.)

2. Update the Edit Down Payment Source dialog. (See Add Source of Down Payment
for details.)

3. Click Save & Close.

Delete Source of Down Payment

Use the following steps to Delete Source of Down Payment.
1. Click the Delete Icon. (See Figure 212.)
2. Click Delete on the Delete Confirmation dialog.

Add Cash From Borrower

Use the following steps to complete the Details of Transaction (1003) section.
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Subject Property
DETAILS OF TRANSACTION (1003)
Initial Fees Worksheet
CASH FROM BORROWER © | cashTo BORROWER +)
Loan Estimate Fee Amount Fee Amount
Fannie Mae Addendum
PMI/MIP/VA/USDA Amount 3,942.50 Base Loan Amount 315,400.00
Freddie Mac Addendum
Sales Price 550,000.00 Up-Front MIP/PMI/Funding Fee Financed 3,942.00
Anti-Steering
Alterations 000 50000 @
Escrow Account
Initial ARM Disclosure Discount 000 @ Borrower Paid Fees 45000 @
HOEPA Counseling List Estimated Closing Costs 478500 @ Closing Costs Paid By Seller 000 @
Estimated Prepaid Items 150000 @ Subordinate Financing 000 @
Land 000 @ Total 320,292.00
Total 560,227.50

Figure 218: Details of Transaction

2. Select the Cash From Borrower Type option.

Add Cash From Borrower x

Cash From Borrower Type v

Amount ]

Figure 219: Cash From Borrower Dialog

3. Enter the Amount.
4. Click Save & Close.
Note: Select Save & New to add another down payment source.

Edit Cash From Borrower
Use the following steps to edit cash from borrower.

1. Select the Fee to edit. (See Figure 214.)
2. Update the Edit Cash From Borrower dialog. (See Add Cash To Borrower for details.)
3. Click Save & Close.

Delete Cash From Borrower
Use the following steps to delete cash from borrower.

1. Click the Delete icon. (See Figure 214.)
2. Click the Delete on the Delete Confirmation dialog.

Add Cash To Borrower
1. Click the Cash to Borrower Add button. (See Figure 214.)
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2. Select the Cash To Borrower Type from the dropdown.

Add Cash To Borrower b4

Cash To Borrower Type

Other Description
Source Type e

Other Description

Amount

Figure 220: Add Cash To Borrower Dialog

3. Enter Other Description when selecting Other Cash To Borrower Type.
4. Enter the Amount.
5. Click Save & Close.

Note: Select Save & New to add another down payment source.

Edit Cash To Borrower
Use the following steps to edit cash to borrower.
1. Select the Fee to edit. (See Figure 214.)

2. Complete the changes in the Edit Cash To Borrower dialog. (See Add Cash To
Borrower for details.)

3. Click Save & Close.

Delete Cash To Borrower
Use the following steps to delete cash to borrower entries.
1. Click the Delete icon. (See Figure 214.)

2. Click Delete on the Delete Confirmation dialog.
Alternative Form

Use the following steps when completing the alternative Cash-to-Close form fields.

Note: The Alternative form is typically used for refinanced loans.
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1. Select Alternative from the Loan Estimate/Closing Disclosure Form dropdown.

“ Zen]y LEADS/LOANS REPORTS USERS TEMPLATE _n o 5] 1
Status  Application = Processing  Underwriting  Reporting ~Documents ~ Services  Settings

Loan ID :20221101000011 - Amy America Export Save ‘
Borrower Loan Estimate/Closing Disclosure Form ~ Alternative v

Loan

Subject Property K. PAYOFFS AND PAYMENTS o

Initial Fees Worksheet

ESTIMATED CASH-TO-CLOSE

Alternative

Loan Estimate (e GO e
Fannie Mae Addendum Total Loan Amount 250,400.00
Freddie Mac Addendum Total Closing Costs () 0.00
Anti-Steering Closing Costs Paid Before Closing 0.00

Escrow Account Total Payoffs and Payments (K)

Initial ARM Disclosure

Total 250,400.00
HOEPA Counseling List
Closing Costs Financed 0.00
SOURCE OF DOWN PAYMENT o

Figure 221: Alternate Estimate/Closing Disclosure
2. Click the Payoffs and Payment Add button.
3. Complete the Add Payoffs and Payment fields.

Add Payoffs and Payments X

To
Account Liability Type v
Number
Closing v
Amount 5 Adjustment
Prepay 5 Other Description
Penalty
) Paid By Entity g
Subject Property
Paid By

Figure 222: Add Payoffs and Payments Dialog
4. Click Save & Close.
Note: Select Save & New to add another down payment source.

5. Complete the Source of Down Payment. (See Add Source of Down Payment for
details.)

6. Complete the Cash From Borrower fields. (See Add Cash From Borrower.)
7. Complete the Add Cash To Borrower fields. (See Add Cash To Borrower.)

Loan Estimate

The Loan Estimate screen discloses the TRID 2.0 compliance requirements for the following
loan types:

e Purchase

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

145


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

v

calyx Zenly User Guide

e Refinance
e Construction

Some screen fields are populated from the Loan screen and Initial Fees Worksheet. Use the
following sections to complete the fields that are not populated.

Note: Make changes to populated fields on the Loan screen and Initial Fees Worksheet.
Initial Fields

Use the following steps to complete the Loan Estimate. The initial fields are not auto
populated.

1. Select the Application tab.

2. Select Loan Estimate.

Status  Application ~ Processing  Underwriting  Reporting Documents  Services  Settings

Loan ID:20221101000011 - Amy America [Ceoor |[ sae |

Borrower

Application Date | 01/05/2019 12:00 AM -]
Loan
Subject Property Purpose | Refinance
Initial Fees Worksheet Product

Estimated Cash-to-Close

Fannie Mae Addendum

Rate Lock No v
Rate Lock Expiration Date ®C v

Freddie Mac Addendum Estimate Available Through Bc v Omitted from Print
Anti-Steering ,

Intent to Proceed ] v
Escrow Account

Optional Payment v If Yes, Period Months
Initial ARM Disclosure

HOEPA Counseling List (] Prepayment Penalty

If Yes, Penalty will be Based on v

Rate Percentage

Figure 223: Loan Estimate Tab
Select Yes from the Rate Lock dropdown to lock the interest rate.
Use the Calendar to select the Rate Lock Expiration Date if applicable.
Use the Clock and Time Zone dropdown to set the Rate Lock time.

Use the Calendar to select the Estimate Available Through date.

N O oM W

Use the Clock and Time Zone dropdown to set the Estimate Available Through
time.

8. Use the Calendar to select the Intent to Proceed date after receiving notification
from the borrower to move forward with the loan.

9. Use the Clock and Time Zone dropdown to set the Intent to Proceed time.

10. Select Yes from the Optional Payment dropdown if borrower elects to make
optional payments.

11. Enter the Months value if selecting Yes.

12. Select the Prepayment Penalty checkbox if applicable.
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13. Complete the Prepayment Penalty fields if applicable.

Remaining Fields

Complete the remaining fields that are not populated from the Loan Screen and Initial Fees

Worksheet.

1. Select the appropriate Assumptions radio button.

OTHER CONSIDERATIONS

Assumptions:

will not allow assumption of this loan on the original terms.

Late Payments:

If @ payment is more than days late, you will be charged |$

Servicing:

We intend

SIGNATURE CONFIRMATION

will allow, under certain conditions, this person to assume this loan on the original terms.

£ v

Other Description

Print Confirm Receipt

Print Additional Signature Page

HIGHER-PRICED MORTGAGE LOAN

APOR Date

APOR

Unable to determine if loan is HPML. You must enter the Average Prime Offer Rate.

Figure 224: Remaining Loan Estimate Fields

Enter Other Description if selecting Other from the Percentage Description

Select the Print Confirmation Receipt checkbox to print the confirmation page.

Select the Print Additional Signature Page checkbox for co-borrower if applicable.

2. Set the Late Payments Days Late value.
3. Enter the Late Fee Charge or Percentage.
4. Select the Percentage Description from the dropdown if applicable.
5.
dropdown.
6. Select the appropriate Servicing option.
7.
8.
Q.

10. Click Save.

Complete the Higher-Priced Mortgage Loan fields if applicable.

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com

www.calyxsoftware.com

© Calyx Technology, Inc. 1991-2024. All rights reserved.

147


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

v

calyx Zenly User Guide

Fannie Mae Addendum
Fannie Mae requires specific addendums for financing mortgages.
Property

Complete the Fannie Mae Property Addendum information not auto populated from other
screens.

1. Select Application tab.

Status  Application = Processing  Underwriting  Reporting Documents Services  Settings

Loan ID :20221101000011 - Amy America Save
Borrower O  AmyAmerica / Andy America - Primary
Loan Ken N Customer Jr
Subject Property
PROPERTY
Initial Fees Worksheet
Estimated Cash-to-Close Subject Property Type Condominium v Property Data ID
Loan Estimate Project Classification v Sales Contract Amount |
Fannie Mae Addendum
CPM Project ID PACE Amount $ 0.00
Freddie Mac Addendum
v
Anti-Steering Appraisal ID Did the seller provide below
market financing?
Escrow Account

Figure 225: Fannie Mae Property Details
Select Fannie Mae Addendum.
Verify the Subject Property Type from the dropdown.
Select the Project Classification from the dropdown.
Enter the CPM Project ID.
Enter the Appraisal ID.
Enter Property Data ID.

Enter the Sales Contract Amount.

© ® N OO A W N

Select the Did seller provide below market financing? checkbox if applicable.
Loan Application Information

The Loan Application Information Addendum information includes loan application details
required by Fannie Mae.
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1. Verify the Product Code is correct.

LOAN APPLICATION INFORMATION

Product Code Refinance Type hd
Product Description v Other Description
Product Plan Number v Total Financed Properties
Lender is funding buydown Escrow Waived

Figure 226: Loan Application Information
Select the Product Description option.
Select the Product Plan Number option.
Select the Lender is funding buydown checkbox if applicable.
Select the ARM Index Type option.
Select the Refinance Type option.
Enter Other Description if applicable.

Enter the Total Financed Properties.

© ® N OO A W N

Select the Escrow Waived checkbox if appropriate.
Community Lending

The Community Lending Addendum information includes community details in which the
property resides.

1. Select the Enable Community Lending Yes option to access the remaining
Community Lending fields if applicable.

COMMUNITY LENDING

Enable Community Lending " Metro Statistical Area or
County
Fannie Neighbor Eligible No
Product v

Community Seconds
HUD Area Median Income &
Repayment Structure s
Income Limit Adjustment o

Income Limit &

Figure 227: Community Lending
Note: Proceed to FHA when selecting No.
2. Select the appropriate Fannie Neighbor Eligibility option.
3. Select the appropriate Community Seconds option.

4. Select the appropriate Repayment Structure option if Yes is selected for
Community Seconds.
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5. Enter Metro Statistical Area or County if applicable.
6. Select the appropriate Product.
7. Enter Housing and Urban Development (HUD) Area Median Income if applicable.
8. Enter Income Limit Adjustment percentage if applicable.
9. Enter Income Limit amount if applicable.

FHA

The FHA Addendum information includes information required for FHA loans through
Fannie Mae.

1. Select the Section of the Act to which the loan pertains option.

FHA

Section of the Act v Mortgage Credit Certificate %

MIP Refund Amou $
1IP Refund Amount Seller Concessions &

Figure 228: FHA Fields
Enter Mortgage Credit Certificate amount.
Enter Mortgage Insurance Premium (MIP) Refund Amount.
Enter Mortgage Credit Certificate amount.

o~ w N

Enter Sellers Concessions amount.
VA

The VA Addendum information includes information required for VA loans through Fannie
Mae.

1. Enter Monthly Maintenance amount.

VA

Manthly Maintenance $ Monthly Utilities F

Entitlement Amount $ Married to Borrower ™

Figure 229: VA Fields
2. Enter Entitlement Amount.
3. Enter Monthly Utilities amount.

4. Select Married to Borrower option.
Validation Service Providers

Use the following sections for validation service providers.
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Add Provider
Use the following to add a service provider.

1. Click the Borrower Validation Service Providers Add button.

Borrower \ Co-Borrower \
VALIDATION SERVICE PROVIDERS @  VALIDATION SERVICE PROVIDERS (+)

TOTAL TAXES & DEDUCTIONS (+] TOTAL TAXES & DEDUCTIONS (+)

Figure 230: Borrower/Co-Borrower Fields

2. Select the Verification Type option.

Add Validation Service Providers X

Verification Type h
Service Provider ~
Reference Number

Reissue Number

Figure 231: Add Validation Service Providers

Select the Service Provider option.
Enter Reference Number.

Enter Reissue Number.

Click Save & Close.

Note: Click Save & New to add another validation service provider.

o o~ W

7. Repeat Steps 1 - 6 to add Co-Borrower Validation Service Providers.

Edit Provider
Use the following steps to edit provider.
1. Select the Service Provider to edit. (See Figure 226.)

2. Update the Edit Validation Service Providers dialog. (See Add Provider for details.)
3. Click Save & Close.

Delete Provider
Use the following steps to delete cash to borrower.

1. Click the Delete icon. (See Figure 226.)
2. Click the Delete on the Delete Confirmation dialog.
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Total Taxes and Deductions

Use the following sections for validation service providers.

Note: Use the VA Loan Type to enable this section. See Loan Information.

Add Deductions
1. Click the Total Taxes and Deductions Add button.

Borrower Co-Borrower

VALIDATION SERVICE PROVIDERS (+] VALIDATION SERVICE PROVIDERS (+]

TOTAL TAXES & DEDUCTIONS \ (+] TOTAL TAXES & DEDUCTIONS \ (+]

Figure 232: Total Taxes and Deductions

2. Select the Deductions Type option.

Type v

Amount 5

Figure 233: Add Total Taxes and Deductions

3. Select the Amount.
4. Click Save & Close.

Note: Click Save & New to add another total taxes and deductions.

5. Repeat Steps 1 - 4 for Co-Borrower Total Taxes and Deductions.

Edit Deductions
Use the following steps to edit deductions.

1. Select the Taxes and Deductions to edit. (See Figure 228.)

2. Update the Edit Total Taxes and Deductions dialog. (See Add Deductions for
details.)

3. Click Save & Close.

Delete Deductions
Use the following steps to delete deductions.

1. Click the Delete icon. (See Figure 228))
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2. Click the Delete on the Delete Confirmation dialog.

Freddie Mac Addendum

Freddie Mac requires specific addendums for financing mortgages.

1.

o0 A W N

Enter the Lender Registration Number if applicable.

Status  Application  Processing  Underwriting Reporting Documents  Services  Settings

Loan 1D :20221101000011 - Amy America

Borrower

Loan Ken N Customer Jr

Andy Ar i
Subject Property ndy America

Initial Fees Worksheet Lender Registration Number

Estimated Cash-to-Close
Lender Branch Number
Loan Estimate

Fannie Mae Addendum

Freddie Mac Addendum

Submitting Role

Case State

O  AmyAmerica- Primary

Underwriting

Export Save

Anti-Steering
Escrow Account
Initial ARM Disclosure

HOEPA Counseling List

PROPERTY

TRANSACTION DETAIL

Agency Case Number Interviewer Signed Date =]
LOAN PROGRAM o FHA/VA
Discount Points Financed % 0.00
VA Residual Income ~ # 0.00
Borrower Paid Closing Costs 0.00

Figure 234: Freddie Mac Addendum

Enter the Lender Branch Number if applicable.

Enter the Agency Case Number if applicable.

Select the appropriate Submitting Role option from the dropdown menu.

Select the Interviewer Signed Date.

Select the Save button at the top of the screen.
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Loan Program

Choose the desired Loan Program if applicable for Freddie Mac.
1. Click the Add button.

LOAN PROGRAM —) O

Figure 235: Loan Program (Freddie Mac)

2. Select the desired option from the Loan Program dropdown menu.

Add Loan Program

Loan Program i

Figure 236: Add Loan Program

3. Select Save & Close or Save & New to add another Loan Program.

4. Select the Save button at the top of the screen.

FHA/VA
1. Enter Discount Points Financed if applicable.
FHA/VA
Discount Points Financed $ 0.00
VA Residual Income $ 0.00
Borrower Paid Closing $ 0.00
Costs

Figure 237: FHA/VA
2. Enter VA Residual Income if applicable.
3. Enter Borrower Paid Closing Costs if applicable.

4. Select the Save button at the top of the screen.
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Property
1. Select Yes or No whether the property is a Manufactured Home.
PROPERTY
Manufactured Home v

Deed Restriction 0 Months

Construction Status

Appraisal ID

Figure 238: Property (Freddie Mac)
2. If needed, enter months of Deed Restriction.
3. Select a Construction Status option if applicable.
4. Enter Appraisal ID.
5

Select the Save button at the top of the screen.
Transaction Detail

1. Enter Sales Concessions if applicable.

TRANSACTION DETAIL

Sales Concessions % 0.00
Cash-Out B 250,400.00
ARM Index Type v

QOther Description

Figure 239: Transaction Detail
2. Enter a Cash-Out if applicable.
3. Select the ARM Index Type dropdown, choose the desired option.
4. If the Other option was selected for the ARM Index Type, enter an Other Description.

5. Select the Save button at the top of the screen.
Validation Service Providers

Add Validation Service Providers for the Borrower/Co-Borrowers.
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1. Click on the Add button.

BORROWER CO-BORROWER

VALIDATION SERVICE PROVIDERS \ o VALIDATION SERVICE PROVIDERS \ o

Figure 240: Validation Service Providers

2. Select the desired option for the Verification Type dropdown menu.

Add Validation Service Providers X

Verification Type ‘ v |

Service Provider

Reference Number ‘ |
Reissue Number ‘

| Save & New | | Save & Close ‘ ‘ Cancel ‘

Figure 241: Add Validation Service Providers
Select the desired option for the Service Provider dropdown menu.
Enter the Reference Number.

Enter Reissue Number.

o o~ W

Select Save & Close or Save & New to another Validation Service Provider.

Negative Amortization

These radio buttons are read only and will be automatically selected based on loan
information that was entered on the loan file.

NEGATIVE AMORTIZATION
You are scheduled to make monthly payments that do not pay all of the interest due that month. As a result, your loan
amount will increase.
You may have monthly payments that do not pay all of the interest due that month. If you do, your loan amount will
increase.

® You do not have a negative amortization feature.

Figure 242:Negative Amortization

Anti-Steering Disclosure

Loan originators are required to present an Anti-Steering Disclosure to borrowers to comply
with the Federal Truth-In-Lending Act (TILA) and Regulation Z (Reg Z). The disclosure

includes the available options for each loan type in which the borrower has expressed an
interest.

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

156


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

calyx Zenly User Guide
1. Select Application tab.
Status  Application =~ Processing  Underwriting Reporting Documents Services  Settings
Loan ID : 2022101000011 - Amy America [ Export \ se |
Borrower O | certify that there is not a difference between Lowest Interest Rate and Lowest Interest Rate without Risky Features because | do not broker loans with
Lo 'risky features"
Subject Property Type of Transaction v
Inital Fees Worksheet Interest Rate Adjusted Origination Charges
Estimated Cash-to-Close
Loan Estimate Lowest Interest Rate $
Fannie Mae Addendum Lowest Interest Rate without Risky Features % $
Freddie Mac Addendum Lowest Origination Costs %| |8
You are applying for a loan with the following terms 5250% | $ 0.00
Escrow Account
Initial ARM Disclosure
HOEPA Counseling List
Figure 243: Anti-Steering
2. Select Anti-Steering.
3. Check the certification checkbox if applicable.
4. Select the Type of Transaction from the dropdown.
5. Enter the Lowest Interest Rate percentage available.
6. Enter the Lowest Interest Rate without Risky Features percentage available.
7. Enter the Lowest Origination Costs percentage available.
8. Enter Adjusted Origination Charges for each field as applicable.
Escrow Account

Fees checked as Escrow in Section G. of the Initial Fees Worksheet will populate the Escrow

Account section. The Escrow Account allows the user to calculate the disbursement for

escrow fees.

To generate Escrow payments:

1

Enter a First Payment Date.
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2. Select the Calculate button.

Status  Application =~ Processing  Underwriting  Reporting Documents  Services  Settings

Loan ID :20221101000011 - Amy America (oo |[ sae ]

Borrower INITIAL ESCROW ACCOUNT

Loan
AGGREGATE PAYMENT

Subject Property

Initial Fees Worksheet First Payment Date =)

Estimated Cash-to-Close Initial Deposit ~ $

Loan Estimate
Aggregate Escrow Adjustment $

Fannie Mae Addendum
Freddie Mac Addendum Cushion Selected &
Anti-Steering

Initial ARM Disclosure

HOEPA Counseling List

Figure 244: Escrow Account

3. Review the Escrow Account Setup.

Escrow Account Setup »
Disclaimer: Selecting the Calculate button will update the Month and the Total Fees for section G.

s ; ; i Load Default
Initial Escrow Payment at Closing table in the Initial Fees Worksheet.

Fee Escrow Cushion Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec

City 2 1
Property
Tax

Hazard 1 1
Insurance

Mortgage 1 1 1 1 1 1 1 1 1 1 1 1 1
Insurance

Calculate | Cancel

Figure 245: Escrow Account Setup

4. If needed, adjust the information.

Note: Selecting the Calculate button will update the Month, Escrow Indicator, and the Total
Fees for section G. Initial Escrow Payment at Closing table in the Initial Fees Worksheets.
The status of the Escrow indicator will determine whether a Fee is included in the
calculation.
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5. Select the Calculate button.

Loan ID : 20220307000011 - Andy America

EEN

Sorrower INITIAL ESCROW ACCOUNT
Loan Month Descriptions Escrow Account Balance
Subject Property Payment To Payment From
Initial Fees Worksheet
Initial Deposit 638.00
Estimated Cash-to-Close
Loan Estimate »  January, 2023 Mortgage Insurance 403.00 123.00 918.00
Fannie Mae Addendum
Freddie Mac Addendum »  February, 2023 Mortgage Insurance 403.00 123.00 1,198.00
Anti-Steering
»  March, 2023 Mortgage Insurance 403.00 123.00 1,478.00
Initial ARM Disclosure > April, 2023 Mortgage Insurance 403.00 123.00 1.758.00
HOEPA Counseling List
» May, 2023 Mortgage Insurance 403.00 123.00 2,038.00
» June, 2023 Mortgage Insurance 403.00 123.00 2,318.00
» July, 2023 Mortgage Insurance 403.00 123.00 2,598.00
> August, 2023 Mortgage Insurance 403.00 123.00 2,878.00
/.../Borrower Martoane ncuwanze 402 00 12200 21cenn

Figure 246: Escrow Disbursements

6. Review the disbursement and re-calculate if needed.

7. Click the Save button at the top of the screen after reviewing the generated

information.

Initial ARM Disclosure

Users may need to complete this screen to issue an initial Adjustable-Rate Mortgage
Disclosure.

To navigate to this screen:

1

Click on the Application tab.
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2. Click on Initial ARM Disclosure.

Status Documents  Services

Application

Processing

Underwriting  Reporting Settings

Loan ID :20221101000011 - Amy America

HOW YOUR INTEREST RATE IS DETERMINED

Borrower

Loan
Program Name
Subject Property

Index T v
Initial Fees Worksheet ndex Type

Estimated Cash-to-Close Other Description
Loan Estimate Information about the index available in/at
Fannie Mae Addendum %

Freddie Mac Addendum
[ the index value plus a margin rounded to the nearest

:] Other:

:] Interest Rate changes are subject to lender's discretion.

Your Index is based on:
Anti-Steering

Escrow Account

Initial ARM Disclosure

(] nitial Interest Rate Discount
HOEPA Counseling List

(] nitial Interest Rate Premium

Figure 247: Initial ARM Disclosure
How Your Interest Rate is Determined

1. Enter the Program Name.

2. Click on the Index Type dropdown menu and select an Index.

HOW YOUR INTEREST RATE IS DETERMINED

Program Name
Index Type hd

Other Description l 1 Year LIBOR
6 Month LIBOR
Wall Street Journal LIBOR
Fannie Mae LIBOR
Freddie Mac LIBOR
Fannie Mae 60 - Day Required Net Yield
| Freddie Mac 60 - Day Required Net
1 Year T- Bill
3Year T - Bill
‘ 5 Year T - Bill
6 Month T - Bill
| Federal Cost of Funds
‘ MTA
Prime Rate
‘ CoDI
cosl
1 - Month British Bankers Association LIBOR on Bloomberg
1 - Month British Bankers Association LIBOR Rate(Monthly)
1 - Month CD Rate Secondary Market(Weekly Avg)

Information about the index available in/at

Your Index is based on:

IMPORTANT LOAN INFORMATION

_A

Figure 248: Index Type

3. Ifthe user selects Other, enter the Index in the Other Description field.

4. If needed, enter information about the index availability.
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5. Select an option that the Index is based on.

Note: Select all that apply.
Your Index is based on: \:\ the index value plus a margin rounded to the nearest

| other: | |

7‘ Interest Rate changes are subject to lender's discretion

_\ Initial Interest Rate Discount

7\ Initial Interest Rate Premium

Figure 249: Index Option
Important Loan Information

1. Click on the dropdown menu to select if the loan has a Demand Feature.

IMPORTANT LOAN INFORMATION

Demand Feature, v

Prepayment Penalty

Figure 250: Important Loan Information
2. If needed, select the Prepayment Penalty checkbox.
3. Click on the button.

Worst Case Scenario

This section explains how the ARM payments are calculated and the maximum payment
the borrower might pay.

WORST CASE SCENARIO (BASED ON A LOAN AMOUNT OF $10,000)

The payment can rise from a first year payment of § 55.22 toa maximum of
$ 55.65 in the 30.00 year.
For example, the monthly payment for a mortgage amount of $60,000 would be:

$60,000 divided by $10,000 =6; 6 X % 55.22 = & 331.32 per month.

Figure 251: Worst Case Scenario

HOEPA Counseling List

Complete Homeownership and Equity Protection Act (HOEPA) options when home ownership
counseling is required.
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Generate Counseling List

Generate a list of available homeownership counselors.

1.
2.

Select Application tab.
Select HOEPA Counseling List.

Status  Application ~ Processing  Underwriting  Reporting  Documents  Services  Settings

Borrower

Loan

Subject Property

Initial Fees Worksheet
Estimated Cash-to-Close
Loan Estimate

Fannie Mae Addendum
Freddie Mac Addendum
Anti-Steering

Escrow Account

Initial ARM Disclosure

HOEPA Counseling List

Loan ID:20221101000011 - Amy America

O  AmyAmerica- Primary

Ken N Customer Jr

Andy America
BORROWER CO-BORROWER

COUNSELORS LIST 1 ©  COUNSELORSLIST

(o o )

HOMEOWNERSHIP EDUCATION HOMEOWNERSHIP EDUCATION

Completed v Completed
Completed Date [::] Completed Date
Training Format v Training Format
Counselor Name Counselor Name
Company Name Company Name

Address 1 Address 1
Address 2 Address 2

City City

Figure 252: HOEPA Counseling List

Click Generate List to create the Counselors List.

COUNSELORS LIST (]

[+

Company /f’isted

NATIONAL COMMUNITY REINVESTMENT COALITI...
NATIONAL FOUNDATION FOR CREDIT COUNSELI...
UNIVERSITY LEGAL SERVICES

UNITED PLANNING ORGANIZATION

HOUSING COUNSELING SERVICES, INCORPORAT...
GREATER WASHINGTON URBAN LEAGUE

LATINO ECONOMIC DEVELOPMENT CORPORATI...

CARECEN-CENTRAL AMERICAN RESOURCE CENTER
UNIVERSITY LEGAL SERVICES

LATINO ECONOMIC DEVELOPMENT CORPORATI...

B 52 58 858 8 32 &2 8 & G

Figure 253: Counselor List

Repeat Steps 1 - 13 for the co-borrower.
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Add HOEPA Counseling List
Use the Add option to create a HOEPA Counseling List or add to the generated list.
1. Click the Counselors List Add button. (See Figure 248.)

2. Enter the Company Name.

Add Counseling List X

Company Name Phone

Address 1 Web Site
Address

Address 2
Email Address

City
Counselor v
State/Province v Visited
Postal Code ) Agency ID#
LANGUAGES PROVIDED o COUNSELING SERVICES o
PROVIDED

Figure 254: Add Counseling List

Enter Address information.

Enter Phone number.

Enter Web Site Address.

Enter Email Address.

Select Counselor Visited from the dropdown.
Enter Agency ID#.

© ©® N OO0 A~ W

Click the Languages Provided Add button to select the preferred language.

Add Languages Provided X

Language h

Figure 255: Add Languages Provided
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10. Click the Counseling Services Provided Add button to select the service.

Add Counseling Services Provided

Service 24

Figure 256: Add Counseling Services Provided
11. Click Save & Close.

Edit HOEPA Counseling List

Use the following steps to edit a listed HOEPA counseling service provider.
1. Select the service provider to edit. (See Figure 249.)
2. Update the Edit Counseling List dialog. (See Add HOEPA Counseling List for details.)
3. Click Save & Close.

Delete HOEPA Counseling List
Use the following steps to delete a listed HOEPA counseling service provider.

1. Select the service provider to delete. (See Figure 249.)

2. Click Delete on the Delete Confirmation dialog.
Homeownership Education

Use the Homeownership Education section to track the completion status of the
borrower/co-borrower homeownership education.

1. Select Yes from the Completed dropdown when borrower finishes the required

education.
HOMEOWNERSHIP EDUCATION HOMEOWNERSHIP EDUCATION
Completed v Completed v
Completed Date Completed Date ]
Training Format v Training Format v
Counselor Name Counselor Name
Company Name Company Name
Address 1 Address 1
Address 2 Address 2
City City
State/Province v State/Province v
Postal Code . Postal Code
Agency ID# Agency ID#

Figure 257: Homeownership Education

2. Select the Completion Date.
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3. Select the Training Format option.
4. Enter Counselor Name.
5. Enter the Company Name and Address.
Note: Enter the Postal Code to auto-populate the City and State.
6. Enter Agency ID# the borrower received after education completion.

7. Repeat Steps 1 - 6 for the co-borrower.
Housing Counseling

Use the Housing Counseling section to track the completion status of the borrower/co-
borrower housing counseling.

1. Select Yes from the Completed dropdown when borrower finishes the required
housing counseling.

2. See Homeownership Education for completion details.

3. Repeat Steps 1 - 2 for the co-borrower when appropriate.

Loan Processing

Use the Loan Processing screens to prepare for form printing.

Note: Printing is performed from the Documents screen. (See Documents for additional
information.)

Credit Information
Use the Credit Information screen to prepare for Credit Report requests.

Credit Scores

Complete the following section to request Credit Reports.
1. Select the Processing tab.

2. Select Credit Information.
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3. Click the Borrower Credit Scores Add button.
Status  Application  Processing ~ Underwriting  Reporting ~ Documents  Services  Settings I
Loan 1D :20221101000011 - Amy America ‘ Export ‘ Save

Credit Information

Tax Return Requests
Title Commitment Request
Verification/Certification
FHA

CREDIT SCORES
Affiliated Business

O  AmyAmerica / Andy America - Primary

Ken N Customer Jr

BORROWER CO-BORROWER

o CREDIT SCORES °

Minimum FICO Minimum FICO

Figure 258: Add Credit Score

4. Select the Credit Repository Type from the dropdown menu.

Add Credit Bureau G

U.S Consumers Rank

Credit Repository Type b Credit Repository
Model Used Address

Score Category Unit Designator W Number
Credit Score City

State/Province

Range of Passible Scares to Postal Code
Number of Recent Inquiries Phone -
Score Date

FACT Act Inquiries

FACTORS

Figure 259: Add Credit Bureau Dialog
Enter the Model Used.
Enter the Score Category.
Enter the U.S Consumers Rank.
Enter the Range of Possible Scores.
Enter the Number of Recent Inquiries.
Use the Calendar to enter the Score Date.

. Select the FACT Act Inquiries checkbox if appropriate.
. Enter the Credit Repository.
. Complete the Address fields.
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14. Click Add if additional factors are required.

Code

Description

Figure 260: Add Factor Dialog

15. Enter the Code.

16. Enter code Description.

17. Click Save & Close on the Add Factor dialog.
Note: Click Save & New to add additional factors.

18. Click Save & Close on the Add Credit Bureau dialog.
Note: Click Save & New to add another credit bureau.

19. Enter Minimum FICO score.

Borrower Co-Borrower

CREDIT SCORES (] CREDIT SCORES (4]

Minimum FICO Minimum FICO

Figure 261: Minimum FICO Score

20. Repeat steps 1 - 19 for co-borrower.
Alternate Creditor Names

Complete the following section when the borrower/co-borrower has obtained credit under
a different name.

1. Click the Borrower Alternate Creditor Names Add button.

ALTERNATE CREDITOR NAMES o

Figure 262: Add Alternate Creditor Names
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2. Enter the name the Borrower Name previously used for credit.
Add Credit Under Alternate Name 574

First

Middle

Last

Suffix

Creditor Name

Account Number

Figure 263: Add Credit Under Alternate Name

3. Enter Creditor Name.
4. Enter Account Number under which the credit was obtained.
5. Click Save & Close.

Note: Click Save & New to add another previous name.

6. Repeat Steps 1 - 5 for co-borrower.
Credit Score Details

Enter the credit score details for the borrower and co-borrower.

1. Select the appropriate borrower Provided on Behalf of Lender option.

CREDIT SCORE DETAILS

Provided on Behalf of Lender A

Disclosed Credit Score v

Credit Bureau Disclosed

Figure 264: Credit Score Details
2. Select the appropriate borrower Disclosed Credit Score option.

3. Repeat Steps 1 - 2 for the co-borrower.

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

168


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

v

calyx Zenly User Guide

Tax Return Requests

Use the Tax Return Requests tab to provide the borrower authorization to verify tax
information with the Internal Revenue Service (IRS).

e Form 4506 orders copies of tax returns.
e Form 4506-T orders transcripts of tax returns.

e Form 4506-C enables Income Verification Express Service (IVES) participants to
order tax transcript records electronically for a third-party.

Note: Zenly creates a clean version of Form 4506-C that is compatible with OCR (Optical
Character Recognition) technology.

Request Transcript

Use the following steps to request Tax Return Transcripts.

Note: Complete separate request for each borrower.
1. Select the Processing tab.

2. Select Tax Return Requests.

3. Click Add.
Status Application Processing Underwriting Reporting Documents Services Settings
Loan ID : 20221101000011 - Amy America [Ceport |[ sae |
Ken N Customer Jr
Title Commitment Request REQUEST FOR TRANSCRIPT OF TAX RETURN (4506/4506-T/4506-C) )

Verification/Certification
LINE 5A - IVES

FHA

Affiliated Business Participant Name Telephone (L )__-

Address Extension

Figure 265: Request Transcripts
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4. Select the Tax Request Status option.

| Add4506/4506T/4506C

NAME ON TAX RETURN SPOUSE NAME
Tax Request Status Individual v First First
Borrower v Middle Middle
Customer File Last Last
Number
Suffix Suffix
Tax Form Number v
SSN/Tax ID R EIN SSN/Tax ID S EIN| _—
Certified Copies
Alternate Name Alternate Name
Unigue ID
Line 1A Request Line 2A Request
Wage & income Wage & income
Transcripts Transcripts
REQUEST PERIOD END DATES
FEES ADDRESS ON RETURN
Cost Amount | & Address Type Current v
Number of Address
Returns
Unit @ Number
TRANSCRIPT REQUESTED Total Amount k1 Designator
Return Verification of Return Refund to 3rd ity
Transcript Nonfiling Party on Line 5
Account Formw-2, REQUEST WAGE & INCOME State/Province
Transcript 1099, 1098, or FoRM )
Record of 5498 Postal Code -

Figure 266: Add Transcript Details
5. Select the appropriate Borrower option.

Note: The Borrower's information auto-populates into the Name on Tax Return fields. The
spouse's information auto-populates if the Borrower dropdown menu contains both the
Borrower and Co-Borrower. See the figure below.

Add 4506/ 4506-T/ 4506-C X

NAME ON TAX RETURN SPOUSE NAME
Tax Request Status Individual v First Andy First Amy
Borrower | Andy America/ v Middle Middle
Customer File Last  America Last America
Number
Suffix Suffix
Tax Form Number v
SSN/Tax ID 999-6C EIN SSN/Tax ID 500-6C EIN .
Certified Copies
Alternate Name Alternate Name
Unique ID i
Line 1A Request Line 2A Request
Wage & income Wage & income
Transcripts Transcripts

Figure 267: Borrower/Spouse Information
Enter the Customer File Number.
Select the Tax Form Number option.

If needed, select the Certified Copies checkbox.

© ® N O

Enter a Unique ID.
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10
11

12.
13.

14.
15.
16.
17.

18.

19.

. Complete the Request Period End Dates.
Select the appropriate checkboxes for Transcript Requested.

Selecting the Form W-2, 1099, 1098, or 5498 checkbox will enable the Request
Wage & Income Form.

Select the Alternate Name checkbox if applicable.

Select the Line 1A Request Wage & Income Transcripts if applicable.
This checkbox is unavailable by default.

Enter the Cost Amount.

Enter Number of Returns.

Select the Return Refund to 3 Party on Line 5 if applicable.

Use the dropdown menus to select which forms to request in the Request Wage &
Income Form section.

This section is unavailable by default.

For the Spouse Name section, select the Alternate Name/Joint Return checkbox
if applicable.

Select the Line 2B Request Wage & Income Transcripts if applicable.

This checkbox is unavailable by default. See step 11 of the Request Transcript
section.

20. Select the Address Type.

Note: The Address fields populate for the selected address.

21.

Click Save & Close.

Note: Click Save & New to request additional returns.

Line 5a - IVES

Complete IVES fields to order tax transcript records for a third-party.

1

Enter Participant Name.

LINE 5A - IVES

Participant Name Telephone -
Address Extension

Unit Designator v Number Fax [ I
City SOR Mailbox ID
State/Province v Participants ID

Postal Code

Figure 268: Line 5a - IVES Dialog
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Complete the Address fields.
Enter Telephone number.
Enter Extension if applicable.
Enter Fax number.

Enter SOR Mailbox ID.

Enter Participants ID.

N oo s w N

Line 5d - Client

Use the fields in this section to enter the client's information.

1. If needed, select the Same as IVES checkbox.

LINE 5D - CLIENT

Same as IVES
Client Name
Address
Unit Designator v Number

City

State/Province hd
Postal Code

Telephone ) -

Extension

Figure 269: Client
2. Enter the Client's name.
3. Complete the Address fields.
4. Enter Telephone number.
5

Enter telephone Extension if applicable.
Line 5 — Return To

Use the Return To fields to indicate where the requested returns should be sent.
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1. Enter the Company Name.

LINE5 - RETURN TO

Company Name
Address
Unit Designator v Number
City
State/Province hd
Postal Code
Telephone ) -

Extension

Figure 270: Return To Dialog
2. Complete the Company Address fields.
3. Enter Company Telephone Number.

4. Enter Extension if applicable.
Tax Request - ID & W-9

Complete the Tax Request - ID & W-9 Borrower fields to verify company ID and W-9
certification if applicable.

1. Select the Borrower Alternate Name checkbox if applicable.

TAX REQUEST - ID NUMBER & CERTIFICATION (W-9)

Borrower
Alternate Name
Name Andy America
Company Name
Federal Tax Classification v
Other Description
Limited Tax Classification v
Exempt Payee Code
FATCA Reporting Code v

Print Requester Name

ACCOUNTS (OPTIONAL) (+]

Figure 271: Tax Request - ID & Certification (W-9)
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2. Enter Borrower Name.

3. Enter the Company Name.

4. Select the Federal Tax Classification option.
Note: Enter Other Description when selecting Other Federal Tax Classification.
Select the appropriate Limited Tax Classification option if applicable.
Enter the Exempt Payee Code if applicable.
Select the FATCA Reporting Code option.

Select the Print Requester Name to include the requester name.

© N o o

9. Repeat Steps 1 - 8 for the co-borrower if applicable.

Add Tax Account
Use the following steps to add a tax account.

1. Click the Accounts (optional) Add button to enter an Account Number.

ACCOUNTS (OPTIONAL) o

Account Number

555555555 [

Figure 272: Accounts (optional)

2. Enter Account Number.

Add Accounts (Optional)

Account Number

Figure 273: Add Accounts

3. Click Save & Close.
Note: Click Save & New to add another account.

Edit Tax Account

Use the following steps to edit a tax account.
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1. Click the Account Number to edit. (See Figure 268))
2. Change the Account Number as applicable. (See Add Tax Account for details.)
3. Click Save & Close.

Delete Tax Account

Use the following steps to delete a tax account.

1.
2.

Click the Delete icon. (See Figure 268.)
Click Delete on the Delete Confirmation dialog.

Tax Authorization 8821

Complete the Tax Authorization (8821) fields to provide taxpayer authorization for personal
taxes to be reviewed.

1.

Enter the Borrower SSN/Tax ID if applicable.

TAX INFORMATION AUTHORIZATION (8821)

Borrower Co-Borrower
MName Andy America Name Amy America
SSN/Tax ID 999-60-3333 SSN/Tax ID 500-60-2222
EIN - EIN [
Plan Number Plan Number

Specific Use not recorded on Centralized Authorization File (CAF)?

Retention/revocation of tax information. This tax information authorization automatically revokes all prior autharizations for the same tax matters listed unless
you selected "Yes" for "Specific Use not recorded on Centralized Authorization File (CAF)" or select "Yes" for "Retain a prior tax information authorization”. (You
must attach a copy of any authorization you want to remain in effect.)

Retain prior a tax information authorization?

v v

v v

Figure 274: Tax Authorization (8821)

2. Enter the Borrower EIN if applicable.
3. Enter the Borrower Plan Number.
4. Select Yes or No appropriately for Centralized Authorization File (CAF) question.
5. Select Yes or No appropriately for prior tax information authorization question.
6. Repeat Steps 1 - 5 for co-borrower if applicable.
Designees

Use the following sections to complete Borrower/Co-Borrower Designees.
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Add Designees

1. Click the Borrower Designees Add button.

DESIGNEES ©  DESIGNEES [+

TAX MATTERS ©  TAXMATTERS o

Figure 275: Designees and Tax Matters

2. Complete the Designee Name fields.

Add Designee X

First
Middle
Last
Suffix
Address
Unit Designator v Number
City
State/Province W
Postal Code
CAF Number
PTIN
Telephone ) R

Fax N

Send copies of notices and
communications 5

Figure 276:Add Designee Dialog

3. Complete the Designee Address fields.
Note: Entering Postal Code populates the City & State/Province.
Enter Designee CAF Number.
Enter Designee PTIN.
Enter Designee Telephone.
Enter Designee Fax.
Select the appropriate checkboxes.
Click Save & Close.
Note: Click Save & New to add another Designee.

© ®© N o o A

10. Repeat Steps 1 - g for co-borrower if applicable.
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Edit Designees
Use the following steps to edit a designee.
1. Click the Designee to edit. (See Figure 271)

2. Update the designee details on the Edit Designee dialog. (See Add Designees for
details.)

3. Click Save & Close.

Delete Designees

1. Click the Delete icon. (See Figure 271.)

2. Click Delete on the Delete Confirmation dialog.
Tax Matters

Use the following steps for borrower/co-borrower Tax Matters information.

Add Tax Matters
Use the following steps to add additional tax information.

1. Click the Borrower Tax Matters Add button. (See Figure 271)
2. Enter Type of Tax.

Add Tax Matters 5

Type of Tax
Tax Form Number
Year(s) or Period(s)

Specific Tax Matters

Figure 277:Add Tax Matters Dialog

Enter Tax Form Number.

Enter Year(s) or Period(s).

Enter Specific Tax Matters.

Click Save & Close.

Note: Click Save & New to add other Tax Matters.

o 0~ W

7. Repeat Steps 1 - 6 for co-borrower if applicable.
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Edit Tax Matters
Use the following steps to edit tax matters.
1. Click the Tax Matters to edit. (See Figure 271.)

2. Edit the Designee as applicable. (See Add Tax Matters for details.)
3. Click Save & Close.

Delete Tax Matters
4. Click the Delete icon. (See Figure 271)

5. Click Delete on the Delete Confirmation dialog.

Title Commitment Request

Use this screen to add information for title commitment requests.

1. Enter the name and address of the requester.

Status  Application Processing Underwriting Reporting Documents Services  Settings

Loan 1D : 20221101000011 - Amy America Export Save
Credit Information
Tax Return Requests FROM PROPERTY AND MORTGAGE INFORMATION
rom Larry Lender, 1800 Maple St, Dallas, TX, 7¢ Homeowner Amy America
Verification/Certificatior
e SEpIe TIE TTC Homeowner phone | (123) 4567890
FHA
Affiliated Business
ATTACHMENTS SPECIAL INSTRUCTIONS

Figure 278: Request Title Commitment
Enter the name of the Title company.
Enter the name of the Homeowner.
Enter the homeowner's phone number.
Add any Attachments if applicable.
Enter the Type of Policy.
If needed, select the Mail Away option.

If needed, add Special Instructions.

© ® N O 0 A W N

Click Save. See Generate Processing Document List.

Verification Certification

The Verification Certification options enable printing forms to verify borrower/co-borrower
provided information. Verification must be completed for borrower and co-borrower.
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Verification of Benefits

Complete the Verification of Benefits (VOB) fields in preparation for printing.

Copy VOB
Copy VOB before adding other income.

1. Select the Processing tab.

2. Select Verification/Certification.

Status Application Processing Underwriting Reporting Documents Services Settings

Loan ID :20221101000011 - Amy America S
Credit Information O  AmyAmerica / Andy America - Primary

Ken N Customer Jr

Tax Return Requests

Title Commitment Request

BORROWER CO-BORROWER
FHA VERIFICATION OF BENEFITS L! ° VERIFICATION OF BENEFITS L. °
Affiliated Business
From
Title
VERIFICATION OF EMPLOYMENT r_.. ° VERIFICATION OF EMPLOYMENT L! °

From

Title

Figure 279: Verification/ Certification

3. Click the Borrower Copy Income button to copy the income from the application.

Copy Income X

Income Type Amount
Base 5,400.00
Miscellaneous Income 400.00

Copy & Close

Figure 280: Copy Income

4. Select Income Type form(s) to print on the Copy Income dialog.
5. Click Copy & Close.

6. Enter the form requestor name in From field. (See Figure 275.)
7. Enter form requestor Title.

Add VOB
Use the following steps to add a VOB.
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1. Click the Add button to add another income source. (See Figure 275.)

Add Verification of Benefits x

Company ACCOUNT VERIFICATION 0

Attention
Address
Unit Designator N Number
City
State/Province
Postal Code
Business Telephone (L)

Business Fax ) MO S

Print "SEE ATTACHED" in
signature box

Figure 281: Add Verification of Benefits

2. Complete the Add Verification of Benefits dialog fields.

3. Click Add to add another account for new income source.

Add Account Verification >

Account Type 4
Other Description
Account Owner
Account Number

Balance %

Figure 282: Add Account Verification Dialog

4. Complete the Add Account Verification dialog fields.

5. Click Save & Close on the Add Account Verification dialog.
Note: Click Save & New to add another account.

6. Click Save & Close on the Add Verification of Benefits dialog.
Note: Click Save & New to add another account.

7. Enter form requester name in From field.

8. Enter form requester Title.

9. Repeat Steps 1 - 8 for co-borrower.
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Edit VOB
Use the following steps to edit a VOB.
1. Select the VOB to Edit. (See Figure 275.)

2. Edit the VOB as applicable. (See Add VOB for details.)
3. Click Save & Close.

Delete VOB
Use the following steps to delete a VOB.

1. Select the Delete icon. (See Figure 275.)

2. Click Delete on the Delete Confirmation dialog.

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

181


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

™

calyx Zenly User Guide

Verification of Employment

Complete the Verification of Employment fields in preparation for printing.

Copy VOE
Copy VOE before adding another employer.
1. Click Copy Employer.

VERIFICATION OF EMPLOYMENT L[.j o VERIFICATION OF EMPLOYMENT r_l;] o

From

Title

Figure 283: Verification of Employment

2. Select Employment Verification form(s) to print.

Copy Employer X

Company Name Employment Status

Aardvark Current

Copy & Close

Figure 284: Copy Employer Dialog

3. Click Copy & Close.
4. Enter form requester name in From field. (See Figure 279.)
5. Enter form requester Title.

Add VOE
Use the following steps to add employment.

1. Click the Add button to add another employer. (See Figure 279.)
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2. Complete the Add Employment Verification dialog fields.

Add Employment Verification X

Method Standard v Employer
Company Title
Attention Contacted Date
Address Employment bt
Status
Unit Designator v Number
Ongoing bt
City Employment
State/Province v Employment Date B © E
Postal Code > Earnings | % Per R
Business ) 2. Position
Telephone
Ongoing &
Business Fax L) = Overtime/Bonuses
Confirmation e Ownership in v
Method Business
Other Description Ownership
Interest
-
"CEE ATTACLERT
e

Figure 285: Add Employment Verification Dialog

3. Select the Print “SEE ATTACHED" in sighature box checkbox to include the
statement on the verification form.

4. Click Save & Close to add the employment verification information.

Note: Click Save & New to add another employment verification.

Edit VOE

Use the following steps to edit employment.
1. Select the VOE to edit. (See Figure 279.)
2. Edit the VOE as applicable. (See Add VOE for details.)
3. Click Save & Close.

Delete VOE
Use the following steps to delete employment.

1. Select the VOE to Delete. (See Figure 279.)
2. Click Delete on the Delete Confirmation dialog.

Verification of Deposit

Complete the Verification of Deposit fields in preparation for printing.
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Copy VOD
Copy VOD before adding other deposits.
1. Click Copy Assets.

VERIFICATION OF DEPOSIT

From

Title

Figure 286: Verification of Deposit

2. Select the Asset to copy.

Copy Asset b

Asset Type Company Amount
Savings Account Bay State Bank 25,000.00
Stock ABC123 Corp 57,000.00

Copy & Close

Figure 287: Copy Asset Dialog

3. Click Copy & Close.
4. Enter form requester name in From field. (See Figure 282.)

5. Enter form requester Title.

Add VOD
Use the following steps to add deposits.
1. Click the Add button to add another deposit. (See Figure 282.)
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2. Complete the Add Verification Deposit dialog fields.

Add Verification of Deposit x
Company ACCOUNT VERIFICATION o

Attention
Address
Unit Designator v Number
City
State/Province e
Postal Code
Business Telephone | () -

Business Fax [

Print "SEE ATTACHED" in signature box
Figure 288: Add Verification of Deposit Dialog

3. Select the Print “SEE ATTACHED" in sighature box checkbox to include the
statement on the verification form.

4. Click Add to complete another account for the new deposit company.

Add Account Verification x

Account Type ¥
Other Description
Account Owner
Account Number

Balance %

Figure 289: Add Account Verification Dialog

5. Complete the fields.

6. Click Save & Close on the Add Account Verification dialog.
Note: Click Save & New to add another deposit account.

7. Click Save & Close on the Add Verification of Deposit dialog.
Note: Click Save & New to add another deposit account.

8. Enter form requester name in From field. (See Figure 282)

9. Enter form requester Title.

Edit VOD

Use the following steps to edit deposits.
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1. Select the VOD to edit. (See Figure 282))
2. Edit the VOD as applicable. (See Add VOD for details.)
3. Click Save & Close.

Delete VOD

Use the following steps to delete a deposit.

1. Select the Delete icon. (See Figure 282))
2. Click Delete on the Delete Confirmation dialog.

Verification of Loan
Complete the Verification of Loan (VOL) fields in preparation for printing.

Copy Liabilities
1. Click Copy Liabilities.

VERIFICATION OF LOAN @ O

From

Title

Figure 290: Verification of Loan

2. Select Liability form(s) to print.

Copy Liabilities X

Company Account Number Amount

Copy & Close

Figure 291: Copy Liabilities Dialog

3. Click Copy & Close.
4. Enter form requester name in From field. (See Figure 286.)
5. Enter form requester Title.

Add VOL

Use the following steps to add VOL.
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1. Click Add to add another liability account. (See Figure 286.)
2. Complete the Add Loan Verification dialog fields.

Add Loan Verification X

Company ACCOUNT VERIFICATION [+

Attention
Address
Unit Designator ¥ Number
City
State/Province b4

Postal Code

Business Telephone -

Business Fax -

Print "SEE ATTACHED" in
signature box

Figure 292: Add Loan Verification Dialog

3. Select the Print “SEE ATTACHED" in signature box checkbox to include the
statement on the verification form.

Click Add to add another account to the new liability company.
Complete the Add Account Verification dialog fields.

Add Account Verification X

Loan Type
Account Owner
Account Number

Balance %

Figure 293: Add Account Verification Dialog

6. Click Save & Close on the Add Account Verification dialog.

Note: Click Save & New to add another liability account to the new liability company.
7. Click Save & Close on the Add Loan Verification dialog.

Note: Click Save & New to add another loan account.
8. Enter form requester name in From field. (See Figure 286.)

9. Enter form requester Title.
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Edit VOL

Use the following steps to edit a loan.
1. Select the VOL to edit. (See Figure 286.)
2. Editthe VOL as applicable. (See Copy Liabilities for details.)
3. Click Save & Close.

Delete VOL
Use the following steps to delete a loan.
1. Select the Delete icon. (See Figure 286.)

2. Click Delete on the Delete Confirmation dialog.
Verification of Mortgage and Rent

Complete the appropriate Verification of Mortgage and Rent (VOM/R) fields in preparation
for printing.
Rental Verification
Complete the Rental Verification fields if borrower/co-borrower currently rents.
1. Click Copy Rentals.

VERIFICATION OF MORTGAGE AND RENT w0 0 O

From

Title

Figure 294: Rental Verification

Note: Proceed to step 4 if borrower/co-borrower currently owns property.
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2. Select the Address checkbox.

Copy Rental X

Address

4321 CulDeSac Street

Property Address
¥321 CulDeSac Street

Someplace, MA 02723

Residence
Save & Close

IAmy America
Figure 295: Copy Rental Dialog

3. Click Save & Close.

4. Click Copy REOs when borrower/co-borrower currently owns property.
5. Select the Address checkbox.

Copy REO X

Address Property Address 4321 CulDeSac Street

4321 CulDeSac Street Someplace, MA 02723

Account Number

Save & Close

Figure 296: Copy REOs

6. Click Save & Close.
7. Enter requestor name in From field. (See Figure 290.)
8. Enter requestor Title.

Note: Use the Delete icon to remove table items.

Mortgage Verification

Complete the Mortgage Verification fields if borrower/co-borrower currently falls into the
Real Estate Owned (REO) category.

1. Click Copy REOs. (See Figure 290.)
2. Select the Address checkbox.
3. Click Save & Close.
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4. Complete the From and Title fields. (See Figure 290.)

Note: Use the Delete icon to remove table items.

Add Mortgage or Rent Account
Use the Add button to add the mortgage or rent details to the Property List if not present.
1. Click the Add button. (See Figure 290.)

2. Complete the Add Mortgage or Rent Verification dialog fields to verify landlord or
mortgage holder details.

Add Mortgage or Rent Verification G

Landlord or Mortgagee Property Type ~
Attention Other Description
Address Address

Unit Designator dd Number Unit Designator o Number

City City

State/Province v State/Province b
Postal Code - Postal Code
Business Phone | P T Account Owner

Business Fax | ST

Print "SEE ATTACHED" in signature box ~ Account Number

Figure 297: Add Mortgage or Rent Verification
3. Click Save & Close.

Note: Click Save & New to add another mortgage or rent verification.

4. Complete the From and Title fields. (See Figure 290.)

Edit VOM/R

Use the following steps to edit mortgage/rent.
1. Select the VOM/R to edit. (See Figure 290.)
2. Edit the VOMZ/R as applicable. (See Add Mortgage or Rent Account for details.)
3. Click Save & Close.

Delete VOM/R
Use the following steps to delete a mortgage/rent.

1. Select the Delete icon. (See Figure 290.)

2. Click Delete on the Delete Confirmation dialog.
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Social Security Number Verification (SSA-89)

Complete the Social Security Number Verification (SSA-89) fields to verify the social
security number matches the borrower/co-borrower providing the documentation.

1. Enter Information Released for the Business Transaction details.

SOCIAL SECURITY NUMBER VERIFICATION (S5A-89)

Information released for the following business transaction

REASON FOR AUTHORIZING CONSENT REASON FOR AUTHORIZING CONSENT

Authorization Reason

Other Description

e Authorization Reason ™

Other Description

Return To:

Name

Company

Address

Unit Designator

City

State/Province

Postal Code

Telephone Number

~ Number

N oo~ w D

Figure 298: Social Security Number Verification

Select the Borrower Reason for Authorizing Consent.

Enter Other Description when selecting Other as the reason.
Repeat Steps 2 - 3 if applicable.

Enter the recipient Name for the returned SSA-89.

Enter the recipient Address Information.

Enter recipient Telephone Number.

VA Verification and Certification

Complete the VA Verification and Certification details to verify the borrower/co-borrower

VA benefits.
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1. Enter the borrower VA Claim Number.

VA VERIFICATION OF BENEFITS

VA Claim Number VA Claim Number

Do you have a VA benefit-related indebtedness?

~ ~

Have you filed a claim for VA disability benefits prior to discharge from active duty service?

~ ~

Figure 299: VA Verification of Benefits
2. Select the appropriate VA benefit-related indebtedness option.

3. Select the appropriate VA disability benefits prior to discharge from active duty
service option.

4. Complete the Certification of Eligibility and Status options.

VA CERTIFICATION OF ELIGIBILITY AND STATUS

Were you discharged, retired, or separated from service because of disability?

w W

Are you currently on active duty?

w ~

Are you a Purple Heart recipient?

W v

Figure 300: VA Certification of Eligibility & Status

5. Repeat Steps 1 - 4 for co-borrower.
Military Service

Complete the Military Verification and Certification details to verify the borrower/co-
borrower military benefits.

1. Click the borrower Add button.

~ v

MILITARY SERVICE o MILITARY SERVICE

ELIGIBILITY ELIGIBILITY

Purchase A Home

Were vou on active military duty the day following the date of separation?

Figure 301: Military Service
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2. Complete the Add Military Service dialog fields.

Add Military Service X

Duty Type

Branch

Enlistment Date

Discharge Date

Career Path

Document |dentification Number

Enlisted Under Different Name

Enlisted Name

Figure 302: Add Military Service Dialog

3. Click Save & Close.

Note: Click Save & New to add additional military service.

Indicate How You Will Use Your Certificate of Eligibility

Use this section to indicate how the Certificate of Eligibility will be used for either the

borrower or the co-borrower.
1. Click on the Select button.

ELIGIBILITY

ELIGIBILITY

INDICATE HOW YOU WILL USE YOUR CERTIFICATE OF INDICATE HOW YOU WILL USE YOUR CERTIFICATE OF

Figure 303: Certificate of Eligibility Indicator

2. Select the desired options.

Use of Certificate X

] Entitlement Inquiry Only

D Purchase A Home
D Cash-Out Refinance

B Interest Rate Reduction
Refinance Loan

Save & Close

Figure 304: Use of Certificate
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3. Click Save & Close.
4. Complete the Military Service options.
MILITARY SERVICE o MILITARY SERVICE o

INDICATE HOW YOU WILL
ELIGIBILITY

USE YOUR CERTIFICATE OF INDICATE HOW YOU WILL USE YOUR CERTIFICATE OF
ELIGIBILITY

Purchase A Home

Were you on active military dut

v

Have you used the VA Home Lo

v

Do you still own any of the hom

v

the day following the date of separation?

bn program before?

Es you used the VA Home Loan Program for?

Figure 305: Military Service Options

4. Repeat Steps 1 - 4 for co-borrower.

VA Property Address

The VA Property Address options are available when Yes is selected for the borrower or co-
borrower questions: Have you used the VA Home Loan program before?, Do you still own any
of the homes you used the VA Home Loan Program for?. See Figure 301.

1. If applicable, use the Copy REO ® button to auto-populate property information.

2. Select the desired Address.

Address

1234 Ocean Pines 823

Property Address 4321 Cul de Sac S5t
44
Someplace, MA 02723

(]  4321CuldeSacSt44

Account Number

Save & Close

Figure 306: Copy REO (VA Property Address)

3. Click Save & Close.
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4. Click the VA Property Address Add button.

Do you still own any of the homes you used the VA Home Loan Program for?

v v

VA PROPERTY ADDRESS L! o VA PROPERTY ADDRESS

]

Wdailing Addeecs for Contification of Eliginilin

Send To: ~ Send To: v
Address Address
Unit Designator i Number Unit Designator e Number

Figure 307: Add VA Property Address
5. Complete the Add VA Property dialog fields.

Add VA Property X

Property Type ~
Address
Unit Designator ~ Number
City
State/Province v
Postal Code

Loan Number
: VA Property Damaged by Disaster

Loan Start Date ::

Date of Loss =

Figure 308: Add VA Property Dialog

6. Click Save & Close.
Note: Click Save & New to add another property.
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7. Enter the Mailing Address details for the returned Certification of Eligibility.

VA PROPERTY ADDRESS L. O VA PROPERTY ADDRESS L! O

Mailing Address for Certification of Eligibility

Send To: e Send To v
Address Address
Unit Designator i Number Unit Designator v Number
City City
State/Province v State/Province
Postal Code B Postal Code

Remarks (if any)

pa Vs

Figure 309: Certification of Eligibility Address
8. If needed, add any Remarks.
9. Repeat Steps 1 - 4 for Co-borrower.

FHA

Complete the FHA options for FHA loans.

FHA/VA Loan Purpose

Complete the FHA/VA Loan Purpose section for an FHA or VA loan.

1. Select the Processing tab.
2. Select FHA.

Status  Application Processing Underwriting Reporting Documents Services Settings

Loan ID : 20221101000011 - Amy America
Credi Information

Ken N Customer Jr

Tax Return Requests

Title Commitment Request

Verification/Certification Section of the Act v FHA Assignment Date o
Affiliated Business
FHA/VA LOAN PURPOSE

ADDENDUM TO UNIFORM RESIDENTIAL LOAN APPLICATION (HUD-92900-A)

Figure 310: FHA/VA Loan Purpose
3. Select the appropriate Section of the Act option.
4. Use the Calendar to select the FHA Assignment Date.

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

196


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

™

calyx Zenly User Guide

5. Click the Select button.
6. Select the FHA/VA Loan Purpose from the dropdown.

FHA/VA Loan Purpose X

FHA/VA h
FHA
Streamline with Build on own
Appraisal Land
Streamline without HUD REO
Appraisal 203(k)
Energy Efficient
Mortgage
Save & Close

Figure 311: FHA/VA Loan Purpose Dialog
7. Select applicable checkboxes.
8. Click Save & Close to add to the FHA/VA Loan Purpose table.

cection of the Act | 2038251 o FHA Assignment Date  01/05/2023

FHA/VA LOAN PURPOSE

Purchase Existing Home (Previously Occupied)

Streamline with Appraisal
Streamline without Appraisal
Energy Efficient Mortgage
Build on own Land

HUD REO

203(k)

Figure 312: FHA/VA Loan Purpose Table
Addendum to Uniform Residential Loan Application

Complete the HUD-92900-A fields for an FHA or VA loan.
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1. Select the appropriate (VA) Title Vested in option.

ADDENDUM TO UNIFORM RESIDENTIAL LOAN APPLICATION (HUD-92900-A)

(VA) Title Vested in v

Other Description

Do you own or have sold other real estate within the past 60 months in which was a HUD/FHA mortgage?

~

Is it to be sold?

v

Address Sale Price %
Unit ™ Number Original &
Designator Mortgage
City
State/Province v
Postal Code

Figure 313: HUD-92900-A
Enter Other Description when selecting other as the (VA) Title Vested in option.
Select the appropriate HUD/FHA mortgage option.
Select the appropriate To be sold option.
Complete the To Be Sold fields when selecting Yes.

oA W N

Complete the remaining HUD-92900-A fields appropriately.

If the dwelling to be covered by this mortgage is to be rented, is it a part of, adjacent or contiguous to any project subdivision or
group of concentrated rental properties involving eight or more dwelling units in which you have any financial interest?

v

Have you ever had a VA home Loan?

~

Will the Borrower or Co-Borrower occupy the property within 60 days of signing the security instrument, and intend to continue
occupancy for at least one year?

~

Property Value &

Property value derived from:

The reasonable value of the property as determined by VA
The Statement of appraised value as determined by HUD FHA

Note: If the contract price or cost exceeds the VA "Reasonable Value" or HUD/FHA "Statement of Appraised Value", mark either item
(a) or item (b), whichever is applicable.

(a) I was aware of this valuation when | signed my contract and | have paid or will pay in cash from my own resources
at or prior to loan closing a sum equal to the difference between the contract purchase price or cost and the VA or
HUD/FHA established value. | do not and will not have outstanding after loan closing any unpaid contractual
obligation on account of such cash payment.

Figure 314: HUD-92900-A Fields
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Property Improvements (HUD-56001)

Complete the Property Improvements sections if appropriate.

1. Select the appropriate answers for HUD-56001 options.

PROPERTY IMPROVEMENTS (HUD-56001)

Do you have any past due obligations owned to or insured by any agency of the Federal Government?

v
Do you have any other applications for an FHA Title | loan pending at this time?

~ With whom?
Are you refinancing a Title | loan?

~ Loan Number Current Balance %

If this is a new residential structure, has it been completed and occupied for 90 days or longer?

v

Figure 315: HUD-56001 Options
2. Click the Property to be Improved Select button.

PROPERTY TO BE IMPROVED ﬁ

Owned by Borrower
Leased from someone else

Being Purchased on contract

Mortgage or Deed of Trust on Property

Figure 316: Select Property to be Improved
3. Select the appropriate checkboxes on the Property to be Improved dialog.

Property to be Improved X

Single family
Multifamily
Number of Units

Nonresidential
Type of Use

Manufactured Home (not classed as realty)
Historic Residential Structure

Number of Units

Health Care Facility

Save & Close

Figure 317: Property to be Improved Dialog

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

199


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

v

calyx Zenly User Guide

4. Click Save & Close.
5. Select the applicable radio button.

PROPERTY TO BE IMPROVED

Owned by Borrower

Leased from someone else

Being Purchased on contract

Mortgage or Deed of Trust on Property

Figure 318: Property to be Improved Options
6. Select the Mortgage or Deed of Trust on Property checkbox if appropriate.

Mortgage or Deed of Trust on Property

Property Lease $
Owner Payment

Address Lease [E]
Expiration
Unit R Number
Designator
City

State/Province i

Postal Code

Figure 319: Mortgage or Deed of Trust Details
7. Complete the Mortgage or Deed of Trust details.

Bank Accounts

The displayed borrower/co-borrower Bank Account information is transferred from Assets
List on the Application Borrower screen.
Note: Separate processing forms are required for each account.

1. Select the Account Type to process for printing.
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2. Enter missing borrower Bank Account details.

BORROWER BANK ACCOUNT CO-BORROWER BANK ACCOUNT

Account Type b Account Type e
Company Name Company Name
Address Address

Unit Designator e Number Unit Designator e Number

City City

State/Province M State/Province ~

Postal Code . Postal Code .

Figure 320: Bank Account Details

3. Enter the co-borrower Bank Account details.
DE Statement of Appraised Value (HUD-92800.5B)

Complete the HUD-92800.5B fields to process the Direct Endorsement (DE) Statement of
Appraised Value form for printing.

1. Select the Conditional Commitment to Mortgage Insurance checkbox when
appropriate.

DE STATEMENT OF APPRAISED VALUE (HUD-92800.5B)

Conditional Commitment for Mortgage Insurance under the National
Housing Act. Section

See Below
By Commitment |
Issued
Action Date E
Commitment [E]
INST Case Ref. No. Expired
Construction v Improved Living Sq
Status Area Ft.

Figure 321: HUD-92800.5B Options

2. Select the See Below checkbox to mark the See Below checkbox on the printed
HUD-92800.5B form.

Note: The See Below form checkbox indicates additional form fields to complete.
3. Enter the appraiser's name in the By field.

4. Use the Calendars to enter the appropriate appraisal dates.
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5. Enter the assigned lender case number in the INST Case Ref. No. field.
6. Enter the home square footage value in the Improved Living Area field.
7. Select the appropriate Construction Status.
8. Complete the remaining selections.

Estimated remaining economic life of the property?

years

Eligible for Maximum Financing?

v

Assurance of Completion?

v If the required repairs can't be completed before closing, HUD-92300 k2
made in the amount of may be established as the means to ensure
completion

See additional items on attached?

v

See additional conditions on the back?

v

Figure 322: HUD-92800.5B Selections

9. Click Select to review the Condition Statements entered on the Underwriting
Conditions screen. (See Underwriting for details.)

10. Select the Conditions to include on the form.

Description

Condition Example 1

Condition Example 2

Save & Close

Figure 323: Conditions Dialog

11. Click Save & Close.
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Energy-Efficient Mortgage Fact Sheet

Enter the Maximum Mortgage Amount value in preparation for printing the FHA Energy
Efficient Mortgage Fact Sheet.

ENERGY-EFFICIENT MORTGAGE FACT SHEET

Maximum mortgage amount for a single-family unit 5 plus the cost of the eligible energy-efficient
is

improvements.

Figure 324: Energy-Efficient Mortgage Fact Sheet
Housing Counseling Lender Certification of Completion

Complete the fields in preparation for printing the verification of Housing Counseling form.

1. Select the appropriate Delivery Method party.

HOUSING COUNSELING LENDER CERTIFICATION OF COMPLETION

Delivery Method A

Training Format hd

Figure 325: Counseling Cert. of Completion

2. Select the appropriate Training Format.

Affiliated Business

Complete this screen if there are any business relationships with service provider(s) that
offer services for the loan.
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Option A
1. Select option A if services are NOT required to be used.
Status Application Processing Underwriting Reporting Documents Services Settings
[ovor [ e |

Loan ID :20221101000011 - Amy America

Credit Information A. Set forth below is the estimated charge or range of charges for the settlement services listed. You are not required to use the listed
provider(s) as a condition for
TaxReturn Requests settlement of your loan on [or]

Title Commitment Request purchase, sale, or refinance of the subject property.

Verification/Certification SERVICES NOT REQUIRED °
FHA
Affiliated Business B. Set Forth below is the estimated charge or range of charges for the settlement services of an attorney, credit reporting agency, or real

[ estate appraiser that we, as your lender, will require you to use, as a condition of your loan on this property to represent our interests in
the transaction.

SERVICES REQUIRED [(+)

Figure 326: Affiliated Business

2. Select the appropriate condition.
3. Click on the Add button to list any affiliated business.

Add Service Provider X

Settlement Service SERVICES o
Provider
Nature of the and percentage of
Relationship ownership interest

~

Figure 327: Add Service Provider

4. Enter the Settlement Service Provider.
5. Enter the Nature of the Relationship.
6. Click the Add button to list the service(s).

Add Service X

Settlement Service

Charge or Range of Charges

Figure 328: Add Service

7. Enter the Settlement Service.
8. Enter the Charge or Range of Charges.
9. Select Save & Close or Save & New for both the Service and the provider screens.
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Option B

1. Select option B if a service is required to be used.
2. Click the Add button to list any affiliated businesses.
3. Repeat Option A steps 4-10 to list any affiliated businesses.

Underwriting

Complete the required fields in preparation for printing the Uniform Underwriting and
Transmittal Summary form and Property Conditions form.

Transmittal Summary

Many of the Underwriting Transmittal screen fields are auto populated and non-editable.

Status  Application  Processing Underwriting Reporting Documents  Services  Settings
Loan ID : 20221101000011 - Amy America save |

Transmittal Summary RATIOS

Conditions Base LTV 59.619 % Total LTV 59.619 %

Notice of Action Taken
Base CLTV 59.619 % Total CLTV 59.619 %

Base HCLTV 50.619% Total HCLTV 59.619%
Housing Expense 17.588 % Debt-to-Housing Gap 3.768%

Debt-to-Income 21.356 % Present Housing Payment $ 0.00

Figure 329: Transmittal Summary

Note: The Ratios, Stable Monthly Income, and Total Monthly Payments tables are auto
populated.

Project Classification

The Project Classification fields are displayed on the Project Classification section of the
Uniform Underwriting and Transmittal Summary form for Freddie Mac or Fannie Mae
submittals.

1. Select the Freddie Mac option if appropriate.

PROJECT CLASSIFICATION

Freddie Mac hd Project Name

Fannie Mae v CPM Identification

Figure 330: Project Classification
2. Select Fannie Mae option if appropriate.

3. Enter the assigned Project Name.
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4. Enter the Constant Payment Mortgage (CPM) Identification number.
Qualifying Ratios

Complete the fields for the Uniform Underwriting and Transmittal Summary form Qualifying
Ratios fields.

1. Enter the Qualifying Interest Rate.

QUALIFYING RATIOS

Qualifying Rate
® Note Rate 5250 %
Above Note
Rate

Below Note
Rate

Bought Down
Rate

Other

Figure 331: Qualifying Ratios
2. Select the Note Rate radio button if appropriate.
3. Enter the Note Rate.

Risk Management

Complete the fields for the Uniform Underwriting and Transmittal Summary form Risk
Assessment fields.

1. Select the Underwriting Method option.

RISK MANAGEMENT

Underwriting Method hd
Other Description
AUS Recommendation
AUS Identification
LP DOC Class

Credit/Indicator Score

Figure 332: Risk Management

2. Enter Other Description when selecting Other from the Underwriting Method
dropdown.
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3. Enter the Automated Underwriting System (AUS) Recommendation.
4. Enter the AUS identifier in the AUS Identification field.
5. Enter the Loan Prospector (LP) document class in the LP DOC Class field.
6. Enter the Credit/Indicator Score.

Escrow Account and Funds to Close

Complete the fields for the Uniform Underwriting and Transmittal Summary form Escrow and
Borrower Funds to Close fields.

1. Select the appropriate Escrow Account radio button.
ESCROW ACCOUNT FUNDS TO CLOSE
Will have an Escrow Account Funds Required | &
Your Loan will not have an Escrow account Verified Assets N
Source
Months in Reserve
Interested Party Contribution
Figure 333: Escrow Account and Funds to Close
2. Enter the Funds Required amount.
3. Enter the Verified Assets amount.
4. Enter the verified assets Source.
5. Enter the total Months in Reserve.
6. Enter the Interested Party Contribution percentage.

Mortgage Originator and Level of Property

Use the following steps to complete the Mortgage Originator/Level of Property sections.
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1. Select the Mortgage Originator from the dropdown.
MORTGAGE ORIGINATOR LEVEL OF PROPERTY REVIEW
Mortgage Originator Property Review Level hd
Contact Form Number hd

Company

Other Description

Community Lending/Affordable Housing Initiative?

v

Homebuyer/Homeownership Education on File?

v

Underwriting Comments

Figure 334: Mortgage Originator/Level of Property

© ® N OO A WD

10. Click Save.

Enter the Mortgage Contact name.

Enter the Mortgage Company name.

Select the Property Review Level from the dropdown.

Enter the Form Number from the dropdown.

Enter Other Description if selecting Other from Form Number option.
Select Yes or No for Community Lending/ Affordable Housing Initiative?
Select Yes or No for Homebuyer/Homeownership Education on File?

Enter Underwriting Comments if applicable.

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com

© Calyx Technology, Inc. 1991-2024. All rights reserved.

208


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

™

calyx Zenly User Guide

Conditions

Add an Underwriting condition by selecting the Add button.

Status  Application  Processing  Underwriting = Reporting Documents Services  Settings

Loan ID :20221101000011 - Amy America Export Save

Transmittal Summary CONDITIONS o

Due By Condition Type Description Satisfied/Waived

Notice of Action Taken

Investor Satisfied W

Figure 335: Conditions
Adding Conditions

To add an Underwriting condition:
1. Select the Add © button.
2. Add a Description to the Condition.

Add Condition X

Description
%
Due = Issued Date 03092023 [E]
Satisfied/Waived e Issued By
Type
Received Date &
Condition Type v
Received By
Other Description
Satisfied/Waived E
Responsible Party v Date
Qther Description Satisfied/Waived By
DOCUMENT V2 +
Borrower Document Name Stored Date

Figure 336: Add Condition

Enter the desired information in the fields on the Add Condition dialog.
If needed, select the paper clip icon to link stored documents.

If needed, select the upload icon to upload a PDF.

o o0 A~ W

Select the Save & Close button to complete the Condition.
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Notice of Action Taken

The Notice of Action Taken allows the user to generate an action notice.

Status  Application  Processing  Underwriting  Reporting Documents  Services  Settings

Loan ID : 20221101000011 - Amy America [ Export || save
Transmittal Summary O  AmyAmerica / Andy America - Primary
Conditions Ken N Customer Jr
Notice of Action Taken
Action Notice v Action Date 2]
Delivery Method v Denied Date 8

Prepared By Counter Offer Date

Notice Detail

Thank you for your application for:

Mortgage Loan Request

Figure 337: Notice of Action Taken
To fill out the notice:

=

Select the Action Notice dropdown and select an appropriate option.
Select a Delivery Method for the dropdown menu.

Enter who the notice was Prepared By.

Select an Action Date.

If the Credit Denial action was selected, add a Denied Date.

If the Counter Offer action was selected, add the Counter Offer Date.

If the Incomplete Application was selected, add Provide Missing Information By
date.

N oo A w WD

8. Type a Notice Detail to explain in-depth the reason for the notice.
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0.

If needed, select the If checked... checkbox.

Note: The If checked.. checkbox only applies to the Counter Offer Action.

If checked, our principal reasons for denying your original request are indicated below

PART | - PRINCIPAL REASON(S) FOR CREDIT DENIAL, TERMINATION, OR OTHER ACTION TAKEN o
CONCERNING CREDIT

PART Il - DISCLOSURE OF USE OF INFORMATION OBTAINED FROM AN OUTSIDE SOURCE

Information obtained in a report from a consumer reporting agency

&
BORROWER CO-BORROWER

CREDIT INFORMATION CREDIT INFORMATION

ﬂ

Score Date Score Date
Inquiries Inquiries
Credit Score Credit Score

Range of Scores To Range of Scores To

Figure 338: Principal Reasons of Action

Add Reasons of Denial

For Part 1 - Principal Reason(s) for Credit Denial, Termination, or Other Action Taken, to add a

reason:

1

ok w D

Click on the Add button.

Add Reasons for Denial >l

Section Credit v
Denial Type v

Other Description

Figure 339: Add Reason of Denial

Click on the Section dropdown menu and select the desired option.
Click on the Denial Type dropdown menu and select the desired option.
If Other was selected, enter a description in the Other Description field.
Select Save & Close.
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Part Il

Select the check box if the information was obtained in a report from a consumer Reporting
agency.

Credit Information

1. If needed, click the Copy Credit Information button for Borrower and/or Co-
Borrower.

OR

2. Enter the Borrower’s and, or Co-Borrower’s Credit Information manually.

Factors

To add Factors:
1. Click on the Add button.

Add Factor > ¢

Code

Description

Figure 340: Factors

2. Enter a Code and a Description.
3. Click the Save & Close or the Save & New button.

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

212


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

v

calyx Zenly User Guide

Credit Agency

Enter the Credit Agency information and select the checkboxes if the credit information was
obtained externally and/or if adding additional information. Click Save when this section is
complete.

CREDIT AGENCY

Information obtained from outside sources other than
a consumer reporting agency. You have the right to

Credit Agency

Address request, in writing, a disclosure of the nature of this
information
Unit Designator v Number Additional Statement
City
State/Province v
Postal Code
Phone (-

Figure 341: Credit Agency

Reporting

Use the Reporting screens for setting the information that will appear on the yearly Home
Mortgage Disclosure Act (HMDA) Report.

Mortgage Call Report 2024

The Mortgage Call Report 2024 (MCR) screen allows the user to enter loan origination
information required for the NMLS (Nationwide Mortgage Licensing System). The Reporting
tab is hidden by default for new users. Ensure to enable the tab in the User Information
screen. See Add User.

Status  Application Processing  Underwriting  Reporting =~ Documents  Services  Settings

Loan ID : 2022110100001 - Amy America ((eporn J(sae |
Mortgage Call Report 2024 -
Business Channel v Current Status Date  11/01/2022 11:36 AM ::JC)
HMDA
Servicing has been v Application Date ~ 01/05/2019 12:00 AM
[[J Exclude Loan from NMLS Report Closed Date  11/07/2022 12:00 AM e
() Report as a HOEPA loan
@ ORIGINATION INFORMATION @ LOAN INFORMATION
Type of Purchaser v Loan Amount 250,400.00
Action Taken v LoanType VA v
Action Taken Date MO Loan Purpose v
Lien Position v
Occupancy Primary Residence v
QM Report Status e

Figure 342: Mortgage Call Report
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Select a Business Channel.

=

Use the Servicing has been dropdown menu to select a service status.
Select the Exclude Loan from NMLS Report if applicable.

Select the Report as a HOEPA loan checkbox if applicable.

If needed, change the Application Date.

oA W N

If needed, change the Closed Date.

Note: Setting a Closed Date will synch and update the Status in the Status > Tracking
screen.

Origination Information

1. Select the Type of Purchaser.
2. Select the Action Taken.

3. Choose when the Action was taken (Action Taken Date).
Loan Information

The information in this section is auto-populated from the Loan Application screen. Edit the
fields in this section if applicable.

Subject Property Information

This section is auto-populated from the Application > Subject Property screen. Edit fields if
applicable.

@ SUBJECT PROPERTY INFORMATION © LOAN ORIGINATOR INFORMATION
Address 1234 Ocean Pines Loan Originator
Unit Designator v Number = 823 NMLS License Number
City Rehobeth License
State/Province MD v Email
Postal Code 21857 N Phone
Property Type v

Figure 343: Subject Property/Loan Originator
Loan Originator Information

This section auto-populates the assigned Loan Originators information from the Status >
Contacts screen.
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Profit & Loss Information

Use this section to enter the Profit and loss information for the loan if applicable. If needed,

follow these steps for both tables.

1. Enter the Lender Comp. (compensation).

° PROFIT & LOSS INFORMATION

Origination Points & + Lender Comp

- Commisions Paid & 410.00 - Lender Charge

Origination Points & + Gain/Loss on Sale

- Commisions Paid % - Warehouse Costs

$

$

5

$

650.00 +Broker Charges % 500.00
53.00 - Other Costs % 100.00 = Net Profit & 587.00
+ Lender Charges &
- Other Costs $ = Net Profit & 0.00

Figure 344: Profit & Loss Information

Enter the Broker Charges.
Enter the Commissions Paid.

Enter the Lender Charge.

o oA W N

Select Save.

HMDA

If needed, enter Other Costs.

The HMDA screen contains application, undenwriting, and closing information for the
selected loan. Most screen fields are pre-populated with data entered on other Zenly

screens.

Select the Exclude Loan from HMDA Report checkbox to exclude the loan from the HMDA

Report.
1. Select HMDA

Loan ID:20221101000011 - Amy America

Mortgage Call Report 2024

HMDA

@ SUBJECT PROPERTY

Status  Application  Processing  Underwriting  Reporting ~ Documents  Services  Settings

DI-C03.v3.4

Address 1234 Ocean Pines

Figure 345: HMDA Application
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2. Select Application.
3. Select the Preapprovals option from the dropdown.
4. Enter the Legal Entity ID.
5. Enter the Non Universal Loan ID.
6. Select the Exclude Loan From HMDA Report checkbox to exclude the selected

loan from the yearly HMDA Report.

Note: The Universal Loan Information field is ungrayed for users that are operating as a
Broker. This functions the same for Loan Application screen.

7. Verify the following information:
e Subject Property
e Applicant
e Co-Applicant
e Applicant & Co-Applicant Ethnicity
e Applicant & Co-Gender
e Race
8. Click Save.
Underwriting (HMDA)
Most screen fields are pre-populated with data entered on other Zenly screens.
1. Select the Application Submission from the dropdown.
@ UNDERWRITING
Application Submission v Date ::§C
AUTOMATED UNDERWRITING o
REASONS FOR DENIAL 0
[ Disclosed using Notice of Action Taken
Figure 346: Underwriting (HMDA)
2. Select an Initially Payable option from the dropdown.
3. Select the Action Taken from the dropdown.
4. Select the Date.
5. Select the Purchaser Type from the dropdown.
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Automated Underwriting

Use the automated underwriting options to select the Automated Underwriting Service (AUS)
details.

Add AUS
1. Click the Automated Underwriting Add button to select the AUS options.

© AUTOMATED UNDERWRITING —0

Figure 347: Automated Underwriting Section

2. Select the Add Automated Underwriting system from the Type dropdown.

Add Automated Underwriting X

Type v
Other Description
Result 4

Other Description

Figure 348: Add Automated Underwriting Dialog

Note: Enter Other Description when selecting Other from Type dropdown.
3. Select the appropriate Result.

Note: Enter Other Description when selecting Other from Result dropdown.
4. Click Save & Close.

Edit AUS

Use the following steps to edit an AUS.
1. Select the AUS to edit. (See Figure 343.)
2. Edit the AUS as applicable. (See Add AUS for details.)
3. Click Save & Close.

Delete AUS
Use the following steps to delete an AUS.
1. Select the Delete icon. (See Figure 343.)
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2. Click Delete on the Delete Confirmation dialog.
Reason for Denial
Use the reason for denial to select the Reason for Denial Service (US) details.

Add Denial Reason

1. Click Reasons for Denial Add button to enter loan denial information.

REASONS FOR DENIAL [+
Date By Reason for Denial
02/01/2023 Credit history w

Disclosed using Notice of Action Taken

Figure 349: Reasons for Denial Section
2. Select the Denial Type option from the dropdown.
Note: The Date field auto populates.

Add Reasons for Denial X

Date | 02/02/2023
By
Denial Type v

Other Description

Figure 350: Add Reasons for Denial Dialog

Note: Enter Other Description when selecting Other from Denial Type dropdown.
3. Click Save & Close.
Note: Click Save & New to add another reason for denial.

4. Select the Disclosed using Notice of Action Taken checkbox if appropriate.

Edit Denial Reason

Use the following steps to edit denial reason.
1. Select the Denial Reason to edit. (See Figure 345.)
2. Edit the Denial Reason as applicable. (See Add Denial Reason for details.)
3. Click Save & Close.
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Delete Denial Reason
Use the following steps to delete a denial reason.

1. Select the Delete icon. (See Figure 345.)
2. Click Delete on the Delete Confirmation dialog.

Closing

Most screen fields are pre-populated with data entered on other Zenly screens.

1. Review the screen fields and add missing information.

@ cLosING
A
— Lien Status
Application Date 01/05/2019 12:00 AM |C j
CLTV Type Total CLTV
Closed Date 11/07/2022 12:00 AM [ fC j
Disclosed CLTV
Property Value 420,00000 [
APOR Date
Interest Rate 5250% [
. Disclosed APR
Annual Income O
J APOR
Loan Term 360 months [
Rate Spread
Intro Rate Period months O
Business/Commercial Purpose
Prepayment Period months [
Py J Open-End Line of Credit
Debt-to-Income 18860 % [ ]
Reverse Mortgage
Loan Type VA v
Interest Only Payment
Other Description
Balloon Payment
Loan Purnose  Cash-Out Refinancing v

No

No

No

59.619 %

Figure 351: Closing

2. Enter the Origination Charges in the Disclosed Fees section.

DISCLOSED FEES

=
5

Origination Charges 3
Discount Paints 3

Lender Credits i

Total Loan Costs $

Total Points and Fees $

Figure 352: Disclosed Fees

Enter the Discount Points.

Enter the Lender Credits.

Enter the Total Loan Cost.

Enter the Total Points and Fees.

N O o~ W

Check NA checkbox when applicable.
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Documents

The Documents screens provide management options for loan associated documents.

Stored

Generated documents are moved to the Stored page after clicking the Generate Store
button.

Document Search
Use the Document Search feature to quickly locate stored documents in a long list.

1. Select Documents.
2. Select Stored.

Status  Application  Processing  Underwriting  Reporting Documents Services  Settings

Loan ID :20221101000011 - Amy America Export Save l

ECHE | - a 4]

Generate

Request

eSign

Figure 353: Search Documents
3. Enter the Search criteria.

4. Press Enter.
Upload Documents

Upload locally saved documents.

File Types allowed:

o TXT e DOCX
e MSG e BMP
e PDF e RTF

e PNG e HTML
e JPEG e TIFF

e JPG e XML
e GIF

1. Click the Upload icon.
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Status  Application ~ Processing  Underwriting  Reporting Documents  Services  Settings

Loan ID :20221101000011 - Amy America

»
Search Q b
Generate /

Request

e

eSign

Figure 354: Upload Documents
2. Enter the Document Name.

Upload X

Document Name Prepared Date
Borrower ¥ Package Name
Category ~ Stored Date

Choose File  No file chosen

] o

Figure 355: Upload Dialog

Select the appropriate Borrower when the document is received from a borrower.
Select the appropriate document type from the Category dropdown.

Click Choose File.

Use the Calendar to select the Prepared Date.

Enter the Package Name if the document is part of a package.

Use the Calendar to select the Stored Date if applicable.

Browse to the file location and upload.

10. Click Store.

© ©® N OO0 N~ W

View Documents

View stored documents for accuracy and details in the Zenly application prior to download.
The document opens in PDF when PDF is installed on the computer.

1. Select the View icon for the document to view.

Loan ID : 20220307000011 - Andy America Export m
»

2 b
Generate
Request

ALL OTHER DOCUMENTS
esign

Borrower Document Name Stored Date Stored By \

Andy America Borrower Signature Auth... 02/01/2023 11:18 AM =N . RO

Figure 356: View Document
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Note: The document opens in a Browser window.
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2. Perform one of the following for the open document.

— > 0O

X @ Zenly X | [ 3aae978d-0c52-4570-b1d3-03b¢ X | +

o] https://s3-us-west-2.amazonaws.com/storage.pacesa/deal/e8b25ca7-d867-4568-96b9-9e5fadf34556/Documents/binar... ¥ =

- 4+ @ | A) Readaloud | ¥ Draw v & Highlig

ht v & Frase | B

ABC Mortgage | Originator: John Done

Borrower Signature Authorization

Privacy Act Notice: Ths infomation is to be used by the agsncy collecting It o fs asslanses i determining whether you aualfy as a prospective morlgagor under
is program. It wil not be disclosed outside the agency except as required and permited by law. You do nol have to provids this inormation, but i vou do ot your
appicaton Tor approval 25 a prospective mortgager of botower My be delayed or rejected. The Information requestd in fis form 13 auhorized by Tl 38, USC,

Chapter 37 (1 VAY by 12 USE, Secion 1701 s seq. (I HUDIFHAY, by 42 USC, Secton 14525 (1 HUDICPD), and Te 42 USG, 1471 et. seq, or 7 USG, 1621 e,
seq. (if USDATFmHA).

Part | - General Information

1. Borrower
Elizabeth E Spender
7054 Cannan Center Rd
‘Wooster, OH 44691-1234

2. Name and address of Lender/Broker

3.Date 4. Loan Number
11/06/2020 DI-C06
Partl - A 1

| hereby authorize the Lender/Broker to verify my past and present employment earnings records, bank accounts, stock
holdings, and any other asset balances that are needed to process my mortgage loan application. | further authorize
the Lender/Broker to order a consumer credit report and verify other credit information, including past and present
mortgage and landlord references. It is understood that a copy of this form will also serve as authorization.

Borrower  Elizabeth E Spender Date

The information the Lender/Broker obtains is only to be used in the processing of my application for a mortgage loan.

Figure 357: Document Browser View

3. Click Save to save the document locally.

4. Click Print to print the document.

Download Documents

Download multiple documents to perform batch printing.

1. Click the Download icon.

Generate
Request

eSign

Loan ID : 20220307000011 - Andy America

Search Q

ALL OTHER DOCUMENTS

[ Export H Save J

[N
Borrower Document Name Stored Date Stored By
Andy America Borrower Signature Auth... 02/01/2023 11:18 AM BEO
Andy America Bank Statements 02/01/2023 12:52 PM

BB

Figure 358: Download Document
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2. Click Open File to view the document.

Borrower Signature....pdf
Open file

Figure 359: Open File

Generate

Generate the files created on the following screens:

e Application
e Processing
e Underwriting

Generated documents display with a DRAFT watermark. Save them to Storage to remove
the watermark in preparation for printing.

Generate Application

Use the following steps to generate the Loan Application.
1. Select Document.
2. Select Generate.

Status  Application  Processing  Underwriting  Reporting Documents  Services  Settings

Loan ID : 20221101000011 - Amy America

Stored BORROWERSET (PRINTS ON FORM)
O  AmyAmerica/ Andy America - Primary
Ken N CustomerJr
Request

esign

DOCUMENT SELECTION LIST SELECTED DOCUMENTS

Filtered by Application v Date Prepared 12/14/2023 &

APPLICATION

Document

Anti-Steering Disclosure

Borrower Signature Authorization (Bor)
Borrower Signature Authorization (Co-Bor)
Borrower Signature Authorization (joint)

Borrower's Acknowledgement of Disclosures

Borrowers' Certificate of Authorization

Figure 360: Generate Application
3. Select the Borrower radio button.

4. Select Application from the dropdown.
5. Enter Date Prepared.
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6. Select the documents from the Application List to store for loan application
submittal.

7. Click Store.

Set Package

Package Name \ ‘

Figure 361: Set Package

8. Enter the Package Name when prompted.

9. Click Set. View document in the using the Document > Stored menu option.
Generate Processing Document List

Use the following steps to generate the processing document list.
1. Select the appropriate borrower radio button. (See Figure 356.)
2. Select the Processing from the dropdown.
3. Enter Date Prepared.
4. Select the processing documents to generate.
5.

Click Store. View document in the using the Document > Stored menu option.
Generate Underwriting Documents

Use the following steps to generate the processing document list.
1. Select the appropriate borrower radio button. (See Figure 356.)
2. Select the Underwriting from the dropdown.
3. Enter Date Prepared.
4. Select the processing documents to generate.
5

Click Store. View document in the using the Document > Stored menu option.

Request

The Request screen has options to request and track requested documents.
Note: Document request recipients must have a valid email address on file.

1. Select Document.
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2. Select Request.

Status  Application  Processing  Underwriting Reporting Documents  Services  Settings

Loan ID : 2022110100001 - Amy America
Stored PENDING o
Generate

REVIEW

eSign

COMPLETED

Figure 362: Document Request
Pending

Use the Pending options to request missing documents from appropriate parties.
1. Click the Add button. (See Figure 358.)

2. Select or enter the Document Name.

—

Add Document Request

Document Name W

Memo to
Borrower
Borrower M
Category s
Due © 4

Figure 363: Add Document Request Dialog

3. Select the request recipient from the Borrower dropdown.
4. Select the document Category from the dropdown.

Note: Leave Category blank when the document category is not listed.
5. Use the Calendar to select the Due Date and Time.

6. Enter a memo to the request recipient if Memo to Borrower does not auto
populate.

7. Click Save & Close.
Note: Click Save & New to add another document request.

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

226


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

™

calyx Zenly User Guide

8. Click Send when requested documents are listed.

Loan ID : 20220307000011 - Andy America Export Save
Stored PENDING [+)
Generate

Borrower Document Name Due Requested Sent To
Andy America Bankruptcy Debt Schedule o]
eSign

REVIEW

COMPLETED

Figure 364: Send Document Request

9. Click Send To.

Send Document Request X

Send To bd Email
Borrower Document Due
Andy America Bankruptcy Debt Schedule

Figure 365: Send To

Review

Documents requested appear in the Review List after return from requestor.

1. Click the Preview icon.

REVIEW
Borrower Document Name Requested Received PrE\V
Andy America Bank Statements 02/01/2023 02/01/2023 B

Figure 366: Review Received Document
2. Click Accept to approve the received document.
3. Click Reject to reject the document.

Note: The rejected document moves back to the Pending List to return to the requestor.
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Completed

Accepted documents move to the Completed List.

REVIEW

COMPLETED

Borrower Document Name Requested Received Preview Accepted

Andy America Bank Statements 02/01/2023 02/01/2023 B 02/01/2023

Figure 367: Completed Document Requests
eSign
eSign documents are available from the Stored Documents List. Upload documents not
auto generated and save to the Stored Documents List that require eSignatures.
Use the eSign screen to request electronic signatures.
1. Select Documents.

2. Select eSign.
3. Click Request eSignatures.

Status  Application  Processing  Underwriting  Reporting  Documents  Services  Settings

Loan ID:20221101000011 - Amy America

Generate

Request

Figure 368: eSign Application
Select the appropriate signee radio button.

Click Next.
Loan ID : 20221101000011 - Amy America mm
Stored Request eSignatures
Generate
_Reques{ 1 2

Select Documents

O  AmyAmerica/ Andy America

Ken N Customer, Jr

Custom Signers

Figure 369: Retrieve Document List
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6. Select the appropriate Filtered by option to return the appropriate Stored
Documents List.

Note: Select the Uploaded PDF icon to display uploaded documents.

7. Select the document from the Document Name List to place in the Selected
Documents List.

o— 3

Select Signers

Place Signatures

Search

Q
DOCUMENT SELECTION LIST E ﬁF SELECTED DOCUMENTS

Filtered by ~ Application v Date Prepared ~ 02/07/2024 2]
APPLICATION AMY AMERICA / ANDY AMERICA
Document Name Prepared Preview
Anti-Steering Disclosure . Borrower Signature 02/07/2024 B ﬁ[

Authorization (Bor)

Borrower Signature Authorization (Bor)

Clear
Borrower Signature Authorization (Co-Bor)

Borrower Signature Authorization (Joint)

Borrower's Acknowledgement of Disclosures

Previous

Figure 370: Selected Documents

8. Repeat Steps 7 - 8 until all documents requiring eSignatures are in the Selected
Documents List.

9. If Document Packages is selected, choose the desired package.
Loan ID : 2022110100001 - Amy America \ Export H Save \
Stored Request eSignatures
Generate
Request °
s |

Select Signers

Search

0

DOCUMENT SELECTION LIST E ﬁ‘ SELECTED DOCUMENTS

Filtered by Document Packages Date Prepared 02/0712024 =]

DOCUMENT PACKAGES

Document

PSR S PP

Previous

Figure 371: Document Packages
10. Click Next.
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11. Select the appropriate link to continue:
e Add Signature Fields

e Request Signatures

Add Signature Fields

Use the Add Signature option to add signature fields to uploaded documents.

1. Select the Read Receipt checkbox to receive an email when the document is

delivered.

Loan ID : 20221101000011 - Amy America

Stored Request eSignatures

Generate

Request

oo o ]

Select Signers

Name

Select Documents

\ Read Receipt

Send

B, Title Commitment

3

Previous

Add Signature

Figure 372: Add Signature
2. Click Add Signature.

3. Click the Add Signature Block icon.

Position Signers X

@QO1/2 Q&

| T - £ T

TALYX

software
Account Information Change Form

‘Changes Requested

a
—

O Company Information O Primary Contact O MyCalyx" Administator
Account ID# or Serial#
Choose Your Business Trpe: L
0 Credi Union O Mongage Eroker O Parscnal Accr Loan Officer
O Comanunity Back O Mertgage Banker O Personal Accr Processar
O Commercial Bank O Government Agency O Personal Acct Underumiter
O Savings & Loan O Educational [nstinuion. O Personal Acct Owner
Company Information Change
Change requested:
O Changeof Address
New BILLING Address: New PHYSICAL Address:
Streer Strear
ApvSuiteUnitBldg = ApvSuiteUnitBldg =
-
Cirv. State. Ziz: Cirv. State. Zin:
4| | 3

Figure 373: Position Signers Dialog
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4. Drag the Signature Block to the appropriate location.

Position Signers X

Change requested- o
O Changeof Address

New BILLING Address: New PHYSICAL Address:

Streat: Streat:

ApvSuiteUmiBMg= AptSuite’'UnitBlag =

Cuy, Stte. 2oy Ciry, State, Zip:

O Chkange of Company Name

Note: If your Company Name has chanzed due to a change of ownership, 2 license transfer is required — please contact
Calyx Software’s Sales Administrative Support Team at the phone mumber or email address on pg 2 of this form to
‘Tequest a license transfer agreement.

Old Company Name: New Company Name:
OKWDBA: NewDBA:

O Other Changes:
New New Fax Number:
New Primary Email Address:

O Adding and/or Deleting Contact Name(s):
{(When adding contacts, plezse include title & email address; when deleting contacts, wiite the name follow=d by the.
word delets)

1 as = Ouner = President = Vice President of
give my consent to Calyx Sofware to make the 1bove changes.
Signamwe:
of2

< 3

Figure 374: Position Signature Block
5. Resize the Signature Block.
6. Click Save.

7. Proceed to Request Signatures.
Request Signatures

Use the following steps to complete the eSignature request.
1. Click Next.

Stored Request eSignatures

Generate

Request
EE— o 2] © .

Select Signers Select Documents Place Signatures Send

Name Read Receipt

B, Title Commitment (] Add Signature

Previous \

Figure 375: Complete eSignature Request
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2. Enter a Package Name.

Stored Request eSignatures
Generate
Request N
C— o 2] ©
Select Signers Select Documents Place Signatures
Package Name l Name of Document Package I DueDate  02/08/2024 =]
DOCUMENTS TO SIGN
Name
Title Commitment

Figure 376: Send eSignature Request
3. Use the Calendar to select the Due Date.
4. Click Request to submit.

5. Use the Resend Email option on the eSign Pending List to resend documents.

Services

Use Services options order credit reports and Automated Underwriting Services (AUS).

Credit Reporting

Use the Credit Reporting screen to order borrower/co-borrower credit reports.

Credit Order

Complete the individual credit report request for borrower and co-borrower.

1. Select Services.

2. Select Credit Reporting.

Status  Application  Processing  Underwriting  Reporting  Documents  Services  Settings

Loan ID :20221101000011 - Amy America

Mortgage Market EXCH
Desktop Originator

Loan Product Advisor

O  AmyAmerica / Andy America - Primary

Ken N Customer Jr

CREDIT ORDER - JOINT

CreditPNs | submic |

(] credit Card Payment

Credit Agency

Request Action Type

Credit Plus, Inc. v

Report Type

Report Identifier

Figure 377: Borrower Credit Reporting
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3. Check the Credit Card Payment checkbox if appropriate.

Note: Leave the Credit Card Payment checkbox blank to use credit card information stored
on the Services Settings screen. (See Services Settings.)

4. Enter the Credit Agency from the dropdown.

Enter the Request Action Type from the dropdown.
Enter the Report Type from the dropdown.

Enter the Report Identifier if applicable.

Click Credit PINs to enter the borrower-provided credit report PIN humber.

© ©® N OO,

Enter the appropriate Credit PIN.
Enter Credit PIN to access locked credit accounts.

Brw Co-Brw

+ | Equifax PIN
~ Experian PIN

~| TransUnion PIN

Figure 378: Credit PIN Dialog
10. Click OK on the Credit PIN dialog.
11. Click Submit to submit the Credit Report Request.

If the Credit Card Payment checkbox is selected the image below displays.

Pay with Credit Card X

CardHolder Name Credit Card Type v
Street Address Card Number cw
City Expires
Month Year
State/Province v
Postal Code

Figure 379: Pay with Credit Card Dialog
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12. Enter credit card information in the Pay with Credit Card dialog.
13. Click Continue Order on the Pay with Credit Card dialog.
14. Enter credit agency Login Information in the Login Information dialog.

Login Information X

Login Name || ;

Password

Account l

Branch 1D |

ok | [ cancel|

Figure 380: Credit Agency Login Information
15. Click OK on the Login Information dialog.

16. Repeat Steps 1 - 13 for co-borrower.
Results

The Results List auto populates when the requested credit report is returned.

1. Click Credit Alerts to review credit report alerts.

RESULTS
Response Date/Time User Report Type Import Liabilities Credit Alerts Report
01/19/2023 11:52:04 AM 5004549 o B B

Credit Bureau Calyx Demo

Credit Technology Provider

Figure 381: Credit Report Results List

2. Click Report to review the full credit report.
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3. Click the Import Liabilities icon to copy credit liabilities to Zenly.

Copy To Liabilities X

Would you like to copy credit liability data to the loan application fields?
If yes, these fields will be copied, for the barrowers in the current credit

report:
Ignore Closed Liability holder company name and
Ignore $0 Balance address

Account Number

Unpaid Balance

Number of months remaining
Monthly payment amount
Type of Account

]

Figure 382: Copy to Liabilities Dialog

4. Select the appropriate checkboxes.

5. Click Yes to import the liabilities to the Application Borrower screen.

Mortgage Market Exchange

The Mortgage Market Exchange (MME) allows the user to submit the loan to multiple
available wholesalers.

Status  Application  Processing  Underwriting Reporting Documents  Services  Settings

Loan ID: 20221101000011 - Amy America

Credit Reporting

SUBMISSION INFORMATION
Desktop Originator
New Request v Mortgage Market Exchange

Loan Product Advisor

Figure 383: MME
To run pricing options:
1. Select the Services tab.
2. Select Mortgage Market EXCH.

3. Select an option from the dropdown menu.
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4. Select a wholesaler from the Mortgage Market Exchange.

Available Lenders

Sortby Lender Name 1%

- Flagstar Py : ROCKET
A s = o loanoepot oelozo

o wnouEsnE corvesroroenT Pro-TPO
PR —— B fresdom ot Corparaion S o P

ol Stearns UuwM

WHOLESALE

Sierra Pacific Mortgage, Inc. Stearns Lending United Wholesale Mortgage

Figure 384: MME
5. Complete the wholesaler's requirements.

Wholesaler Status and Received Documents

After a new request submission, the user may receive a status or documents from the
wholesale. Those items will appear in the tables below the Submission Information section.

To view the status or documents received:

1. In the Submission Information section, select the dropdown menu and select the
wholesaler.

Credit Reporting

SUBMISSION INFORMATION
Desktop Originator

Loan Product Advisor

uwm v Mortgage Market Exchange
Lender Loan ID:
@ sTaTUs
Date/Time Status
12/11/2023 0213 PM Submitted

° RECEIVED DOCUMENTS

Document Category Stored
Transmital Summary Disclosure 12711 oH
Gift Letter Borrower 12711 B b

Figure 385: Status and Received Document
2. Preview or download any documents received by selecting the icons.
3. Click Save.
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Desktop Originator

The Desktop Originator settings determine how Zenly interacts with Fannie Mae Desktop
Originator.

Fannie Mae DO and Credit Logins must be set up to submit to Underwriting.
Note: Proceed to Services Settings to set up Fannie Mae credentials.

1. Select Desktop Originator.

Status  Application  Processing  Underwriting Reporting Documents  Services = Settings

Loan ID : 20221101000011 - Amy America [ Export H save ]
Credit Reporting
Mortgage Market EXCH
SUBMISSION INFORMATION
Loan Product Advisor B User not authenticated m
Underwriting Submission Lender
~ ~ ~ 2
RESULTS
Response Date/Time Status Recommendation Messages Reports
Findings Credit

Figure 386: Desktop Originator Submission Info
2. Select Credit & Underwriting from the Underwriting dropdown.

Note: Select Underwriting from the Underwriting dropdown when re-submitting to Desktop
Originator.

3. Select the appropriate Submission option.
4. Select the appropriate Lender option.
Note: Selecting a Lender is not required when the Preliminary Submission option is selected.
5. Click the Lender Refresh icon to refresh the Lender dropdown.
6. Click Submit.
Note: A red warning displays by Submit when a Credit Reissue is not attached.

7. Click the Remove button to remove the Fannie Mae assigned Casefile ID and the
Results List information to resubmit and receive a new Casefile ID.

Note: The Results List populates after submittal.

Loan Product Advisor

Freddie Mac's Loan Product Advisor (LPA) allows the user to access Freddie Mac credit
requirements and view credit risks as well as the loan's overall underwriting risk.
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Before submitting an LPA request. Ensure that the following is completed:

e LPA credentials are added to Zenly.
e The borrower's credit is pulled through Zenly.
o The loan application is reviewed.

Status  Application  Processing  Underwriting  Reporting  Documents  Services  Settings

Loan ID : 20221101000011 - Amy America
Credit Reporting
Mortgage Market EXCH
SUBMISSION INFORMATION
Desktop Originator
Loan Product Advisor All borrowers must have a credit report to reissue. m
Transaction Request Type Case State Submitting Role
v v v
RESULTS
Casefile ID m
Loan ID
Response Date/Time Status Recommendation Messages Reports
Feedback Prop. Valuation Doc. Checklist Credit

Figure 387: Loan Product Advisor
To submit an LPA request:
1. For the Transaction Request Type dropdown menu, select the desired option.
2. Enter the desired Case State option.
3. Enter the desired Submitting Role.
4. Click the Submit button.

The Submit button will change to a Refresh button after an LPA is Processing
message appears.

5. Toretrieve aresult, select the Refresh button.

Note: Allow the screen a few seconds to process before selecting the Refresh button.

Results Table

The Results table contains LPA information for submitted requests. Errors messages are
views by selecting the icon in the Messages column. The LPA report is viewed by selecting
the icon in the Reports column.

Error Messages Table

The Error Messages table is a hidden table below the Results table and becomes visible if
the LPA submission contains errors.
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Settings

Use the Settings tab to apply conditions for the selected loan. The Settings tab options
override the USER tab selections.

User Access
Apply User Access settings to the selected loan.

Add User Access

Use the following steps to add user access to the loan.

1. Select User Access from the Settings tab.

Status  Application  Processing  Underwriting  Reporting Documents  Services  Settings

Loan ID :20221101000011 - Amy America Export Save
Document Defaults
dJ User Permission
O Edit o
Assign Edit Assign Read-Only

Figure 388: Loan User Access Settings
2. Click Add to add another user to the loan.
3. Enter the user in the Search field.

‘Search HE'

User Email

Add Edit Add Read

Figure 389: Set Loan User Access

4. Click the Search icon.
5. Click Add Edit to enable edit functionality.
Note: Click Add Read to enable read functionality.

6. Click Close.
Edit User Access

Use the following steps to edit loan user access.
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1. Select User Access from the Settings tab. (See Figure 384.)
2. Update the Edit User Access To Loan dialog. (See Add User Access for details.)
3. Click Save & Close.

Delete User Access

Use the following steps to delete loan user access.
1. Select the Delete icon. (See Figure 384.)

2. Click Delete on the Delete Confirmation dialog.

Document Defaults
Use Document Defaults settings to set up the default information for specific documents.

Status Defaults

Use the Status Defaults to set the company defaults to automatically print on forms.

1. Select Document Defaults from the Settings tab.

Status  Application  Processing Underwriting Reporting Documents  Services  Settings

Loan ID: 20221101000011 - Amy America
User Access Select Menu Select Document

NN N

Figure 390: Document Defaults

2. Select Status from the Select Menu dropdown.

3. Select Company Information from the Select Document dropdown.
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4. Enter Company Information.

Loan ID : 20220307000007 - Suzi S Builder
User Access Select Menu Select Document
Status v Company Information v
COMPANY INFORMATION
Name v Federal Tax ID
Address NMLS License
Unit Designator & Number State License &
City License Number
State/Province ~ Web Site Address
Postal Code
Telephone -

Extension

Fax )

Figure 391: Default Company Information

5. Click the State License Add button to automatically add state license information
to documents.

6. Enter the licensed State from the dropdown menu.

State v
License Number
License Authority

Web Site Address

Figure 392: Add State Dialog

7. Enter License number.
8. Enter License Authority.
9. Enter Web Site Address.
10. Click Save & Close.

Note: Click Save & New to add additional licenses.
Application Privacy Settings

Select the information to appear on the Privacy Statement Form.
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1. Select Application from Select Menu.

User Access Select Menu Select Document

Application v Privacy Polic v
Document Defaults s v Y

PRIVACY POLICY

Revision Date ::]

QUESTION AND ASSISTANCE

PERSONAL INFORMATION SHARING [+)

Telephone (L)~

Web Site Address

REASON TO SHARE PERSONAL INFORMATION

Does Share Limited Sharing

Our everyday business purposes | No v We Don't Share v

Figure 393: Loan Application Privacy Settings
2. Select Privacy Policy from Select Document.
3. Select the Calendar to set Privacy Policy Revision Date.

Click the Personal Information Sharing Add button to select document types
impacted by personal sharing.

Add Personal Information Sharing X

Type b

Other Description

Figure 394: Add Personal Information Sharing

5. Select the appropriate Type.
Note: Enter Other Description when selecting Other from the Type dropdown.
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6. Select Save & Close to add the document type to the Personal Information List.

Select Menu Select Document

Application v Privacy Policy ~

PRIVACY POLICY

Revision Date =
PERSONAL INFORMATION SHARING ©  QUESTIONS AND ASSISTANCE
Type Telephane )
Account Balances (o} Web Site Address

Figure 395: Document Type List
Note: Select Save & New to add another document type.

7. Enter Questions and Assistance Telephone and Web Site Address to which the
borrower/co-borrower can refer when questions arise.

8. Select Yes for the Reason to Share Personal Information statements to appear on

the form.
REASON TO SHARE PERSONAL INFORMATION
Does Share Limited Sharing
Our everyday business purposes No v We Don't Share v
Our marketing purposes No v We Don't Share ~
Joint marketing with other financial companies No v We Don't Share v
Affiliates’ purposes - transaction and experiences No v We Don't Share v
Affiliates' purposes - credit worthiness No v We Don't Share v
Affiliates' marketing to you No v We Don't Share v
Nonaffiliates marketing to you No v We Don't Share v

Figure 396: Reasons to Share Personal Info.

9. Select the appropriate corresponding Limited Sharing option.
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10. Select the appropriate Opt-out Methods details.
OPT-OUT METHODS
Return To
Telephone ()~ Company Name
Web Site Address Address
Number of Days Unit Designator Number

Reference

City

State/Province

Postal Code

Figure 397: Opt-out Methods

11. Click Select to add Opt-out Choices.

12. Select the checkboxes to include the information on the form.

Opt-out Choices X

Single opt-out joint borrowers.

Do not share information about my creditworthiness
with your affiliates for thier everyday business
purposes.

Do not allow your affiliates to use my personal
information to market to me.

Do not share my personal information with nonaffiliates
to market thier products and services to me.

Do not share my personal information to market to me.
Do not use my personal information to market to me.

Do not share my personal information with other
institutions to jointly market to me.

Figure 398: Opt-out Choices Dialog

13. Complete the remaining form fields.

14. Click Save to save the selections.

ECOA Processing Settings

Select the statement to include on the Equal Credit Opportunity Act (ECOA) Form.
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1. Select Processing from the Select Menu dropdown.

User Access Select Menu Select Document

Processing v ECOA/NOA v
Document Defaults

EQUAL CREDIT OPPORTUNITY ACT / NOTICE OF ACTION

Federal Agency Office of the Comptroller of the Currency ~

Description  Office of the Comptroller of the Currency, Customer Assistance
Group, 1301 McKinney Street, Suite 3450, Houston, TX 77010-9050

&~

Figure 399: ECOA Form Statement
2. Select ECOA from the Select Document dropdown.
Select the appropriate Federal Agency from the dropdown.

Review the Description to ensure the correct one is selected.
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Chapter 5: REPORTS TAB

The Reports tab allows users to generate reports with loan data from loan files in Zenly.
Each Report has the export function to let the user download a CSV file of the loan data.

a

‘ Ze N Iy LEADS / LOANS REPORTS USERS TEMPLATES -‘ 0

Active Pipeline Report

Lender Report
New Prospect Report
Closed Report

Mortage Call Report

Figure 400: Reports Tab

The reporting options available in this tab function similarly to each other. The difference is
the data generated in the report. See the figure below.

Active Pipeline Report
Leads Loans ( Current Status ]
Loan Originator v Status Prospect ~ is between 2] and 2]
Loan Number Borrower Name  roperty Address  Unit Designator ~ Unit Number  City State I Postal Code  Status Status Date  Application Date ~ Purpose I
20220718000007 Andy America an Pines 823 Rehobeth  MD 21857 Prospect 09/26/2022" 10/05/2019 Refinance
20230306000006 Ken N Customer ch St Burbank CA 91502 Prospect 03/13/2023 Refinance
20240409000000 Loan Status, Check Application  04/10/2024 Purchase
Closed Report
Leads Loans ( Current Status |
Loan Originator e Status Prospect v is between & and &
Loan Number Borrower Name  ’roperty Address  Unit Designator ~ Unit Number  City State IPosta\ Code LoanAmount Loan Type Note Rate  Loan Terml '
20220718000007 Andy America 2an Pines 823 Rehobeth  MD 21857 250,400.00 Conventional  5.000 360
20230306000006 Ken N Customer  rch St Burbank  CA 91502 500,000.00 Conventional  6.000 360
20240409000000 Loan Status, Check 803,000.00 Conventional

Figure 401: Active Pipeline/Closed
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Status Dropdown Menu

The user can use the Status dropdown menu to generate a report based on the Status of
the loan files. Any loans labeled with the selected Status at any point will populate the

table/report.

Example: The figure below shows that the loans are either currently a Lead or was Lead.

Loan ID : 20220208000031 - Andy America

srarus

Contacts

Date
Conversation Log

Status

02/23/2022 10:20 AM

02/08/2022 3:18 PM

Application

ToTTTTO ™ T T ST

Contacts

Date
Conversation Log

Status Description

11/30/2022 10:18 AM

| Lead I

Figure 402: Status

Generating a Report

Follow the steps below to generate a report. Use one or all the functions to specify which

loans appear in the table.
To generate a report:

1. Select the Reports tab.

2. Select the desired report (Example: Active Pipeline Report). See Figure 396.

3. Click on the Current Status button.
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4. Select or unselect desired Statuses.
Click on the AUl checkbox to unselect the other checkboxes.

| Current Statuses x

Al

Lead
Prospect
Application

Clear to Close

Signing Scheduled
Funded

Approved not Accepted
Denied

Withdrawn

Canceled

Closed

Save & Close

Figure 403: Status Dropdown

Processing

Loan Registered
Loan Submitted
Conditional Approval

Note: Using both the Status dropdown menu and the Statuses button allows the user to pull
loans that have had the same status and are at the same current Status. See the example
below.

Example: Both loan files previously had the Lead status assigned, and both are currently

Closed.
Status | Application | Processing = Underwriting | HMDA | Documents | Services | MarketPlz
Loan ID : 20221101000011 - Amy America
sratus
Contacts
Date Status

Current Statuses X

All

Lead

Prospect
Application
Processing
Loan Registered
Loan Submitted

Conditional Approval

Clear to Close
Signing Scheduled
Funded
Approved not Accepted
Denied
Withdrawn
Canceled
~| Closed

Save & Close

Conversation Log

11/01/2022 11:36 AM

11/01/2022 11:36 AM

11/01/2022 11:36 AM

11/01/2022 11:33 AM

Signing Scheduled

Conditional Approval

Status | Application | Processing HMDA  Documents

Underwriting

Loan ID : 20221101000009 - Ken N Customer JR

Services = MarketPlace

STATUS

Contacts
Date Status

Conversation Log -
11/0172022 11:37 AM
11/01/2022 11:37 AM Funded
11/01/2022 11:37 AM Application
11/01/2022 11:33 AM Lead

Figure 404: Status/Current Status
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5. If needed, select the Loan Originator dropdown menu, and select the desired
option.

6. Select a Status dropdown menu to select an option.

7. Select the Calendar icon to select the date interval.

Active Pipeline Report
Leads Loans Current Status
Loan Originator v Status Lead hd is between|  11/15/2022 & and  03/15/2023 2
Loan Number Borrower Name Subject Property Address _ Unit Designator _ Unit Number _ Cit: State Postal Code _ Status Status Date _ Application [

Figure 405: Select Dates
8. Click the Generate button to populate the table.

Active Pipeline Report

Leads Loans Current Status ‘
Loan Originator hd Status Lead hd is between 11/15/2022 & and 03/15/2023 &
Loan Number Borrower Name Subject Property Address  Unit Designator ~ Unit Number  City State Postal Code  Status Status Date  Application [
20220208000000 NJ Lead 02/08/2022
20220208000001 Ken N Customer, JR 10655 Birch St Burbank CA 91502-1234 Lead 02/08/2022
20220208000002 Homer Loanseeker 3700 Connecticut Ave, .. Washington DC 20008 Lead 02/08/2022
20220208000003 Andy America 1234 Ocean Pines 823 Rehobeth MD 21857 Lead 02/08/2022
20220208000004 Patrick P Purchaser 1234 Main Baltimore MD 20600-1234  Lead 02/08/2022

<

Figure 406: Generated Report

Exporting Generated Report

Once generated, the user can export and download the report as a .csv file.

To export the report:
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1. Select the Export to CSV button.

Active Pipeline Report

Leads Loans ‘ Current Status
Loan Originator N Status Lead v is between  11/15/2022 & and  03/15/2023 ]
Loan Number Borrower Name Subject Property Address  Unit Designator ~ Unit Number  City State Postal Code  Status Status Date  Application [
20220208000000 NJ Lead 02/08/2022
20220208000001 Ken N Customer, JR 10655 Birch St Burbank CA 91502-1234  Lead 02/08/2022
20220208000002 Homer Loanseeker 3700 Connecticut Ave, .. Washington DC 20008 Lead 02/08/2022
20220208000003 Andy America 1234 Ocean Pines 823 Rehobeth MD 21857 Lead 02/08/2022
20220208000004 Patrick P Purchaser 1234 Main Baltimore MD 20600-1234  Lead 02/08/2022

e

Figure 407: Export to CSV

2. Once the file is downloaded, click on Open File.

3. Save the report to the desired location.

Mortgage Call Report

The Mortgage Call Report (MCR) contains features to generate a report for all the loan files.
The data generated from the Mortgage Call Report 2024 screen, located in the Reporting tab
within a loan file. The generated MCR report contains fields specific to this report with the
ability to export to an XML file.

To generate the MCR:
1. Click the Reports tab.
2. Select Mortgage Call Report.

3. Choose a State from the dropdown menui.

Mortgage Call Report

Leads Loans

State X v Report Period v is between ] and ;]

Figure 408: Mortgage Call Report
4. Select a quarter from the Report Period dropdown.

Note: Using the Report Period dropdown auto-populates the dates fields with the correct
quarter interval.
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5. Click on the Calendar icon to choose date interval.

Mortgage Call Report

Leads Loans

State X v Report Period Quarter 1 v is between 01/01/2024 [::] and 03/31/2024 ]

Figure 409: MCR Date Interval

6. Click Generate.

The generated report displays a view familiar to the user that can be exported.

Mortgage Call Report
Leads Loans
State X v Report Period Quarter3 v isbetween  05/01/2023 B and 0472412024 ]

° RMLA SECTION |

Application Data

Type of Action Taken Directly Received From Borrower Received From 3rd Party

Amount ($) Count (#) \Average Size (S)| Amount ($) Count (#) Average Size ($)
IACO10  |Applications in Process at the Beginning of the Period 0.00| 0| 0.00| 20| 207,100.00
AC020 |Applications Received 3| 225,000.00| 0 0.00
/AC030  |Applications Approved but not Accepted 0.0 0| 0.00| 0| 0.00
IAC040  |Applications Denied 0.0( 0| 0.00| 0l 0.00
IAC050  |Applications Withdrawn 0.00| 0| 0.00| 0| 0.00
IAC060  |File Closed for Incompleteness 0.00] 0 0.00| 0 0.00
/AC065  [Net Changes in Application Amount(decreases should be reflected as negative) 0.00]
AC063  [Net Application Changes (decrease should be reflected as negative) ‘ 0.00| ‘ 0.00
/AC066 |Total Application Pipeline 675,000.00) 3‘ 225,000.00| 4,142,000.00 ZU‘ 207.100.00|
Application Pipeline Results
IAC070 |Loans Closed and Funded 0| 0.00| 0l 0.00)
/AC080  |Applications in Process at the End of the Period 675, I 3] 225,000.00| 20| 207,100.00|
/AC090 |Total Application Pipeline Results 675,000.00] 3] 225,000.00| 4,142,000.00 20| 207,100.00|
Closed Loan Data
I Forward Mortgages I Brokered I Closed-Retail Application I Closed-Wholesale Application |

‘ ‘ Amount ($) ‘ Count ($) ‘ Average Size ($) ‘ Amount ($) ‘ Count ($) ‘ Average Size ($) ‘ Amount ($) | Count($) | Average Size ($) ‘
Loan Type
= —

I

Figure 410: Generated MCR

To view the report's data, click on the View Data button at the bottom of the screen.

r : r ; ; T ; ; T
|acos0_|applications in Process at the End of the Period | 67500000 3| 22500000 4.142.000.00] 20 207.100.00]

|acoso [otal Application Pipeline Results | 675.000.00] 3 22500000 4.142,000.00] 20 207.100.00]

Closed Loan Data

‘ Forward Mortgages ‘ Brokered | Closed-Retail Application ‘ Closed-Wholesale Application |
| | amount (s) | count (s) | Average 5j | Amount (s) | count (s) [ Average size (s) | Amount (5) | Count (s) | Average size (s) |
Loan Type

Export to CSV Export to XML

Figure 411: View Data

Note: Line items AC063 and AC1100 are user-defined. Those items are editable after the
XML submission.

View Data
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Exporting

The Mortgage Call Report (MCR) allow the user to choose between two options; via CSV
(See Exporting Generated Report), and via XML.

Use the CSV file to assist in cleaning up the data prior to submitting the report as an XML.

Resubmission Status X

@ New Submission

O Resubmission

Save & Close

Figure 412: Resubmission Status
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Chapter 6: USERS

The USERS tab contains administrative options for Zenly user setup and maintenance.

User Information

Access the User Information screen to view and update current user statuses.

Add User

Use the following sections to create a new Zenly user.
User Status and Contact

Setup the user status and contact information.
1. Select the USERS tab.
2. Click New.

“ Zenly LEADS/LOANS ~ REPORTS ~ USERS  TEMPLATE A O

First Middle Last Suffix Email

LAL

Figure 413: New User

3. Select the Active radio button to activate the new user.

User : New User

Services Settings
@ Acive O Inactive

Alerts Configuration

CONTACT (* REQUIRED FIELD)

First ~ New * Email *
Middle Contact *
Last  User * Mobile
Suffix :] By Checking the Opting in Box, you are

authorizing us to send you related
NMLS Number informational texts. Message/data rates apply.

Figure 414: New User Contact Details
Note: Select Inactive to establish the user without activating user ability to access Zenly.
4. Enter Contact First name.
5. Enter Contact Last name.
6. Enter Contact Email.
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7. Enter Contact Phone number.

8. Enter Contact Mobile number.

9. Enter Contact NMLS Number if applicable.

10. If needed, select the By Checking the Opting in Box....

Note: By opting into the informational texts, the user is provided with an additional method
for sending password change requests.

Loan Access

Set the options for determining which loans to which the user has access and the type of
access granted.

1. Select the appropriate Loan Access View option.

LOAN ACCESS MENU LOAN ACCESS
View All/Read Only v Status Edit v
Create New Loans )
Delete Existing Loans Application Edit e
Processing Edit ~
DOCUMENT MANAGEMENT ACCESS
Underwriting Edit ~
[_, Upload Documents °
[_, Delete Documents Reporting Edit “

ﬁ eSignature

Services Edit v
DIRECTORY ACCESS

Settings Edit v
Contacts Edit v

Figure 415: User Loan Access

e All/Edit: Select to enable user to view and edit all loans.
e All/Read Only: Select to enable user to view all loans.
e User's Only/Edit: Select to enable user to view and edit assigned loans.

2. Select the Create New Loans checkbox to enable the user to create new loans.

3. Select the Delete Existing Loans checkbox to enable user to delete loans from
Zenly.

Document Management Access

Set the user document management options.

1. Select the Upload Documents checkbox to enable the user to upload documents
to Zenly.

2. Select the Delete Uploaded Documents to enable user to delete documents from
Zenly.
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3. Select the eSignature checkbox to enable user to capture borrower/co-borrower
electronic signatures.

Menu Loan Access

The options selected for Menu Loan Access determine the Zenly tabs to which the user has
access and the level of assigned access. Different access options may be set for different
tabs. Options include:

No Access: Removes the tab from user view and prevents the user from performing the
action.

Read Only: Enables information viewing without editing capabilities.
Edit: Enables user to make changes to tab information

1. Select the appropriate Status option. (See Figure 408))
Select the appropriate Application option.
Select the appropriate Processing option.
Select the appropriate Underwriting option.
Select the appropriate Reporting option.

Select the appropriate Services option.

N o o~ W DN

Select the appropriate Settings option.
Directory Access

Enable or disable the user's ability to edit contacts.

¢ Read Only: Enables information viewing without editing capabilities.
¢ Edit: Enables user to make changes to tab information.

User Profile
Admins can configure User Profiles to allow or disallow functions in the menu and for the
Interview Portal.

For the User dropdown menu:

e No Access: Users will not have access to the user profile.
e Read Only: Users can view the User Profile, but not the ability to edit.
e Edit: Users have full access to the User Profile.

For the Interview Portal dropdown menu:

¢ Disable Site: This option prevents the user from accessing the Interview Portal.
¢ Company Managed: This option disables the site for the user.
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¢ Read Only/Limited Access: This option allows the user to only view the Interview
Portal, but not have any editing access.
¢ Edit/User Configurable: This option allows the user to have full access to the site.

Administrator Access

Administrator Access options determine the administrative actions the user may access.
Template options determine how the user interacts with the TEMPLATE tab.
Administrator User options include:

¢ No Access: Prevents user from seeing or interacting with administrative options.
e Read Only: Enables the user to see administrative options.
¢ Edit: Enables the user to modify administrative options

Template options include:

e No Access: Prevents user from using templates.
e Read Only: Enables the user to access and use templates as-is.
e Edit: Enables the user to modify and use templates

1. Select the appropriate Administrator Users option.
2. Select the appropriate Templates option.

State Licenses

Use the State License Add option to upload and add state licenses by the user.
1. Click Add.
2. See Status Defaults for details.

3. Repeat Steps 1 - 2 for additional user state licenses.

Modify User

Modify access levels for existing Zenly users.

1. Select a user from the User table.

‘ zenly LEADS/LOANS ~ REPORTS ~ USERS  TEMPLATE A O
First Middle Last / Suffix Email

Figure 416: Select User

@greatdem... w

2. Update User fields as required.
3. Click Save.
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Reset User Password
Use the following steps to reset a user password.
1. Select a user from the User table. (See Figure 409.)
2. Click Reset Password.
‘ Zen |y LEADS/LOANS REPORTS ~ USERS  TEMPLATE ‘ O

User

User : Wes Alt

Reset Password
Services Settings

@ Active O Inactive

Alerts Configuration

CONTACT (* REQUIRED FIELD)

First *

Email @greatdemobank.com *
Middle Contact *
Last * Mobile *
Suffix NMLS Number
Figure 417: Reset Password
Delete User
Delete users that no longer require Zenly access.
1. Select the user to delete.
“ zenly LEADS/LOANS ~ REPORTS  USERS  TEMPLATE A ay
First Middle Last Suffix Email \
@greatdem... w

Figure 418: Delete User
2. Click the Delete icon.

User Search

Enter search criteria to locate a Zenly user.

1. Enter the Search criteria.

‘ Zenly LEADS/LOANS R TS USERS TEMPLATE ‘ 9
I Search Active Users b

‘ New User

First Middle Last Suffix Email

@greatdem... w

Figure 419: User Search
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2. Press Enter to search.

Activate/Inactivate User

Activate or deactivate users without removing them from Zenly.

1. Select the appropriate user from the User List.

* zenly LEADS/LOANS

REPORTS  USERS PLATE A O
l Search Q . Active Users

First Middle Last Suffix Email

@greatdem... W

Figure 420: Activate/Deactivate User
2. Select Active User to enable Zenly access.

3. Select Inactive to remove Zenly access.

Services Settings

Use the Services Settings screen to setup user credentials for selected service providers.

Add User Services Credentials

Use the following steps to add user credentials to selected services.
1. Select the USERS tab.
2. Select the User.

‘ zZeén |y LEADS/LOANS ~ REPORTS  USERS  TEMPLATE ‘ e

l Search

Q . Active Users e

First

Middle

Last

Suffix

Email

o

@greatdem... o
Figure 421: Select User
3. Select Service Settings.
4. Click Add.
User Information LOGIN CREDENTIALS ——) O

Alerts Configuration

Figure 422: Add Service
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5. Select the desired Service from the dropdown.

Add Login Credentials X

Select Service v Login Name @GreatDemoBa
Select Agency ~ Password — sesessesesess "@
Preferred
Account
Branch ID

Figure 423: Add Login Credentials

6. Select the desired Agency from the dropdown.

7. Select the Preferred checkbox to set the agency as a preferred provider.
8. Enter the Login Name.

9. Enter the Password.

10. Enter the Account Number.

11. Enter the user Branch ID.

12. Enter the Fannie Mae Account Number.

13. Enter the Fannie Mae Password.

Note: The Fannie Mae fields only appear for credit vendors that require different
authentication credentials for Fannie Mae vendors.

14. Click Save & Close.

Note: Click Save & New to add another provider.

Edit Provider

Use the following steps to edit a provider.
1. Access Service Settings.
2. Click the provider to edit.

User Reset Password H Save ‘

User Information LOGIN CREDENTIALS o
Service Agency Login Name Account Branch Id Preferred

Alerts Configuration
Credit Xactus @great... v w

Figure 424: Modify Provider
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3. Update the Edit Login Credentials dialog as appropriate.

Edit Login Credentials X

Select Agency Desktop Originator Password | seeesesss
Account 444444

Branch ID 54545454

Save @ Cancel

Select Service Fannie Mae i Login Name @GreatDemoBz

Figure 425: Edit Login Credentials Dialog
4. Click Save & Close.

Delete Provider

Use the following steps to delete a provider.

1. Access Service Settings.
2. Click the Delete icon. (See Figure 417.)

3. Click Delete on the Delete Confirmation dialog.

Alerts Configuration

The Alerts Configuration screen allows the user to adjust the notifications that appear in

Zenly. Use the toggles to select the notification types and access.

User :

Reset Password

User Information
Use the toggles to switch the alerts and email notifications on/off for these system generated items.

Services Settings

Alerts Configuration Alert Email

@ @ Documents Received
© © -«
@ @ vouare assigned afile

[ o] Interview Completed

ACCESS

View  Edit v

@ Create New Alerts - Allows for creating custom alerts within files
@ Assign Alerts - Grants the ability to assign alerts to other users
@ Clear Existing Alerts - Grants access to remove from the list prior to the automatic clear date/time

@ clear Alert after 30 Days - Allows for alerts o be cleared automatically. This can be toggled on/off per user
(Range 5-365)

Figure 426: Alerts Configuration
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Alerts & Notifications

Two types of notifications are available: Alerts and Email (See Figure 419). Alerts appear in
the bell icon & at the top of the screen. The three criteria for triggering a notification are:

e Document Received
e eSign Package Received
e Being assigned afile.

e New Lead from Interview

Access

In the Access section, adjust the user's level of access by selecting an option from the View
dropdown menu. Grant the user the ability to Edit alert configurations. The admin can
remove that ability by choosing the No Access option.
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Chapter 7: TEMPLATE TAB

Use the TEMPLATE tab options to customize and manage templates.

Fee Templates

Set up the Fee Templates used to populate loan fees. The set fees auto populate the Zenly
corresponding fields.

Update Standard Fee Template

The Standard Fee Template is a canned template used to populate the Initial Fees
Worksheet.

Note: Use the Add button to create a new template. See Create New Fees Template for
details.

1. Click Fee Template on the Template tab.

’ zenly LEADS/LOANS ~ REPORTS  USERS  TEMPLATE A O
‘ Save ‘
Fee Templates
Search Q (+]
Loan Programs
Document Packages Templates Name
Directory o}
Services Settings
0}
Company Information
! o
Dropdown Lists
Document Settings u}
Escrow Account Setup m)
o
o
[ =

Figure 427: Standard Fee Template
2. Select the Add © button.
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3. Enter the Template Name.

Template Name Non-Specific Lender Credit
A. ORIGINATION CHARGES 0
Fee Name Amount
Loan Amount (Points) 0.00

B. SERVICES BORROWER CAN'T SHOP FOR

C. SERVICES BORROWER CAN SHOP FOR

E. TAXES AND OTHER GOVERNMENT FEES o

Figure 428: Origination Charges
4. Enter the Non-Specific Lender Credit code if applicable.
5. Click the Amount field.

Add Origination Charges X

Fee Name v Company Name
Other Description Responsible Party Borrower v
Paid To G Eguahﬂed -Mortgage
Exclude from Tolerance
Based On Total Loan Amount v
Paid By: Fee Percentage Fee Dollar Amount Total Fee Amount Paid Before Closing ~ PFC  FHA FIN
Borrower % $ $ &
Seller o i? $ i
Lender % i $ $
Broker o i? $
Third Party % # &
Correspondent % & &
Total Amount 3

Figure 429: Edit Origination Charges Dialog
6. Enter the Origination Charges details in the Edit Origination Charges dialog.
7. Click Save & Close.

8. Repeat Steps 3 - 4 for remaining Origination Charge additions.
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9. Click Origination Charges Add to add additional origination charges. (See Figure
421)

10. Enter the new Origination Charge details in the Add Origination Charges dialog.

Add Origination Charges X

Fee Name ¥ Company Name
Other Description Responsible Party Borrower ~
ualified Mortgage
FeslTo e chlude from T%Iirance
Based On Total Loan Amount v
Paid By: Fee Percentage Fee Dollar Amount Total Fee Amount Paid Befare Closing PFC FHA FIN
Borrower % % % $
Seller % ki & i
Lender %o $ & $
Broker % 5 &
Third Party %o 5 2
Correspondent % $ &
Total Amount %

Figure 430: Add Origination Charges Dialog
11. Click Save & Close.
Note: Click Save & New to add another new Origination Charge.
12. Repeat Steps 1 - 10 for the following Standard Fees:

e Services Borrower Can't Shop For
e Services Borrower Can Shop For
e Taxes and Other Government Fees

e Prepaids
e Initial Escrow Payment at Closing
e Other

Create New Fees Template

Create a new Fees Template by copying the Standard Fee Template or by using specific
Add buttons.

Create from Copy

Create a new Fees Template with different names to enable different fees for different loans
and loan types.
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1. Click and hold the Template Name to copy until the Add button changes to Drag
& Drop here to Copy.

Save

Search Q I Drag & Drop here to Copy |
24 temp [ [T}

Templates Name

10th template o)
21te W
23 tem o}
25 the temp |of
26 th tamn 1

Figure 431: Copy Fees Template

2. Drag the selected template to the Drag & Drop here to Copy button to create a
copy.

7th temp

8th temp
Copy of 24 temp

Copy of Copy of Copy of non spec8

=]

&
&l

Copy of Copy of non spec8
Copy of non spec

Copy of non spec(1)

B B & B8 & &

deepu test 1

Figure 432: Copied Template
3. Rename the template appropriately.

Template Name Copy of 24 temp

Non-Specific Lender Credit
A. ORIGINATION CHARGES \ 0

Fee Name Amount

Loan Amount (Points) 0.00

Figure 433: Rename Fees Template
4. Enter the Non-Specific Lender Credit Identifier if appropriate.

5. Use Steps 3 - 10 in Update Standard Fee Template to update the appropriate
charges.

Create a New Template

Use the appropriate Add button to create a new template.
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1. Click the Add button.

Template Name Non-Specific Lender Credit
A. ORIGINATION CHARGES 0
Fee Name Amount
Loan Amount (Points) 0.00

B. SERVICES BORROWER CAN'T SHOP FOR

C. SERVICES BORROWER CAN SHOP FOR

E. TAXES AND OTHER GOVERNMENT FEES

F. PREPAIDS

G. INITIAL ESCROW PAYMENT AT CLOSING

H. OTHER

SERVICE PROVIDERS BORROWER CAN'T SHOP FOR

o©c [© (O |0 |© (O

Figure 434: Add New Fees Template

2. Enter the Template Name.
3. Enter the Non-Specific Lender Credit Identifier if appropriate.
4. Click Add for the first type of charge to enter in the template.
5. Complete the appropriate Add Charges dialog fields.
Fee Name e Company Name
Other Description Responsible Party Borrower M
; G Qualified Mortgage
Lo Exclude from Tolerance
Based On Total Loan Amount v
Paid By: Fee Percentage Fee Dollar Amount Total Fee Amount Paid Before Closing PFC FHA FIN
Borrower %o B 5 $
Seller %o % 5 k2
Lender %o 5 5 %
Broker %o % %
Third Party % 5 $
Correspondent % s 3§
Total Amount 5

Figure 435: Add Charges Dialog
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6. Click Save & Close.
Note: Click Save & New to add another new charge for the selected list.

7. Repeat Steps 4 - 6 for each charge type to add to the new template.

8. Click Save when complete.

Loan Program

This section allows the user to create, edit, or delete templates for loan programs that will

auto-populate to a loan file. See Application Loan.

Creating a Loan Program Template

To create a new template:

1. Select the Add © icon to add a template.

2. Enter the Template Name.

Template

Fee Templates

Document Packages

Directory

Services Settings

Template Name

MAX QUALIFYING RATIOS

Save

LTV

Housing Expense

Figure 436: Template Name

3. Adjust the desired fields in the Loan Information section.

LOAN INFORMATION

Loan Type

Other Description
Loan Purpose
Other Description
Construction Type
Cash-Out Type

Occupancy

Conventional

Purchase

Primary Residence

E FHA Secondary Residence

Lien Position

Amortization Type

QOther Description

Note Rate

Amortization Term

Loan Term

First

Simultaneous Financing

Fixed

Months

Months

[ HELoc

Figure 437: Loan Information Template
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4.

If needed, enter Rate Adjustments.

RATE ADJUSTMENT

Adj Cap Months Index Type v
1st Change
Other Description
Adj Period . .
Rate Rounding Options
Life Cap Rate o
Margin Rate Round To e
Index
Alt. Index
Floor
Figure 438: Rate Adjustment
5. If needed, enter Payment Adjustments.
If needed, enter the Buydown Mortgage.
PAYMENT ADJUSTMENT
Interest-Only
months Extra Payment of 5 every payment
(] calculate Qual Ratios at the Interest-Only Payment [] Bi-Weekly Payment Schedule
Initial Payment Rate [J simple Interest
e % months [ Down Payment Assistance Program
Adj Cap Adj Period Principal Forgiven
%o % every maonths
Recast Pd/Stop Graduated Payment Mortgage
/ Years at Rate
Max Balance Payment Rounding Options Payment Rounding
% Payment % v
(] calculate Qual Ratios at the Max Adjusted Loan Balance
BUYDOWN MORTGAGE [+]
Paid By Borrower e Temporary Buydown Fee k3
Disclose LE/CD Product Step Rate v Type v
[ Temporary Subsidy
Figure 439: Payment Adjustment
7. Click on Save.
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Document Packages

Use this section to create templates for print documents. The Document Package will
appear when generating documents for a borrower. See Generate.

Template

Search Q (+]

Fee Templates

Loan Programs

Document Packages Templates Name

Directory

Services Settings
Company Information
Dropdown Lists
Document Settings

Escrow Account Setup

B & & & & &

Figure 440: Document Packages
To create a Document Package:
Select the TEMPLATE tab.
Select Document Packages.
Click on the Add icon.
Create a name for the template using the Template Name field.
In the Filtered by dropdown, select the desired document type.

Choose the desired document(s).

N o o~ w N E

Select the Save button.
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Directory

The Directory allows the user to add or import contact information to Zenly.
To a contact:

1. Select the Add button.

Template

Fee Templates

Search Q
Loan Programs

CONTACTS 2,
Document Packages L _O

Type « Contact Company Telephone Email

Services Settings

Applicable Point of Contact  First Contact Entered, Man... Great Demo Bank

Company Information

Appraiser Freddie Mac Integration S..
Dropdown Lists

Broker Calyx Test Calyx Software
Document Settings
Escrow Account Setup Lender/Mortgagee

Lender/Mortgagee Great Demo Bank

99@@9\

Figure 441: Directory
2. Select a Contact Type.

Add Contacts X

a
Contact Type v First Company Name
Other Type Middle Address
Reference Last Unit Designator e Number
Entity v Suffix City
Position State/Province v
Telephone - Postal Code
Extension County
Email Country e
Telephone -
Extension
Fax -
ADDITIONAL DETAILS
Contact Detail State Company Detail State
NMLS License Number NMLS License Number
License License
Federal Tax ID Federal Tax ID L/

Figure 442: Contact Type (Directory)
3. Enter the desired contact information.
4. Select Save & Close.
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Importing Contacts

Import contacts using the import icon. A Sample CSV file is provided to assist with the
importation of a directory.

Note: Use the headers from the Sample CSV file to format the desired directory CSV file
before importing.

To import contacts:

1. Select the Import icon.

Template

Fee Templates
3 Search Q
Loan Programs
CONTACTS A
Document Packages o
Type « Contact Company Telephone Email
Services Settings Applicable Point of Contact  First Contact Entered, Man... Great Demo Bank w
Company Information )
Appraiser Freddie Mac Integration S... w
Dropdown Lists
Broker Calyx Test Calyx Software w
Document Settings
Escrow Account Setup Lender/Mortgagee o
Lender/Mortgagee Great Demo Bank w

Figure 443: Use Directory Icon
2. Select Choose File.
Note: Click on the Sample .csv file link to open the CSV sample file.
3. Select the desired CSV file.
You can import Contacts to the Directory using a .csv file
Choose File = No file chosen

Sample .csv file B

Figure 444: Import Directory

4. Ensure the format is correct.
5. Select Open.
6. Select Import.

Global Services Settings

Use the Services Settings screen to set global service credentials for users.
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1. Select the TEMPLATES tab.

Fesilemplafes LOGIN CREDENTIALS [+)
Loan Programs

Service « Agency Login Name Account Branch Id Preferred
Document Packages

Credit Credit Plus, Inc. o
Directory

Credit Factual Data Inc o

Company Information Credit Factual Data by CBC w
Dropdomn Lists Credit CorelLogic CREDCO - Testing o
Document Settings

Credit Calyx DO Demo w
Escrow Account Setup

Credit Informative Research Inc. (Test e... o]

Credit Xactus - test ]

Figure 445: Stored Credit Card
2. Select Services Settings.
3. Click Add.
4. Select the appropriate Service.

Add Login Credentials X

Select Service Credit Reports v Login Name @GreatDemoBank
Select Agency Advantage Credit Bure v Password PO
Preferred
Account
Branch D

Fannie Mae

Account
Number

Password O]

Figure 446: Add Login Credentials Dialog

5. Select the appropriate Agency.
6. Select the Preferred checkbox to save settings as preferred.
7. Enter Login Name.
Note: The Login Name for the Loan Product Advisor Agency is given by Freddie Mac.

8. Enter the login Password.

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

272


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

calyx

™

Zenly User Guide

9. Enter the Account number.

10. Enter the company Branch ID if appropriate.
11. Enter the Fannie Mae Account Number.

12. Enter the Fannie Mae Password.

Note: The Fannie Mae fields only appear for credit vendors that require different
authentication credentials for Fannie Mae vendors.

13. If needed, enter TPO/NOTP (Freddie Mac).
14. If needed, enter Seller Servicer number (Freddie Mac).
15. Click Save & Close.

Note: Click Save & New to add another service setting.

Company Information

Set company information defaults that will appear on all printed documents.

1. Select Company Information.

Template

Fee Templates

Loan Programs Our business is a Lender/Mortgagee v

Document Packages

COMPANY INFORMATION PROCESSING CENTER

Directory

Services Settings Name Name  Processorsinc

Company Information Address 3500 Maple Ave. Address 321 smaple ave

Dropdown Lists
Unit Designator v Number Unit Designator ~ Apartmer v Number 11

Document Settings

Cit Dallas Cit Garland

Escrow Account Setup 4 4

State/Province  TX v State/Province  TX v
Postal Code 75219 - Postal Code 75040

Telephone () Telephone  (555)333-2222

Figure 447: Company Information
Select the business type from the Our business is a dropdown.
Enter Company Information.
Enter Processing Center information if required.
Click the Company Information State License Add button.
Complete the Add State dialog fields.
Click the Processing Center State License Add button.
Complete the Add State dialog fields.

©® N OO A W N
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Dropdown Lists

Use the Dropdown List options to customize dropdown lists on some Zenly screens.
Choose either Leads or the Loans option to add list items to the selected location.

Select List Items

Use the following steps to select a listed item not included in a dropdown.

1. Select Dropdown Lists.

Template

Save
Fee Templates O Leads @ Loans
Loan Programs Select Tab Select Menu Select Dropdown
Document Packages ~ ~ v
Directory
Services Settings
Company Information LIST ITEM 0
Document Settings
Escrow Account Setup
Figure 448: Status Dropdown Lists
2. Select either the Leads or the Loans option.
3. Select the Tab option.
4. Select the Menu option.
5. Select the Dropdown option.
6. Select the required option.
Wire Transfer Fee <
Other v

Non-Display Items \

Loan Originator Compensation

Figure 449: Select List Option
7. Click Add.
8. Click Load Default to add the option to the Default List.
9. Click Log Out to save the change.
Note: Log Out is required to save the default selection.
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Add List Items

Use the following sections to add custom items to dropdown lists.

Leads Status Dropdown

Use the following steps to add list items to the Leads Tracking screen.
Select Dropdown Lists.

Select Leads.

Select the Status option in the Select Tab menu.

Select the Tracking option from the Select Menu.

NV S

Select the Status option from the Select Dropdown menu.

.
@ Leads O Loans
Select Tab Select Menu Select Dropdown
Status v Tracking v Status v
LIST ITEM 0
List Items Decription Display
New
Prospect
Qualified
Ungqualified

Figure 450: Leads Status Dropdown
6. Click on the Add © icon to create a Status for a lead.

Leads Documents Dropdown

Use the following steps to add list items to the Documents Request screen Pending options.
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1. Select Documents from the Select Tab dropdown menu.

@ Leads (> Loans
Select Tab Select Menu Select Dropdown
Documents v Document Request v Pending v Load Default
LIST ITEM o
List ltems Memo to Borrower Display
new item new items memo w
User Item Testing w
Bank Statements 2 most recent months, all Pages
-

Figure 451: Leads Documents Dropdown
2. Select Document Request from Select Menu.
3. Select Pending from Select Dropdown.
4. Click Add to and a new dropdown menu item.
5.

Repeat steps for additional Select Dropdown options as required.

Application Dropdown

New Fees must be added to the Application dropdown before the Fees are available on the
Application screens.

Use the following steps to add list items to the Application screen Initial and Closing fees
options.

1. Select Application from Select Tab menu.

P
“\) Leads © Loans

Select Tab Select Menu Select Dropdown

Application v Initial and Closing Fees v Origination Charges v Load Default

LIST ITEM o
List Items Display

203K Permits

203K Supplemental Orig ...

Figure 452: Initial & Closing Fees Dropdown

2. Select Initial and Closing Fees from Select Menu.
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3. Select the appropriate Select Dropdown option.

P
O Leads @ Loans

Select Tab Select Menu Select Dropdown
Application v Initial and Closing Fees v Origination Charges v
Origination Charges
Services Borrower Cannot Shop For
LIST ITEM Services Borrower Can Shop For
Taxes and Other Government Fees
Prepaids
List Items

Initial Escrow Payment at Closing
Other

203K Permits
203K Supplemental Orig ...

Application Fee

nnraical Dack Roview E

Load Default

L+

Display

poeQEQ

Figure 453: Application Select Dropdown List
4. Click Add to and a new dropdown menu item.

Note: See steps 5 -8 in Leads Documents Dropdown.

5. Repeat these steps to add additional Dropdown options.

Documents Dropdown

Use the following steps to add list items to the Documents Request screen Pending options.

1. Select Documents from Select Tab.

pu
O Leads @ Loans

Select Tab Select Menu Select Dropdown
Documents v Document Request v Pending v
LIST ITEM o
List Items Memo to Borrower Display
Borrower Gov't Issued Photo ID
Borrower Personal Tax Returns 2 most recent years, all pages
Borrower W2/1099 2 most recent years
Borrower YTD Paystubs Most recent 30 days worth

Figure 454: Select Document Pending Option
2. Select Document Request from Select Menu.
3. Select Pending from Select Dropdown.
4. Click Add to and a new dropdown menu item.
Note: See steps 5-8 in the Leads Documents Dropdown.

5. Repeat these steps for additional dropdown options.
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Document Settings

Use the following sections to set Application and Processing document settings.

Application Privacy Settings

Select the information to appear on the Privacy Statement Form.

1. Select Application from Select Menu.

Template

Save
Fee Templates Select Menu Select Document
Loan Programs Application v Privacy Policy v

Document Packages
PRIVACY POLICY

Directory
Services Settings Revision Date ;3
Company Information
. PERSONAL INFORMATION SHARING o QUESTIONS AND ASSISTANCE
Dropdown Lists
I

Escrow Account Setup
Web Site Address

REASON TO SHARE PERSONAL INFORMATION

Figure 455: Loan Application Privacy Settings
2. Select Privacy Policy from Select Document.
3. Select the Calendar to set Privacy Policy Revision Date.

4. Click the Personal Information Sharing Add button to select document types
impacted by personal sharing.

Add Personal Information Sharing X

Type M.

Other Description

Figure 456: Add Personal Information Sharing

5. Select the appropriate Type.

Note: Enter Other Description when selecting Other from the Type dropdown.
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6. Select Save & Close to add the document type to the Personal Information List.

Select Menu Select Document

Application v Privacy Policy v

PRIVACY POLICY

Revision Date E‘
PERSONAL INFORMATION SHARING ©  QUESTIONS AND ASSISTANCE
Type Telephone -
Account Balances W Web Site Address

Figure 457: Document Type List
Note: Select Save & New to add another document type.

7. Enter Questions and Assistance Telephone and Web Site Address to which the
borrower/co-borrower can refer when questions arise.

8. Select Yes for the Reason to Share Personal Information statements to appear on

the form.
REASON TO SHARE PERSONAL INFORMATION
Does Share Limited Sharing
Our everyday business purposes No v We Don't Share v
Our marketing purposes No v We Don't Share v
Joint marketing with other financial companies No v We Don't Share v
Affiliates' purposes - transaction and experiences No ~ We Don't Share v
Affiliates' purposes - credit worthiness No v We Don't Share v
Affiliates' marketing to you No v We Don't Share v
Nonaffiliates marketing to you No ~ We Don't Share v

Figure 458: Reasons to Share Personal Info.

9. Select the appropriate corresponding Limited Sharing option.
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10. Select the appropriate Opt-out Methods details.
OPT-OUT METHODS
Return To
Telephone ()~ Company Name
Web Site Address Address
Number of Days Unit Designator Number

Reference

City

State/Province

Postal Code

Figure 459: Opt-out Methods

11. Click Select to add Opt-out Choices.

12. Select the checkboxes to include the information on the form.

Opt-out Choices X

Single opt-out joint borrowers.

Do not share information about my creditworthiness
with your affiliates for thier everyday business
purposes.

Do not allow your affiliates to use my personal
information to market to me.

Do not share my personal information with nonaffiliates
to market thier products and services to me.

Do not share my personal information to market to me.
Do not use my personal information to market to me.

Do not share my personal information with other
institutions to jointly market to me.

Figure 460: Opt-out Choices Dialog

13. Complete the remaining form fields.

14. Click Save to save the selections.

ECOA Processing Settings

Select the statement to include on the Equal Credit Opportunity Act (ECOA) Form.
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1. Select Processing from the Select Menu dropdown.

Select Menu Select Document

Processing v ECOA/NOA v

EQUAL CREDIT OPPORTUNITY ACT / NOTICE OF ACTION

Federal Agency FDIC Consumer Response Center v

Description FDIC Consumer Response Center, 1100 Walnut Street, Box #11,
Kansas City, MO 64106

Figure 461: ECOA Form Statement
2. Select ECOA from the Select Document dropdown.
3. Select the appropriate Federal Agency from the dropdown.

4. Review the Description to ensure the correct one is selected.

Escrow Account Setup

Use this section to set up Escrow account fees.

Note: The user can customize what fees/items are shown on Escrow Account Setup screen
by using the Dropdown Lists screen.

Template

Save

Fee Templates ESCROW ACCOUNT SETUP
Loan Programs Fee Cushion Jan Feb Mar Apr May Jun  Jul Aug  Sept Oct Nov Dec
Document Packages

Assessment Tax 2 6 6
Directory

City Bond Tax 2 6 6
Services Settings

City Property Tax 2 4 4 4
Company Information
Dropdown Lists Condo Association Dues 2 3 3 3 3
Document Settings Condo Assoc Assessment
Escrow Account Setup Construction Completion Funds

Co-op Association Dues

Figure 462: Escrow Account Setup
To edit a fee:
1. Locate the desired fee.

2. Click on the fee.
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3. If needed, enter a Cushion.

List Item Assessment Tax cushion

DISBURSEMENT MONTHS

January July
February August
March September
April October
May November
June December

Figure 463: Editing Escrow Fees

4. Enter the desired value for each month.
5. Enter Save & Close.
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Chapter 8: ZIp

The Interview Portal provides options for setting up Zip users. To access the Zip user
settings, select on the Users name in the User Profile.

Interview Portal

Use the Interview Portal to customize and manage Zip information. The options enable
design and message configuration for the company Zip website used to introduce the
borrower to organizations and loan officers. Borrowers may apply for loans and select
specific loan officers via the company Zip website.

Note: Not all described options are available to all Zenly users.
To access the Interview Portal:
1. Open the User Profile.

2. Select Interview Configuration.

20

Ii Interview Configuration I
© Help ]
I

(# Sign Out

Figure 464: User Profile (Zip)
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Company Site

The Company Site options enables selecting what appears on the company Zip Main page.
Include which Loan Originators appear on the Zip site.

Company Main

Configure the design and layout of the landing page for the company Zip landing site.

1. Select Company Main from the sidebar.

>

B company site
Company Main
Company Main »
Set Loan Originators List Here you can set up your company introduction, company information, and other content that appears on your Zip company main page.
If you do not want to enable your Zip company main page, select Off in the Use Company Main section.

.
8% Borrower Portal

Use Company Ma
Default Information

Banner and Colors Oon @ off

Loan Originators

Language Selection

B calculators

8 Products Oon @ off
Product Introduction
Product Details r eb Address Setur
@ Borrower Interview Zip requires a web address to ensure that potential borrowers can access the company site. The web address automatically assigned by
Zip is shown below. You may change the web address prefix in the box below. If you need assistance setting up your web address, please
Configuration email the Zip setup team.

Figure 465: Company Main Page Setup

2. Select the Use Company Main On radio button to enable the company Zip Main
page.

3. Select the Language Selection On radio button to enable language selection on
the company Zip Main page.

4. Enter the company website URL in the field to enable access to the company site.

A

Company Web Address Setup

Zip requires a web address to ensure that potential borrowers can access the company site. The web address automatically assigned by
Zip is shown below. You may change the web address prefix in the box below. If you need assistance setting up your web address, please
email the Zip setup team.

.zipforhome-qa.com

Figure 466: Company URL
5. Select GO to test the URL.
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6. Select the Zip Main page layout design.

Select Type

Select a type to apply the Company Main page.

Figure 467: Zip Main Page Layout

7. Click the Blank image to browse to the stored Company image to use on the Zip
Main page.

Select Image

Select an image to apply to the visual area igfCompany Main page. You can also upload an image from your computer.
The optimal size is 1800%500~740 (The opfimal size for Type C is 570%350.). The file types supported are: JPEG, PG, GIF, PNG

Figure 468: Zip Main Page Image

Note: Select a provided image when electing to not use a stored image. Use the Arrows to
browse all available provided images.

8. Browse to and upload the image.
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9. Make changes to the Edit Contents section as appropriate.
Edit Contents
[EDIT]

Your Trusted
Mortgage Experts

Buying a home is about more than interest rates.

You need knowledgeable, mortgage professionals who give
you their best consistently. Whether you?e a first-time °
home buyer or looking to refinance an existing loan, our
professionally trained staff of Mortgage Advisors is ready
to help.

o

Apply Now
—r i

P g
Loan Officers.
N
»

qm
=
e,

LATEETT B TR L YT R Yooy

Any Street Arlington TX 76014

Figure 469: Edit Zip Main Page Contents
10. Click the EDIT links to change the text.

Purchasing a home?

and ready to work for you, give us a call today.

Looking to refinance?

Let us help.

The home of your dreams is waiting for you. By offering personalized service, we quickly help secure the right home loan for
our clients. We make the loan process simple, straightforward, and fast. Our team of knowledgeable originators are on staff

If you?e considering refinancing your current mortgage, we can help you understand your options. We listen to your specific
needs then present personalized mortgage options for you in real-time. Your needs can change, so can your mortgage loan.

[EDIT]

Preview Save

Figure 470: Edit Links
11. Click Preview to view the updates.
12. Click Save.
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Set Loan Originators List

Select the Loan Originators to list on the company Zip Main page.

1. Select Set Loan Originators List from the sidebar.

B8 company site
Company Main Set Loan Originators List
You can select and sort the list of loan originators who appear on the company main site.
% Borrower Portal
Set the List on Company Main
Default Information
Banner and Colors
Sort by registration | Sort by Name
Loan Originators
Loan Originators List on Company Main
8 calculators
B Products

Product Introduction

Product Details
@ Borrower Interview
3
Configuration
Disclaimer/eConsent/Result n

Terms of Use/Privacy Policy

@ Retention Policy

Figure 471: Set Originators List
2. Select the appropriate Originators from Loan Originators list.
3. Click the »> to move the selected Originators to the List on Company Main list.

Note: Select Originators from the List on Company Main list and us the << to move to the
Loan Originators list.

4. Click Sort by Registration to sort Originators by registration number.
5. Click Sort by Name to sort Originators by hame.

6. Click Save to save changes.

Borrower Portal

Use the Borrower Portal options to set up Borrower Portal page.
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Default Information

Use the following options to set the Borrower Portal images and comments the borrower

will see.

1. Click Default Information from the sidebar.

B company site

Company Main Default Information
Set Loan Originators List

Here you can set your company’s default profile photo and borrower landing page message.
8%, Borrower Portal

Image and Comments
Default Information > -

Banner and Colors Register your company image and introduction message to be displayed on your consumer web portal landing page.
(* Required fields)
Loan Originators

Image
B calculators

B Products

Product Introduction
Product Details « Recommended image size: 230 x 230
« Maximum file size: 2MB

B Borrower Interview « File types supported: JPEG, JPG, GIF, PNG

Configuration

>

Figure 472: Borrower Portal Image

2. Click the Image field to browse to and upload a stored image.

3. Below the company image registry, enter the company's information.

4. Enter a Borrower Portal Welcome message.

Open Sans 11pt B 7

B3
|»
1
L[]
il
1]

L o

« File types supported: JPEG, JPG, GIF, PNG, MP4(video)

* Maximum video file size: 10MB

Language Selection O on @ off

Landing page message to applicants English Spanish

Figure 473: Borrower Portal Welcome Message

5. Enter the message in Spanish if appropriate.

6. Select the Language Select On radio button when using the Spanish message

option, if not selected.
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7. Select the provided Logo to display on the Borrower Portal.

X X (Recommended image size: 80 x 90. Maximum file size: 2MB.
File types supported: JPEG, JPG, GIF, PNG.)

Logos

EQUAL HOUSING
OPPORTUNITY

Save

Figure 474: Borrower Portal Logo

Note: Select the Blank Logo to browse to and upload a stored logo image.

8. Click Save to save the Default Information.
Banner and Colors
Set the banner and colors options to display on the Borrower Portal.

Banner Types
Two banner type configurations are available for the user.
1. Select Banner and Colors.

2. Select the A Type or the B Type configuration.

8 company site

A Banner and Colors
Set Loan Originators List

Upload an image to display on your landing page banner and enter messages to greet your borrowers.
8%, Borrower Portal

Default Information

Select a configuration for the landing page of your borrower interview portal.

Loan Originators
B calculators

B8 Products

Product Introduction

Figure 475: Banner Options
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Edit Banner and Colors

This section of Banners and Colors allows the user to customize the banner.

m
=
w

Edit Banner Main Color 9 #c7b055 Background Color 9 #68a3cf . Font | Verdana

LO image

NMLS 321654
t. 123-456-7890 = @GreatDemoBank.com

anner and Colors Sl S LT

Figure 476: Edit Banner and Colors
To edit the banner:

3. Select the Edit Banner button to open the Edit Banner dialog. See Figure 470.

4. Select the appropriate options. See Figure 470.

Banner Options
The Edit Banner dialog displays additional banner options that include:

¢ Displaying no banner.
e Displaying a text banner.
e Displaying an image banner.

Use the radio buttons to choose the desired option.
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Do Not Display Banner
If no banner will be displayed, use the Banner Navigation Options to enter the URL.
. X
Edit Banner
Banner options
Select a banner option and complete the related information.
@ Do not display banner
(O Display text
(O Display image
Banner navigation options
Navigate to the following URL when the banner is clicked:
https://
Figure 477: Edit Banner
Display Text
Complete the following text options.
1. Enter the text to display on the banner.
X

Edit Banner

Banner options

Select a banner option and complete the related information.
(O Do not display banner
(@ Display text

Enter the text to display on the banner.

Main Color | #ffffff Background Color |#1598bc . Font | Verdana v
(O Display image

Banner navigation options

Navigate to the following URL when the banner is clicked:

https://

Figure 478: Text Banner Options
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2. Select the Text Color.
3. Select the banner Background Color.
4. Select the text Font.

5. Proceed to Color Settings and Font to select the Borrower Portal color options.

Display Image
Complete the following image options.

1. Click Browse to browse to and upload the stored Banner Image.

Edit B x
Select a banner option and complete the related information.
(O Do not display banner
(O Display text
@ Display image
File upload owse-pload

(Maximum file size: 2MB. File types supported: JPEG, JPG, GIF, PNG.)

Banner Placement @) Left (O center () Right

lwilogo image

Navigate to the following URL when the banner is clicked:

https://

Figure 479: Image Banner Options
2. Select the appropriate Banner Placement radio button.
3. Enter the URL the banner opens when clicked on the Borrower Portal.

4. Proceed to Color Settings and Font to select the Borrower Portal color options.

Color Settings and Font

Two Borrower Portal colors are allowed. The selected Font overrides the Display Text
selected above.
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1. Click the Hex Color Code for page titles and buttons on the active page.

Set Back fo Default

Edit Banner and Colors

Edit Banner Main Color 6 #¢7b055 Background Color 9 #68a3cf . Font | Verdana ~

Figure 480: Text Colors
2. Select the appropriate color from the Color Palette.
Edit Banner and Colors L]

T |
Edit Banner Main Color e #C7b0S5 Background Color 0 #68a3ch . Font | Verdana v

Figure 481: Color Palette

3. Click the Hex Color Code for completed pages, background text, tooltip buttons,
etc.
Select the appropriate color from the Color Palette.

Select the appropriate Font from the dropdown.

Set Back to Default

Edit Banner and Colors

Edit Banner Main Color 9 #c7b055 Background Color 0 #68a3cf . Font | Verdana ~

Figure 482: Borrower Portal Font
Note: Font selection supersedes font selected in Display Text section.

6. Click Preview to view selections.
7. Click Save to save Borrower Portal selections.
Loan Originators

The Loan Originators search for and change the image, borrower landing page message
and web address of a loan originator.
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Add Loan Originators

1. Select Loan Originators.

B company site

Company Main Loan OriginatOFS

Set Loan Originators List

Search for and change the image, borrower landing page message and web address of a loan originator.
#%, Borrower Portal

Search

Default Information

Banner and Colors

Loan Originator
Loan Originators »

(You can search by first or last name.)
B calculators

Loan Originator Email
B Products
Web Address
Product Introduction

Product Details
Search

B Borrower Interview

Figure 483: Loan Originators
Choose the Loan Originator option.
Choose the Loan Originator Email.
Choose the Loan Originator Web Address.
Click Search.

Verify the search Results.

oA W N

Edit Loan Originators

Use the following steps to edit a user.

Select Edit User from the Results table.
Enter the user Email Address.

Enter the user Password.

Enter the user Website Number.

Select the Checkbox if appropriate.

o0 s W N e

Click Login.
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Calculators

When borrowers visit the landing page, they can use a Calculator to see their expected
monthly payments. As the administrator, use this screen to enable this function.

B company site

Company Main Calculators

Set Loan Originators List
v
8% Borrower Portal

Default Information ~
@ On QO off
Banner and Colors

Mortgage Calculator
Loan Originators

B calculators > Open Sans 11pt B 7 A-B-E=

Get a sense of the costs of buying a home with our monthly mortgage calculator.

@ Products
Product Introduction
Product Details

@ Borrower Interview

Configuration
Disclaimer/eConsent/Result

Terms of Use/Privacy Policy

@ Retention Policy

Figure 484: Calculators
Choose the On option to enable the Calculator for the borrowers to use.
Use the textbox to enter a message for the borrowers using the calculator.
Click on the Spanish to enter a message in Spanish if applicable.
Use the toolbar above the textbox to edit the message.
Click Save.

To preview the site, click on the link at the bottom of the screen.

o0 s W N e

Save

https:// .zipforhome-ga.com

Figure 485: Zip Site Link
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Products
Set up loan products that borrowers can choose from the Zip portal. The menu is divided
into two screens:

Product Information: Use the screen to provide borrowers with an introduction to the loan
products offered.

Product Details: Use this screen to provide borrowers with details about what the loan
products contain.

Product Introduction

Use this section to add information about the loan products offered.

B company site

Company Main Product Introduction

Set Loan Originators List

Zip enables you to present and promote your loan products, which you can set up here. Once set up is completed, borrowers will be able
8% Borrower Portal to apply for your loan products online.

Default Information

Banner and Colors

Loan Originators

B calculators

B Products

Product Introduction »

Product Details

B Borrower Interview Open Sans 11pt B7A-R

A& BF P o
Configuration Testing the Product Introduction Textbox.
Disclaimer/eConsent/Result

Terms of Use/Privacy Policy

@ Retention Policy

Figure 486: Production Introduction
To set up a product introduction:
1. Select the On option to enable the borrowers to view the offered loan products.
2. Enter an Introduction for the products offered.
3. Enter additional information in the Footer textbox.
Information added in the Footer textbox will appear below the offered products.
Click Save.

Use the Preview button to open a sample.
Product Details

The Product Details screen allows the user to add what loan products are offered by your
company. Use the button on the table to add, delete, or copy a loan product.
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1. Click on the New Loan Product button.

a
@ company site
Company Main Product Details
Set Loan Originators List
Here you set up the list of loan programs to be presented to borrowers. You can:
8%, Borrower Portal
Add to your list of loan products (New Loan Product button)
Default Information Modify an existing loan product (click the product's name in the Product column)
Banner and Colors Delete a product
- Copy a product
Loan Originators . Reorder the sequence in which the products are presented to borrowers (click and drag to reorder)
@ calculators Products List New Loan Product
B Products
W Product Last Modified Status
Product Introduction
([ Fixed 30yr Mortgage 2024-02-13 14:23:06 ® active
Product Details L (O Fixed 30yr FHA 2024-02-13 14:19:38 ® active
B Borrower Interview
Configuration
Disclaimer/eConsent/Result
Terms of Use/Privacy Policy
@ Retention Policy
v

Figure 487: Product Details
2. Enter information about the product.

Loan Product Information

@ Active (O Inactive

Product ame | | Y e

Description

Opensans ~ | 11pt B 7

I»
=
[

Cancel Save

Figure 488: Loan Product Information
3. Scroll down to enter loan information for the offered product.
4. Click Save.

5. If needed, click the Preview button to view a sample of the screen.
Borrower Interview

Use the Borrower Interview options to customize the information collected from Zip users.
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Configuration

Select the interview questions.

1. Select Configuration.

3

8 company site

Configuration
Customize the Zip borrower interview to include the information you want to collect from potential borrowers.
Borrower Interview Configuratiol

You can create various configurations of the borrower interview and select which configuration to use for which loan officer, via
Loan Originators > Edit Users. By clicking the plus button (+) below, you can add as many different configurations as desired.

Select Default Configuration | Full Loan App v
@ Product

Product Introduct

Product Det E atio

B Borrower Interview
Detailed Settings

@ configo1 | Full Loan App
Configuration »
n Check the boxes to indicate the information you want to include in

Disclaimer/eConsent/Result your borrower interview.

Terms of Use/Privacy Policy
[ (A Menu
@ Retention Policy

Figure 489: Set Loan Interview Configurations

2. Select the Default Configuration from the dropdown when more than one
configuration is available.

Select the appropriate Config radio button when more than one is available.
Select the appropriate Detailed Settings.

Select the Classic or New radio button.

Click Save.

o o~ W
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Disclaimer/eConsent/Result
Set the Disclaimer and Thank you statements.
1. Select Disclaimer/eConsent/Result from the sidebar.
B Company site ~

Company Main Disclaimer/eConsent/Result

E—— B2z s

Loar Open Sans 11pt B 7 A-1A EEEE

contacted by a representative of our company to complete this information.

eConsent

Customize the message displayed after the borrower submits their interview.

@ Retention Policy

oo VN3

By submitting your information, you agree to our Terms of Use and Security and Privacy Policies. You also expressly consent to being

Figure 490: Zip Disclaimer/eConsent/Result
2. Enter the Zip Disclaimer in English.
3. Enter the Zip Disclaimer in Spanish if required.
4. Enter the Zip eConsent if required.
5. Enter the Zip Thank You Message in English.

Thank You Message (Result)

Customize the message displayed after the borrower submits their interview.

Open Sans 11pt B 7

=
|»
I
[
[l
(1]

Thank you for submitting your information.

your application.
In the meantime, please do not hesitate to call or email me with any questions.

I look forward to working with you!

spanish

1 will reach out to you shortly to answer any questions you may have and to request any additional information needed to process

Disclaimer Preview eConsent Preview Result Preview m

Figure 491: Zip Thank You Message
6. Enter the Zip Thank You Message in Spanish if required.
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7. Click Disclaimer Preview to review.
8. Click eConsent Preview to review.
9. Click Result Preview to review.

10. Click Save to save the Zip messages.
Terms of Use/Privacy Policy

Set the Terms of Use and Privacy Policy statements.

1. Select Terms of Use/Privacy Policy from the sidebar.

»

B company site

Company Main Terms of Use/Privacy Policy

Set Loan Originators List
Customize the Terms of Use and the Privacy Policy the borrower must agree to before submitting their interview.

&, Borrower Portal
Terms of Use
Default Information
Banner and Colors English
Loan Originators. Open Sans 11pt B 7 A " = =
B calculotors Under Federal Law, we are required to provide you a copy of our Privacy Policy and Privacy Notice. Receiving this Privacy Policy and
Privacy Notice is a necessary step in obtaining the particular financial product or service that you are requesting. We reserve the
right to alter our Privacy Policy and Privacy Notice at any time. We will provide notice of any revised Policy and Notice to our current
B Products customers. If we decide to revise our Privacy Policy and Privacy Notice, in whole or in part, you can always review our current Policy

and Notice at our website or contact us for a copy. I acknowledge that receiving a copy of this Privacy Policy and Privacy Notice is a
step necessary in obtaining the particular financial product or service that I am requesting and I agree to receive this Privacy Policy
and Privacy Notice via this website. If I continue to be a customer of this company, I agree to receive annually the Privacy Policy
and Privacy Notice via this website.

Product Introduction

Product Details

B Borrower Interview

Configuration

Spanish

Disclaimer/eConsent/Result

Open Sans 11pt B 7 A "

Terms of Use/Privacy Policy
Bajo la Ley Federal, nosotros somos requeridos a proporcionarle una copia de nuestra Politica de la Intimidad y Nota de Intimidad.
Recibir esta Politica de la Intimidad y Nota de Intimidad son un paso necesario a obtenei

@ retention Policy

Figure 492: Terms of Use/Privacy Policy

2. Enter the Terms of Use in English.

English

Open Sans 11pt B /7 A A

Under Federal Law, we are required to provide you a copy of our Privacy Policy and Privacy Notice. Receiving this Privacy Policy and
Privacy Notice is a necessary step in obtaining the particular financial product or service that you are requesting. We reserve the
right to alter our Privacy Policy and Privacy Notice at any time. We will provide notice of any revised Policy and Notice to our current
customers. If we decide to revise our Privacy Policy and Privacy Notice, in whole or in part, you can always review our current Policy
and Notice at our website or contact us for a copy. I acknowledge that receiving a copy of this Privacy Policy and Privacy Notice is a
step necessary in obtaining the particular financial product or service that 1 am requesting and 1 agree to receive this Privacy Policy
and Privacy Notice via this website. If I continue to be a customer of this company, I agree to receive annually the Privacy Policy
and Privacy Notice via this website.

Spanish

Open Sans 11pt B 7 A .y

Bajo la Ley Federal, nosotros somos requeridos a proporcionarle una copia de nuestra Politica de la Intimidad y Nota de Intimidad.
Recibir esta Politica de la Intimidad y Nota de Intimidad son un paso necesario a obtener el producto o el servicio financieros
particulares que usted solicita. Reservamos el derecho de alterar nuestra Politica de la Intimidad y Nota de Intimidad en tiempo.
Proporcionaremos nota de alguna Politica y la Nota revisadas a nuestros clientes actuales. Si decidimos revisar nuestra Politica de la
Intimidad y Nota de Intimidad, en el total o en la parte, usted siempre puede revisar nuestra Politica y la Nota actuales en nuestro
sitio web o nos contacta para una copia. QA

Figure 493: Terms of Use Statement.

3. Enter the Terms of Use in Spanish if required.
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4. Enter the Privacy Policy in English.

Privacy Policy

Customize the Privacy Policy to inform visitors to your site how infoermation collected on your website is used.

English

4 ¢ | Verdana - 1ipt - B 7 A-HEA-EE =

1 acknowledge that receiving a copy of this Privacy Policy and Privacy Notice is a step necessary in obtaining the particular "_

financial product or service that I am requesting and I agree to receive this Privacy Policy and Privacy Notice via this website. If I

continue to be a customer of this company, I agree to receive annually the Privacy Policy and Privacy Notice via this website.

1. We collect nonpublic personal information about you from the following sources:

-

Spanish

“ | verdana - | 1pt ~-'B I A-RA-E=E=EE

Reconozco que eso recibiendo una copia de esta Politica de la Intimidad y Mota de Intimidad es un pase necesario en obtener el "7

producto o el servicio financieros particulares que solicito y concuerdo en recibir esta Politica de la Intimidad y Nota de Intimidad

via este sitio web. Si continle ser un cliente de esta compafiia, yo concuerdo en recibir anualmente la Politica de Intimidad y

Nota de Intimidad via este sitio web.

1. Recopilamos informacion personal no padblica sobre usted de las siguientes fuentes: hd

Terms of Use Preview Privacy Policy Preview Save

Figure 494: Privacy Policy

Enter the Privacy Policy in Spanish if required.
Click Terms of Use Preview to review.

Click Privacy Policy Preview to review.

© N o »

Click Save to save the Zip statements.
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Retention Policy

Use the Retention Policy options to change the default Zip loan document and eSignature
retention settings.

1

Select Retention Policy from the sidebar.

8 company site

Company Main

Set Loan Originators List

8% Borrower Portal
Default Information
Banner and Colors

Loan Originators

Calculators

Products

Product Introduction

Product Details

@ Borrower Interview

Disclaimer/eConsent/Result

Retention Policy

Zip is configured to automatically delete loan documents after 365 days.
Use this screen to customize these settings for your company.
Document retention time is based on the policy in place at the time Zip received the document. Deleted documents cannot be retrieved.

Loan Information

Retain loan Information for| 60 | days (Retention period must be between 1 and 365 days.)

eDisclosure & eSignature

Record Retention The E-Sign Act requires a financial institution to maintain electronic records accurately reflecting the information
contained in applicable contracts, notices or disclosures and that they remain accessible to all persons who are legally entitled to access
for the period required by law in a form that is capable of being accurately reproduced for later reference. See Section 101(d).

Retain electronic disclosures and electronically signed documents for| 90 |days (minimum 90 days.)

Terms of Use/Privacy Policy

@ Retention Policy >
v

Figure 495: Zip Retention Policy

2. Change the Loan Information retention setting to modify the retention length.

3. Change the eDisclosure & eSignature retention setting to modify the retention
length.

4. Click Save.

Notifications
Use the following section to setup borrower reminders.
Email Settings

Use the following sections to set up email addresses and email preferences.

Set Email Address

Use the Set Email Address to set email preferences.
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1

o~ w N

o

Select Set Email Address from the sidebar.

B company site
Email Setting

Figure 496: Zip Email Preferences

Enter the Primary Email address.
Use the *+ to add Additional Email Addresses.
Click Save.

Select the On radio button to receive the Loan Officer (LO) Notifications Emails

when borrowers interact with Zip.

Enter the email to Receive Notification Email with Borrower Contact Information.

Click Save.

Edit Emails

Use Edit Emails screen to customize email notifications sent to the borrowers after
submitting a loan.

Use the following steps to customize email notifications.

1

Select Edit Emails from the sidebar.

Edit Emails

Hi {Borrower_Name},
Success! Thank you fc

What's Next:

Insert Merge Fields

We are reviewing your information and will reach out to you shortly with the next steps.

Figure 497: Edit Emails
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2. Click the Select Loan Originator dropdown and select an originator.

Email Notifications
1. Select the Copy Setting > link if applicable.
2. Select an email template from the dropdown menu.

Email Notifications

Customize the notification emails that are sent to the borrower when you need a document from the borrower or to send a confirmation
email to the borrower. Areas to customize are the email’s subject, introduction, and footer, where it is recommended that you include
your contact information so that it is convenient for the borrower to reach you, should they have questions that need to be answered.

Copy Setting_ »

Thank You Email v English Spanish

hce to the borrower, we recommend

you include your contact information and any other information you want them to know.

Insert Merge Fields

Subject

Figure 498: Email Template
3. Select either English or Spanish tab.
4. Use the Insert Merge Fields dropdown to add automation to the email.

Note: The default email template contains bracketed tags (merged fields) that autofill
common elements within the email (Ex. {Sender_Name).

Insert Merge Fields
Subject
Loan information received
Body Open Sans 11pt B / A A = = = =| Insert Merge Fields
What's Next:
We are reviewing your information and will reach out to you shortly with the next steps.
Want to be ahead of the game?
While you may have entered asset information or given us permission to do automated account lookup
and importing, we may need more information to process your loan.
{Document_List}
Click the link below to check your loan status as well as upload important documents needed to process
your loan.
{SianIn Hynerl ink e
Footer Verdana 11pt B 7 A-HA = = = = Insert Merge Fields

Figure 499: Insert Merge Fields
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5. Customize the Subject content.

Note: Before entering a Merge Field, place the insertion mark at the desired location. The
Merge Field will appear wherever the user places the insertion mark. See the image below.

*

Subject
Loan information Receive

Figure 500: Placing a Merge Field

6. Customize the Body content.
7. Customize the Footer content.
8. Select the Save button.

Set Back to Default

Use the Set Back to Default button to reset the Subject, Body, and Footer to the email's
original format.

1. Select the Set Back to Default button.

2. Click on Yes to reset the email.

Send Sample

Use the Send Sample button to send a sample of the modified email to the desired email
address.

1. Click the Send Sample button.

2. Enter an email address in the Send To field.

Send Sample Email

Send Document Request (borrowers without accounts) sample
to your chosen email address.

Send To @GreatDemoBank.com

oo

Figure 501: Send Sample Email

3. Click Send.

Calyx Software: 6475 Camden Avenue, Suite 207 San Jose CA 95120
3500 Maple Ave, Suite 500 Dallas, TX 75219 Calyxdcs@calyxsoftware.com
www.calyxsoftware.com
© Calyx Technology, Inc. 1991-2024. All rights reserved.

305


mailto:Calyxdcs@calyxsoftware.com
https://www.calyxsoftware.com/
https://www.calyxsoftware.com/

v

calyx Zenly User Guide

Email Signature
Use this section to create an Email Signature. Choose between Default, Use HTML, or None.
1. Select a signature option.

The Default option will apply a signature with the loan originators information set in
Loan Originators.

Set up your email signature

(@ Default (O Use HTML () None

Mobile 123-456-7890 Signature Information

Address: 123 Friendship Circle TX 75001
Email (@GreatDemoBank com
zipforhome-ga.com

s Name, title, mobile number, NMLS number and email from
Loan Originators > Edit Users.

[Manage Social Media] + Profile image, address, and office phone number from
Loan Originators > Borrower Landing Page.

« Website address is your Zip borrower portal.

Figure 502: Email Signature
Select the Manage Social Media link.
In the Manage Social Media dialog, add the desired social media URLs.
Click Save.

After adding social media accounts, click the Save button to complete the
signature setup.

ok~ w N

Use HTML

The user can design their own signature by selecting the Use HTML option. If the user
prefers not assigning a signature, the None option is available.

If the Use HTML option is selected:
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1. Click on the blank image field to add an image to the signature.

Set up your email signature.

(O Default (@ Use HTML (O None

« Recommended image size: 150 x 150
* Maximum file size: 1MB
« File types supported: JPEG, JPG, GIF, PNG

Open Sans 11pt B 7

b3
>
m
1}
1]
I}

Email Signature Appearance

Figure 503: Use HTML
Browse to the desired image.
Select Open to upload the image.
Click on the Crop button to edit the image.

o~ WD

Click Save to keep the crop.

Use the Delete button to remove the uploaded image.

6. Enter the signature information in the text box.

Use the functions for the text box to design the signature.

7. Select an appearance for the signature.

Email Signature Appearance

Figure 504: Email Signature Appearance

8. Click the Save button to save the email signature.
Edit Reminders

Use the following section to set up reminders.

1. Select Edit Reminders.
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2. Choose a Loan Originator.

>

B compary ste

Edit Reminders

Select Loan Originator

Figure 505: Edit Reminder

Copy Setting

Use the Copy Setting > link to copy the settings from a chosen loan originator and apply
them to other loan originators.

After selecting the link:
1. Select the Copy from dropdown menu and chose whose settings to copy.

Edit Reminders

Select Loan Originator v

Copy Setting ¥

Copy from

Copy to Select All Users

Figure 506: Copy Setting
2. If needed, click on the Select All Users button.

3. Or enter which originators to apply the settings to.

4. Click on the Copy button.
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Document/eSign Dashboard Reminder

Selecting On will alert borrowers (with accounts created) with emails/text messages about
completing any outstanding documents or electronic signature requests before their due
dates. The Off option disables this feature.

To set areminder;

1. Select either On or Off.

Document/eSign Request Reminder Incomplete Loan Interview Reminder

Use Borrower Dashboard Reminder

By selecting On, borrowers (who created accounts) will receive emails/texts reminding them to complete outstanding documents and
electronic signature requests hefore their due dates. Selecting Off disables this feature.

Use Reminder Oon (@ Off
Select Reminder Methods Email Text

First Reminder day(s) before due date at

Reminder Frequency

Figure 507: Document/eSign Reminder

Chose Email, Text, or select both options.

Select the number of days before the due date to remind the borrower.
Select the time of day.

Click on the Reminder Frequency dropdown menu and select an option.
Click Save.

If selected, customize the email reminder.

® N O oA W WD

If selected, customize the text reminder.

Loan Interview Reminder

Selecting On will alert borrowers (with accounts created) with emails/text messages about
completing loan interviews. The Off option disables this feature.
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To set a reminder:
1. Select either On or Off.

By selecting On, borrowers (who have not completed the interview) will receive emails/texts reminding them to complete their loan
interviews. Selecting Off disables this feature.

Use Reminder O on @ Off
Select Reminder Methods Email Text

First Reminder day(s) after an unfinished interview at

Reminder Frequency

Figure 508: Loan Interview Reminder

2. Chose Email, Text, or select both options.

Select the number of days after an unfinished interview before notifying the
borrower.

Select the time of day.
Click on the Reminder Frequency dropdown menu and select an option.
Click Save.

If selected, customize the email reminder.

© N O ok

If selected, customize the text reminder.
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Reports
Use the Reports options to run Zip Reports.
Borrower Interview Report

Set the Borrower Interview Report options to retrieve the list of borrower interviews for a
specified timeframe.

1. Select Borrow Interview Report from the sidebar.

B company site
Company Main Borrower Interview Report

The Borrower Interview Report provides a list of interviews that were submitted between the specified dates.

Loans originated date and

Download as Excel

Click Resend to re-import the application

Figure 509: Run Borrower Interview Report
Enter Loan Originator Name.
Enter Borrower Email.
Set Loans originated dates.
Click Search.

Click Download as Excel to download the results in an Excel spreadsheet.

o0~ W N

Billing Statement Report

Use the Billing Statement Report options to run billing reports for a selected month.
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1

Select Billing Statement Report.

i~

Company Site

Company Main

Set Loan Originators List

Borrower Portal

Default Information
Banner and Colors

Loan Originators

Calculators

Products

Product Introduction

Product Details

Borrower Interview

Configuration
Disclaimer/eConsent/Result

Terms of Use/Privacy Policy

Retention Policy

Notifications

Email Setting

Billing Statement Report

The Billing Statement Report displays a detailed list of borrower interviews submitted and eSign requests sent, as well as a summary of

the total number and fees for the selected month.

View ‘ 02/2024 v

Type period Unit Cost | Number Total
Monthly fee (per user) 02/01/2024 - 02/29/2024 $35.00 10 $350.00
esign (per package) 01/01/2024 - 01/31/2024 $1.50 0 $0.00

Total Amount. $350.00

Click the number in the Number column to view details

Activity since last statement

Type Unit Cost | Number Total
Monthly fee (per user) $35.00 10 $350.00
esign (per package) $1.50 0 $0.00

Total Amount $350.00

Click the number in the Number column to view details

Figure 510: Billing Statement Report

2. Enter the Loan Originator Name.

3. Select the Month for the report.

4. Click Search.

Note: Results display in the Results List.

Borrower Statistics

Use the Borrower Statistics options to review Zip borrower activity.

Registered Borrowers

Review the Zip registered borrowers.

1

Select Borrower Statistics from the sidebar.

© company site
Company Main

Set Loan Originators List

&% Borrower Portal

Default Information

Loan Originators

B calculators

B Pproducts

oduction

Product Detalls
B sorrower Interview

Configuration
Disclaimer/eConsent/Result

Terms of Use/Privacy Policy

@ Retention policy

=

Email Setting

Borrower Statistics

Here you can review the statistics for borrower activity, including the number of submission attempts (successful and failed), successful
submissions, abandoned loans and registered borrowers.

Total Number of Borrowers Registered

st vorover [T

Numbers

Loan Submission Report
Loan Originator Name

Date between and ‘

Results

Figure 511: Borrower Statistics
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2. Click the Registered Borrowers link to review the registered borrowers.

Registered Borrowers bt

Borrower Email

oo L oo

No Results.

Figure 512: Registered Borrowers

3. Click Search to locate a borrower when the registered borrowers appear in a list.

Loan Submission Report

Use the Loan Submission Report options to return a report containing the Zip submitted
loans.

1. Select Borrower Statistics.
2. Enter the Loan Originator Name.
3. Enter the Date Between range to include in the report.
4. Click Search.
Note: The results display in a Results List.

Settings

As the administrator, configure the settings for document collection and VOA (verification of
asset) via the Settings menu.

Google Analytics

From the Google Analytics screen, the user can register Google Analytics ID to track the
pattern on how borrowers use the interview portal.

To register Google Analytics ID:
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1. Choose the On option.

B company site

Company wain Google Analytics

Set Loan Originators List

Register your Google Analytics ID to track the pattern of how borrowers are using your Zip borrower portal.

be collected from borrowers using Firefox.
Loan Originators

Select Loan Originator .

Calculators

Use Google Analytics QOon @ off

Products
Measurement 1D* @

Product Introduction

Product Details

D e

Configuration

Disclaimer/eConsent/Result

Terms of Use/Privacy Policy

@ Retention Policy

@ notifications

Email Setting

8% Borrower portal
Register your Google Analytics ID
Default Information
S o Please register the measurement ID created by Google Analytics. Firefox blocks tracking from Google Analytics. Therefore, data cannot

Figure 513: Google Analytics
2. Enter the Google Analytics ID into Measurement ID field.

Document Template

Use the Document Template screen to Set the document collection that you want to receive

from borrower during Loan Interview.

1. Select Document Template from the sidebar.

@ company site

Company Main Document Template

Set Loan Originators List
Set the document collection that you want to receive from borrower during Loan Interview.
.
8% Borrower Portal

Default Information

Banner and Colors In the fields below, enter the documents to be received from the borrower

Loan Originators Required: Enable the Required toggle if this document must be requested during the interview
B calculators Grace Period: If the borrower fails to submit the required document, enter the number of days for the grace period,

during which the document request will be displayed under To-Do, in the borrower dashboard
B Produas
[J1. Document Name | Government-issued 1D
Product Introduction
Note Driver's License, ID Card, Passport.

Product Detalls

Borrower Interview
e Add Conditions

Configuration Required

Disclaimer/eConsent/Result

Terms of Use/Privacy Policy Save

© Fetentin rolicy

B notifications

Email Setting

Document List Add New Document

Figure 514: Document Template
Enter Document 1 name.
Enter description in the Note field.
Click + to add additional documents.
Click Save.

ok~ WD
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Security

1. Select the 2-factor Login Authentication option.

B company site
Company Main

Set Loan Originators List

Borrower Portal

™

Default Information

Banner and Colors

Loan Originators

Calculators

B products
Product Introduction

Product Details
@ Borrower Interview

Configuration
Disclaimer/eConsent/Result

Terms of Use/Privacy Policy
@ Retention Policy
B nNotifications

Email Setting

Security

By selecting On, borrowers (who created accounts) must enter the 6-digit security code (received via email or text) when logging in.

@on Q off

Password Parameters
Set password parameters for the borrower portal

Password must be a minimum length of | 8 characters and a maximum length of | 15 | characters.

- The minimum amount of characters must be at least 6.
The minimum amount of characters must be less than the maximum
- The maximum amount characters cannot be more than 15.

Figure 515: Security Login

2. If needed, set Password Parameters.

3. Click Save.

Payment Management

Use the Payment Management screen to update the credit card information used for Zip
and eSignature transactions.

1. Select Payment Method from the sidebar.

8 company site

Company Main
Set Loan Originators List

v
8% Borrower Portal

Default Information
Banner and Colors

Loan Originators
@ calculators

@ Products

Product Introduction

Product Details

Payment Management

Zip and the eSignature Transaction fees are automatically charged to the credit card or ACH you provided during account setup.

You can update the credit card information on file below. All information is transmitted over a secure connection to ensure the
confidentiality of your information

Payment Management

Select your payment method and enter your contact information and payment information for billing purposes. (* Required fields)

Select payment method* Please Choose v

Figure 516: Payment Method

2. Select the appropriate Payment Method.
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3. Enter Credit Card or Automatic Clearing House (ACH) information.

Credit Card Type* ‘ Please Select One M ‘
Number* ‘ ‘
Cardholder Name* ‘ ‘ Exaq

Card Security Code* S (2]

Billing Address* ‘

City* ‘

Figure 517: Payment Management Credit Card

4. Click Save.

User Profile

User Settings determine the Loan Originator information to display on the Zip Borrower
Dashboard.

To access the User Profile Settings:
1. Open the User Profile.

2. Select the username.

0.0

2

W Interview Configuration
@ Help |

(» Sign Out

ress

Figure 518: Access User Settings
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Contact Information

Set the user contact information and state licensing options.

1. Select the User Profile.

2. Enter Loan Originator First name.

User Profile

\ Save ‘

CONTACT (* REQUIRED FIELD)

Services Settings

Alerts Configuration First Email

Middle Contact | (_)_- *

N
Last Mobile | (-

Suffix By Checking the Opting in Box, you are
authorizing us to send you related
NMLS Number informational texts. Message/data rates
apply.
STATE LICENSE o

Figure 519: Loan Originator Contact Information
Note: Asterisks indicate required fields.
Enter Loan Originator First and Last name.
Enter Middle name if applicable.
Enter Loan Originator Email.
Enter Loan Originator Contact number.

Enter Loan Originator Mobile number.

© N O oA Ww

If needed, select the By Checking the Opting in Box....

Note: By opting into the informational texts, the user is provided with an additional method
for sending password change requests.

9. Click the State License Add © button.
10. Enter State License information.
11. Click Save & Close.

Note: Click Save & New to add additional licenses.

Services Settings

Use the Services Settings to create Loan Originator Login credentials.
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1. Select Services Settings.

‘ zenly LEADS/LOANS ~ REPORTS  USERS  TEMPLATE A O
Save

Contact Information

LOGIN CREDENTIALS o

Alerts Configuration

Figure 520: Add Login Credentials
2. Click on the Add © icon.
3. Select the appropriate Service.

Add Login Credentials X

Select Service e Login Name @GreatDemoBa
Select Agency v Password =~ teeeseseseess ’@
Preferred

Account

Branch ID

Figure 521: Add Login Credentials Dialog

4. Select the appropriate Agency.

5. Select the Preferred checkbox to save settings as preferred.
6. Enter Login Name.

7. Enter the login Password.

8. Enter the Account humber.

9. Enter the company Branch ID if appropriate.

10. Enter the Fannie Mae Account Number.

11. Enter the Fannie Mae Password.

Note: The Fannie Mae fields only appear for credit vendors that require different
authentication credentials for Fannie Mae vendors.

12. Click Save & Close.
Note: Click Save & New to add another service setting.
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Alerts Configuration (User Profile)

Use the Alerts Configuration to set notifications. Toggle the switches for the desired alerts.

‘ Zenly LEADS/LOANS REPORTS USERS TEMPLATE ‘ e

User Profile
Save

Contact Information ALERTS & NOTIFICATIONS

Services Settings
Use the toggles to switch the alerts and email notifications on/off for these system generated items.

Alerts Configuration Alerts are set to clear automatically after 30 days

Alert Email

@ @ Documents Received
© © s
@ @ Youareassignedafile

© Interview Completed

Figure 522: Alerts Configuration (Zip)
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Chapter 9: ACRONYMS

The following tables contain acronym definitions used in this document.

Table 4: Acronyms

Acronym Definition
ADA Americans with Disabilities Act
ARM Adjustable-Rate Mortgage
CBSV Consent Based Social Security Number Verification
FHA Federal Housing Administration
HMDA Home Mortgage Disclosure Act
FNM Fannie Mae Data file developed by Calyx.
HTML Hyper Text Markup Language
HOEPA Homeownership and Equity Protection Act
MIP Mortgage Insurance Premium
PMI Private Mortgage Insurance
POS Point of Sale
SCIF Supplemental Consumer Information Form
USDA United States Department of Agriculture
URLA Uniform Residential Loan Application (Form 1003)
VA Veterans Affairs
XML Extensible Markup Language
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APPENDIX A: LOAN ESTIMATE MAPPING TABLES

See Loan Estimate.

Loan Terms

Table 5: Loan Terms Mapped Fields

Loan Estimate Field(s) Mapped from Screen Mapped from Section/Field
Loan Amount Loan Application Summary of Total Loan Amount
Can this amount L Determine by various loan data
. . Loan Application
increase after closing? and loan terms.

Interest Rate Loan Application Payment Schedule
Monthly Principal & Loan Application Payment Schedule
Interest
Prepayment Penalty Checkbox
Prepayment Penalty Loan Estimate and the fields below the
checkbox.
Balloon Payment Loan Application Loan Features

Projected Payments

Table 6: Project Payments Mapped Fields

Loan Estimate Field(s) Mapped from Screen Mapped from Section/Field
Principal & Interest Loan Apolication Payment Schedule - Mth Pmt
(MIN/MAX) PP column
Mortgage Insurance (M) Loan Application Payment Schedule - M
Escrow Initial Fees Worksheet G, lm.tlal Escrow Payment at

Closing
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